Copyright © 2004 by Wavelink Corporation All rights reserved.

Wavelink Corporation
6985 South Union Park Avenue, Suite 335
Midvale, Utah 84047
Telephone: (801) 316-9000
Fax: (801) 255-9699
Email: info@roisys.com
Website: http:\\www.wavelink.com
Email: sales@wavelink.com

No part of this publication may be reproduced or used in any form, or by any electrical or mechanical means, without permission in writing from Wavelink Corporation. This includes electronic or mechanical means, such as photocopying, recording, or information storage and retrieval systems. The material in this manual is subject to change without notice.

The software is provided strictly on an “as is” basis. All software, including firmware, furnished to the user is on a licensed basis. Wavelink grants to the user a non-transferable and non-exclusive license to use each software or firmware program delivered hereunder (licensed program). Except as noted below, such license may not be assigned, sublicensed, or otherwise transferred by the user without prior written consent of Wavelink. No right to copy a licensed program in whole or in part is granted, except as permitted under copyright law. The user shall not modify, merge, or incorporate any form or portion of a licensed program with other program material, create a derivative work from a licensed program, or use a licensed program in a network without written permission from Wavelink. The user agrees to maintain Wavelink’s copyright notice on the licensed programs delivered hereunder, and to include the same on any authorized copies it makes, in whole or in part. The user agrees not to decompile, disassemble, decode, or reverse engineer any licensed program delivered to the user or any portion thereof.

Wavelink reserves the right to make changes to any software or product to improve reliability, function, or design.

The information in this document is bound by the terms of the end user license agreement.
# Table of Contents

**Chapter 1: Introduction**
- Document Assumptions ...................................................... 1
- Document Conventions ..................................................... 1
- Document Revision History .................................................. 3
- About the TelnetCE Client .................................................. 3
  - TelnetCE Client Overview ................................................ 3
  - Deployment Methods ..................................................... 3
  - TelnetCE Client Components ............................................ 4
    - About Host Profiles .................................................. 4
    - About Emulation Parameters ......................................... 4
    - About Localization .................................................... 5
    - About SSL ............................................................... 5
    - About Scripting ....................................................... 5
    - About Keyboard Creator ............................................ 5
  - TelnetCE Client Functionality .......................................... 5
- TelnetCE Client Version and Supported Features Matrix .............. 6

**Chapter 2: Installation and Configuration**
- Installing the TelnetCE Client ........................................... 9
  - Cold Boot Recovery .................................................... 10
- Configuring the TelnetCE Client ........................................ 10
  - Configuration Overview ................................................ 10
  - Configuration Support Matrix ........................................ 12
  - Using Avalanche Manager to Configure the TelnetCE Client ...... 13
  - Using Microsoft ActiveSync to Configure the TelnetCE Client ... 15
- Deploying Configurations ................................................ 16
  - Deploying Configurations via Avalanche Manager ................. 17
    - Preparing for Updates ............................................... 17
    - Downloading the Configuration to the Mobile Device .......... 21
  - Deploying Configurations via Microsoft ActiveSync .............. 23

**Chapter 3: Host Profiles**
- Overview of Host Profiles ............................................. 25
- Configuring a Host Profile ............................................. 27
  - Adding a Host Profile ................................................ 28
  - Modifying an Existing Host Profile .................................. 29
  - Deleting a Host Profile ............................................... 30
- Host Profiles and SSL .................................................. 31
  - Installing the SSL Support Package on the Host System ......... 31
  - Installing the SSL Support Package on the Mobile Device ...... 32
  - Enabling SSL ........................................................... 32
  - Enabling Certificate Verification .................................... 34
- Host Profiles and Wavelink TermProxy ................................ 37
Chapter 4: Emulation Parameters

About Emulation Parameters ........................................ 55
About Per-Host Emulation Parameters .......................... 55
About Global Emulation Parameters ............................. 56
Configuring Emulation Parameters ............................... 56
Overview of Configuring Emulation Parameters .............. 56
Accessing Global Emulation Parameters ....................... 56
Using Microsoft ActiveSync ........................................ 57
Using Avalanche Manager .......................................... 59
Accessing Per-Host Emulation Parameters ................... 61
Using Microsoft ActiveSync ........................................ 61
Using Avalanche Manager .......................................... 65
Using Configuration Manager ...................................... 68
Modifying Emulation Parameters ................................. 70
Using the Find Function ........................................... 71
Switching to Alphabetized View .................................. 72

Chapter 5: Scripting

Overview of Scripting .................................................. 75
Launching the Script Editor ......................................... 76
Creating Scripts Using the Script Editor ....................... 78
Configuring the Script Name ....................................... 79
Selecting the Activation Method ................................. 79
Select from Menu ...................................................... 80
On Key Combination ................................................. 80
When Session Connects ............................................. 81
On Barcode, MSR or RFID Scan ................................. 82
On Screen Update ...................................................... 83
Creating the Script Code ............................................ 84
Creating Variables .................................................... 84
Selecting Host Profiles .............................................. 86
Performing Script Capturing ....................................... 88
Editing Scripts ......................................................... 92
Importing Scripts ..................................................... 92
Saving and Exporting Scripts ..................................... 94
Deploying Scripts ..................................................... 96
## Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Executing Scripts</td>
<td>96</td>
</tr>
<tr>
<td>Select from Menu</td>
<td>96</td>
</tr>
<tr>
<td>On Key Combination</td>
<td>97</td>
</tr>
<tr>
<td>When Session Connects</td>
<td>97</td>
</tr>
<tr>
<td>On Barcode, MSR, or RFID Scan</td>
<td>98</td>
</tr>
<tr>
<td>On Screen Update</td>
<td>98</td>
</tr>
<tr>
<td><strong>Chapter 6: Keyboard Creator</strong></td>
<td>99</td>
</tr>
<tr>
<td>Overview of Keyboard Creator</td>
<td>99</td>
</tr>
<tr>
<td>Launching the Keyboard Creator</td>
<td>99</td>
</tr>
<tr>
<td>Selecting Keyboard Files</td>
<td>101</td>
</tr>
<tr>
<td>Creating Keyboards</td>
<td>102</td>
</tr>
<tr>
<td>Adding a new keyboard</td>
<td>102</td>
</tr>
<tr>
<td>Sizing Keyboards</td>
<td>104</td>
</tr>
<tr>
<td>Deleting Keyboards</td>
<td>104</td>
</tr>
<tr>
<td>Importing Keyboard Graphics</td>
<td>105</td>
</tr>
<tr>
<td>Creating and Configuring Keys</td>
<td>105</td>
</tr>
<tr>
<td>Adding a new key</td>
<td>106</td>
</tr>
<tr>
<td>Sizing and Positioning Keys and Rows</td>
<td>108</td>
</tr>
<tr>
<td>Deleting Keys</td>
<td>109</td>
</tr>
<tr>
<td>Deploying the Keyboard to the Telnet CE Client</td>
<td>109</td>
</tr>
<tr>
<td><strong>Chapter 7: Licensing</strong></td>
<td>111</td>
</tr>
<tr>
<td>Overview of Licensing</td>
<td>111</td>
</tr>
<tr>
<td>Authorization Methods</td>
<td>112</td>
</tr>
<tr>
<td><strong>Types of Licenses</strong></td>
<td>113</td>
</tr>
<tr>
<td>About Platform Licenses</td>
<td>113</td>
</tr>
<tr>
<td>About Maintenance Licenses</td>
<td>113</td>
</tr>
<tr>
<td>Licensing Methods</td>
<td>113</td>
</tr>
<tr>
<td>Manually Licensing the TelnetCE Client</td>
<td>114</td>
</tr>
<tr>
<td>Using License Server to License the TelnetCE Client</td>
<td>115</td>
</tr>
<tr>
<td>Using a Local License Server</td>
<td>116</td>
</tr>
<tr>
<td>Using a Remote or Specific License Server</td>
<td>117</td>
</tr>
<tr>
<td>Using the Demo License</td>
<td>118</td>
</tr>
<tr>
<td><strong>Chapter 8: Using the TelnetCE Client</strong></td>
<td>121</td>
</tr>
<tr>
<td>Using the TelnetCE Client and Connecting to Hosts</td>
<td>121</td>
</tr>
<tr>
<td>Launching the TelnetCE Client</td>
<td>121</td>
</tr>
<tr>
<td>Launching the TelnetCE Client From Windows</td>
<td>122</td>
</tr>
<tr>
<td>Launching the TelnetCE Client from Avalanche</td>
<td>123</td>
</tr>
<tr>
<td>Initiating a Telnet Session</td>
<td>125</td>
</tr>
<tr>
<td>Disconnecting a Telnet Session</td>
<td>127</td>
</tr>
<tr>
<td>Exiting the TelnetCE Client</td>
<td>128</td>
</tr>
<tr>
<td>Working with Multiple Concurrent Telnet Sessions</td>
<td>129</td>
</tr>
<tr>
<td>Overview of Multiple Concurrent Sessions</td>
<td>129</td>
</tr>
<tr>
<td>Initiating an Additional Telnet Session</td>
<td>129</td>
</tr>
</tbody>
</table>
# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Font Settings</td>
<td>175</td>
</tr>
<tr>
<td>Display Settings</td>
<td>177</td>
</tr>
<tr>
<td>View Settings</td>
<td>178</td>
</tr>
<tr>
<td>Cursor Settings</td>
<td>180</td>
</tr>
<tr>
<td>Beeps Settings</td>
<td>182</td>
</tr>
<tr>
<td>Telnet Settings</td>
<td>183</td>
</tr>
<tr>
<td>Printer Settings</td>
<td>183</td>
</tr>
<tr>
<td><strong>Appendix A: Using Microsoft ActiveSync</strong></td>
<td>187</td>
</tr>
<tr>
<td>Requirements</td>
<td>187</td>
</tr>
<tr>
<td>Overview of Creating a Partnership</td>
<td>187</td>
</tr>
<tr>
<td>Selecting the Microsoft ActiveSync Connection Method on the Mobile Device</td>
<td>187</td>
</tr>
<tr>
<td>Selecting the Microsoft ActiveSync Method on the Host System</td>
<td>188</td>
</tr>
<tr>
<td>Freeing a COM Port</td>
<td>191</td>
</tr>
<tr>
<td>Creating a Partnership</td>
<td>191</td>
</tr>
<tr>
<td>Creating a Standard Partnership</td>
<td>192</td>
</tr>
<tr>
<td>Creating a Guest Partnership</td>
<td>196</td>
</tr>
<tr>
<td><strong>Appendix B: Common Configuration Tasks</strong></td>
<td>201</td>
</tr>
<tr>
<td>Configuring Passwords</td>
<td>201</td>
</tr>
<tr>
<td>Configuring the Number of Concurrent Sessions</td>
<td>203</td>
</tr>
<tr>
<td>Configuring IP Printing</td>
<td>204</td>
</tr>
<tr>
<td>Configuring License Server IP Address</td>
<td>205</td>
</tr>
<tr>
<td>Configuring TelnetCE Client Display Settings</td>
<td>206</td>
</tr>
<tr>
<td>Configuring TelnetCE Client Lockdown</td>
<td>207</td>
</tr>
<tr>
<td>Configuring Key Macros</td>
<td>209</td>
</tr>
<tr>
<td>Configuring Screen Panning</td>
<td>210</td>
</tr>
<tr>
<td>Configuring ActiveText</td>
<td>212</td>
</tr>
<tr>
<td>Configuring Scan Handlers</td>
<td>213</td>
</tr>
<tr>
<td>Configuring Autologin for VT Emulation</td>
<td>215</td>
</tr>
<tr>
<td>Configuring Telnet Negotiation Strings for VT Emulation</td>
<td>217</td>
</tr>
<tr>
<td>Configuring Workstation IDs for 5250/3270 Emulation</td>
<td>218</td>
</tr>
<tr>
<td>Enabling Battery Strength and Signal Strength Icons</td>
<td>220</td>
</tr>
<tr>
<td>Configuring Indicator Settings</td>
<td>222</td>
</tr>
<tr>
<td><strong>Appendix C: Using the TelnetCE Client License Server</strong></td>
<td>223</td>
</tr>
<tr>
<td>TelnetCE Client License Server Overview</td>
<td>223</td>
</tr>
<tr>
<td>License Server Versions and Maintenance Licenses</td>
<td>224</td>
</tr>
<tr>
<td>Installing the TelnetCE Client License Server</td>
<td>225</td>
</tr>
<tr>
<td>Installation Methods</td>
<td>225</td>
</tr>
<tr>
<td>Installing the License Server as a Windows Application</td>
<td>225</td>
</tr>
<tr>
<td>Installation Requirements</td>
<td>225</td>
</tr>
<tr>
<td>Installing License Server</td>
<td>226</td>
</tr>
<tr>
<td>Installing License Server as a Windows Service</td>
<td>226</td>
</tr>
<tr>
<td>Using the License Server</td>
<td>227</td>
</tr>
<tr>
<td>Launching the License Server</td>
<td>227</td>
</tr>
</tbody>
</table>
Chapter 1: Introduction

This document provides information about installing, configuring, and using the Wavelink TelnetCE Client for Windows CE-based mobile devices.

This section provides the following information:

• Document assumptions
• Document conventions
• Document revision history
• An overview of the TelnetCE Client
• TelnetCE Client version and supported features matrix

Document Assumptions

This document assumes that the reader has the following:

• Familiarity with Windows CE operating systems and the mobile device to which you are deploying the Wavelink TelnetCE Client.

• Knowledge of wireless networks and wireless networking protocols (IEEE 802.11b).

• Knowledge of TCP/IP, including IP addressing, subnet masks, routing, BOOTP/DHCP, WINS, and DNS.

• Knowledge of Telnet services and terminal emulation, including IBM 5250/3270, HP, and VT100/220.

• Knowledge of Wavelink Avalanche Manager and Avalanche Enablers (optional, for users that intend to install and configure the TelnetCE Client via Avalanche Manager).

Document Conventions

The following section contains information about text-formatting conventions in this manual.
Table 1-1 lists the conventions that are used in this manual.

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>courier new</td>
<td>Any time you interact directly with text-based user interface options, such as a button, or type specific information into an text box, such as a file pathname, that option appears in the Courier New text style. This text style is also used for keys that you press, filenames, directory locations, and status information. For example: Press ENTER. Click OK.</td>
</tr>
<tr>
<td>bold</td>
<td>Any time this document refers to a labelled user interface option, such as descriptions of the choices in a dialog box, that option appears in the Bold text style. Examples: Enable the DHCP checkbox. Access the TelnetCE Client Session menu.</td>
</tr>
<tr>
<td>italics</td>
<td>Italicized text is used to indicate the name of a window or dialog box. For example: The Update Utility dialog box. The Profile Manager dialog box.</td>
</tr>
</tbody>
</table>

Table 1-1: Text-Formatting Conventions

If you have questions about the terminology in this document, see the Glossary on page 235.
Document Revision History

The following table shows the Wavelink TelnetCE Client User’s Guide revision history:

<table>
<thead>
<tr>
<th>Document Number</th>
<th>Release Date</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>wltn-cegeneric-200411120-01</td>
<td>11/12/04</td>
<td>Initial release of generic TelnetCE Client document</td>
</tr>
<tr>
<td>wltn-wince-20040729-02</td>
<td>07/29/05</td>
<td>- Reorganized manual into new chapters and sections</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Added information to support new TelnetCE Client version 5.0 and 5.1 features, including SSL, scripting, and the keyboard builder</td>
</tr>
<tr>
<td>wltn-wince-20050805-03</td>
<td>08/05/2005</td>
<td>Updated screen captures</td>
</tr>
</tbody>
</table>

Table 1-2: Document Revision History

About the TelnetCE Client

This section provides an overview of the TelnetCE Client.

TelnetCE Client Overview

The TelnetCE Client is a Windows CE-based application that facilitates IBM 5250/3270, VT 100/220, and HP Telnet emulation.

Deployment Methods

Currently, you can use one of the following methods to install and configure the TelnetCE Client on a mobile device:

- **Microsoft ActiveSync.** You can install the TelnetCE Client configuration utility on a host PC. The configuration utility uses an ActiveSync connection between the host PC and the mobile device to deploy the TelnetCE Client and TelnetCE Client configurations to the mobile device.

- **Wavelink Avalanche Manager.** If your mobile device is running the Avalanche Enabler, you can use Avalanche Manager to deploy the TelnetCE Client and TelnetCE Client configurations to a mobile device.
• **Third-Party Applications.** Wavelink supports some third-party deployment applications. For more information about supported deployments for your device, please see the TelnetCE Client installation guide for your mobile device.

**TelnetCE Client Components**

The TelnetCE Client has a number of configurable components, including:

• Host profiles
• Emulation parameters
• Localization
• SSL settings
• Scripts
• Virtual keyboards

**NOTE** Scripts and virtual keyboard settings may only be deployed to mobile devices via Avalanche Manager. If you are using Microsoft ActiveSync or a third-party application to deploy the TelnetCE Client and TelnetCE Client configurations to your mobile devices, you will need to manually transfer the script files and virtual keyboard files to each mobile device.

**About Host Profiles**

A host profile contains all of the information that a mobile device needs to connect to a particular host, including the IP address of the host, the TCP port number on which the host is listening for Telnet requests, the emulation type, and login information.

Host profiles provide an easy way for users at a mobile device to establish a connection with a host without having to remember the parameters that are required to establish the session.

**About Emulation Parameters**

The configuration utility allows you to configure the emulation parameters for Telnet sessions. For example, you can change the way the virtual screen
displays on the mobile device, the type and size of font that is used, and the
type of printer to which the mobile device may be connected.

You can configure global and per-host emulation parameters.

Global emulation parameters apply to terminal emulation with hosts for
which you have not configured a per-host profile.

Configuring per-host emulation parameters allows you to specify the
emulation parameters for terminal emulation sessions with a particular host.

**About Localization**

Localization allows you to deploy language profiles with the TelnetCE Client.
The language profile allows you to convert common textual strings into a
different language. The TelnetCE Client will then display the converted string
rather than the native string.

**About SSL**

The TelnetCE Client allows SSL-encrypted Telnet connections between a
mobile device and a host system. The TelnetCE Client also provides certificate
verification for SSL connections. You may import your own trusted
certificates into the TelnetCE Client, or you may use the TelnetCE Client
installation and configuration utility to create your own certificates, which
you can then import to your Telnet server or Wavelink TermProxy server.

**About Scripting**

The TelnetCE Client provides automated services through scripting. For
example, you might create a user-login script. TelnetCE Client scripting
provides for the automatic generation of scripts through script recording.
Alternatively, use the Script Editor to create your own scripts or to modify
recorded scripts.

**About Keyboard Creator**

Use the TelnetCE Client Keyboard Creator to modify the standard TelnetCE
Client virtual keyboards to meet the needs of your production environment.
The Keyboard Creator allows you to completely modify the layout of the
virtual keyboard for each emulation type. Additionally, import your own
graphic files (bitmaps) to create your own unique buttons for the keyboard.

**TelnetCE Client Functionality**

The TelnetCE Client provides the following functionality:
• Use host profiles to initiate Telnet sessions with hosts.

• Connect to a host through Wavelink TermProxy.

• Engage in up to four simultaneous Telnet sessions.

• Configure Wavelink licensing.

• Configure new host profiles.

• View and modify certain per-host emulation parameters, including scan codes and symbologies.

• View the current device wireless and IP settings.

• View TelnetCE Client version information.

• Integration with the Avalanche framework to provide session monitoring and viewing of real-time statistics from Avalanche Management Console.

**TelnetCE Client Version and Supported Features Matrix**

The key features of the TelnetCE Client - host profiles, emulation parameters, localization, SSL support, scripting, keyboard building, and Avalanche integration - may not be supported in your version of the TelnetCE Client.

The following table provides information about the supported features in each major revision of the TelnetCE Client.

<table>
<thead>
<tr>
<th>TelnetCE Client Version</th>
<th>Host Profiles</th>
<th>Emulation Parameters</th>
<th>Localization</th>
<th>SSL Support</th>
<th>Scripting</th>
<th>Keyboard Builder</th>
<th>Avalanche Integration</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.xx-xx</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>5.00-xx</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>5.1-xx</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

*Table 1-3: TelnetCE Client Version and Supported Features Matrix*
The TelnetCE Client version number consists of three numbers:

- A version number
- A revision number
- A build number

For example, if your version number is 5.00-10, then:

- 5 is the version number
- 00 is the revision number
- 10 is the build number
Chapter 2: Installation and Configuration

This section provides the following information:

- Installing the TelnetCE Client
- Configuring the TelnetCE Client
- Deploying configurations

Installing the TelnetCE Client

This section provides an overview of the TelnetCE Client.

Currently, you can use one of the following methods to install the TelnetCE Client on a mobile device:

- **Microsoft ActiveSync.** You can install the TelnetCE Client configuration utility on a host PC. The configuration utility uses an ActiveSync connection between the host PC and the mobile device to deploy the TelnetCE Client and TelnetCE Client configurations to the mobile device.

- **Wavelink Avalanche Manager.** If your mobile device is running the Avalanche Enabler, you can use Avalanche Manager to deploy the TelnetCE Client and TelnetCE Client configurations to a mobile device.

- **Third-Party Applications.** Wavelink supports some third-party deployment applications. For more information about supported deployments for your device, please see the TelnetCE Client reference guide for your mobile device.

Because installation methods vary across mobile devices, each mobile device has its own reference guide. For information about installing the TelnetCE Client on your mobile device, please see the reference guide for that mobile device.

**NOTE** To obtain the reference guide for your mobile device, please contact Wavelink customer service. *Appendix D: Wavelink Contact Information* on page 233 contains Wavelink contact information.
Cold Boot Recovery

All TelnetCE Client installations are designed to survive a device cold boot. Additionally, the TelnetCE Client is configured to automatically re-install in the event of a cold boot. The cold boot recovery process ensures that not only the TelnetCE Client application survives a cold boot, but also the TelnetCE Client configuration. Any deviation or exception to this process will be noted in the reference guide for your mobile device.

To allow the TelnetCE Client to survive a cold boot, a backup copy of the TelnetCE Client is stored in the non-volatile (Flash) memory of the device. A copy of any configuration files for the TelnetCE Client are also stored in this location when they are downloaded to the mobile device.

Cold boot recovery processes vary across mobile devices. Each TelnetCE Client is designed to use the recovery method of the mobile device for which it has been designed.

Configuring the TelnetCE Client

This section provides the following information:

- Configuration overview
- Configuration support matrix
- Configuring the TelnetCE Client with Microsoft ActiveSync
- Configuring the TelnetCE Client with Avalanche Manager

Configuration Overview

Under most circumstances, you will use the same installation/configuration application to configure the TelnetCE Client that you used to deploy the TelnetCE Client to your mobile device.

The following tasks describe the process of configuring the TelnetCE Client:

1. Use the installation and configuration application to create and store TelnetCE Client configuration files on the host system.

2. Use the installation and configuration application to download the configuration files to the mobile device.
For example, if you installed the TelnetCE Client to a mobile device using the Microsoft ActiveSync installation and configuration utility, then you would also use the same utility to create the TelnetCE Client configuration files. After creating and saving the configuration files on the host system, you would then use the installation and configuration utility to push the configuration files down to the mobile device over an ActiveSync connection between the host system and the mobile device.

![Figure 2-1. ActiveSync Installation and Configuration Utility](image)

You may configure the following parameters and options for the TelnetCE Client:

- **Host Profiles.** A host profile contains all of the required information for a mobile device to connect to a host system, including an alias, IP address, TCP port, and other emulation-specific parameters. The TelnetCE Client supports multiple host profiles to allow a user at the device to easily create a Telnet session with a host system.

- **Emulation Parameters.** Emulation parameters provide control over many aspects of an emulation session, including key macros, text and screen display, and barcode scanning. You may control the settings of an emulation session on a global level or on a per-host level.
- **Localization.** Localization allows you to convert strings of text from one language to another. Use the Localization tool to create conversions, then configure the TelnetCE Client to use the appropriate language. For example, you might create support files to convert server strings from English to Spanish.

- **SSL and SSL Certificates.** Some versions of the TelnetCE Client support encryption-protected Telnet connections via SSL. You may also configure the TelnetCE Client for SSL certificate validation. SSL is configured via host profiles. You may also use the configuration and installation utility to import certificates from trusted servers or to generate new certificates that you can then export to your Telnet or Wavelink TermProxy server(s).

- **Scripting.** Scripting allows you to automate functions within the TelnetCE Client. For example, you might create a login script for users. You may record scripts, or you may use the Script Editor to create new scripts or modify existing scripts.

- **Keyboard Builder.** Use the Keyboard Builder to generate virtual keyboards for your TelnetCE Client. You may create any number of virtual keyboards to meet the needs of your production environment.

### Configuration Support Matrix

Depending on the TelnetCE Client installation and configuration utility that you are using, the applications and tools that allow you to configure TelnetCE Client features may not be available. Table 2-1 provides information about the configuration tools that are available for your chosen installation and configuration method:

<table>
<thead>
<tr>
<th>Deployment Method</th>
<th>Host Profiles</th>
<th>Emulation Parameters</th>
<th>Localization</th>
<th>SSL Support</th>
<th>Scripting*</th>
<th>Keyboard Builder</th>
</tr>
</thead>
<tbody>
<tr>
<td>Avalanche</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>ActiveSync</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Third-Party Application</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

* You may configure scripting through the TelnetCE Client interface on the mobile device

**Table 2-1: TelnetCE Client Configuration Support Matrix**
Using Avalanche Manager to Configure the TelnetCE Client

You may use the Avalanche framework to update the TelnetCE Client configuration.

To configure the TelnetCE Client through Avalanche Manager:

1. Ensure that the TelnetCE Client Avalanche package is installed in Avalanche Manager.

   NOTE For more information about installing the TelnetCE Client in Avalanche Manager, see the reference guide for your mobile device.

2. Launch the Management Console and connect to the Agent.

3. In the Tree View of Management Console, locate and right-click the TelnetCE Client package.

   A menu list appears.

4. Select **Configure Package** (Figure 2-2).

   ![Configure Package](image)

   **Figure 2-2. Configuring the TelnetCE Client Package**

   A menu list appears.

5. From the menu list, select the component of the TelnetCE Client that you want to configure:

   - Select **Host Profiles** to access the **Host Profiles** dialog box, which will allow you to configure host profiles and SSL settings for the TelnetCE Client.
NOTE For more information about configuring host profiles, see Chapter 3: Host Profiles on page 25.

- Select Emulation Parameters to access Configuration Manager, which will allow you to modify emulation parameters for the TelnetCE Client.

NOTE For more information about configuring emulation parameters, see Chapter 4: Emulation Parameters on page 55.

- Select Script Editor to access the script editor, which will allow you to import and configure scripts for the TelnetCE Client.

NOTE For more information about configuring scripts, see Chapter 5: Scripting on page 75.

- Select Keyboard Creator to access the Keyboard Creator, which will allow you to create and import virtual keyboards for the TelnetCE Client.

NOTE For more information about using the Keyboard Creator, see Chapter 6: Keyboard Creator on page 99.

- Select Localization to configure the Localization settings for the TelnetCE Client.

After you have configured the new settings for the TelnetCE Client, use Avalanche Manager to deploy the new configuration to the mobile device.

NOTE For information about deploying TelnetCE Client configurations to the mobile device, see Deploying Configurations on page 16.
Using Microsoft ActiveSync to Configure the TelnetCE Client

Use the Microsoft ActiveSync installation and configuration utility to configure host profiles, emulation parameters, and localization. After you have created the configuration, push the configuration files to the mobile device over a Microsoft ActiveSync connection between the host system and the mobile device.

To configure the TelnetCE Client using Microsoft ActiveSync:

1. Ensure that the Microsoft ActiveSync TelnetCE Client installation and configuration utility is installed on the host system.

   **NOTE** For more information about installing and using the Microsoft ActiveSync installation and configuration utility, see the TelnetCE Client reference guide for your mobile device.

2. Launch the installation and configuration utility on the host system.
   
   The Wavelink Product Configuration dialog box appears (Figure 2-3).

![Wavelink Product Configuration Dialog Box](image)

**Figure 2-3. Wavelink Product Configuration Dialog Box**
3 Click the icon button for the TelnetCE Client component that you want to configure:

- Click the Host Profiles icon button to access the Host Profiles dialog box, which will allow you configure host profiles and SSL settings for the TelnetCE Client.

**NOTE** For more information about host profiles, see Chapter 3: Host Profiles on page 25.

- Click the Emulation Parameters icon button to access Configuration Manager, which will allow you to configure emulation settings for the TelnetCE Client.

**NOTE** For more information about emulation parameters, see Chapter 4: Emulation Parameters on page 55.

- Click the Localization icon button to access the Localization dialog box, which will allow you to configure localization settings for the TelnetCE Client.

4 After you have created the new configuration for the TelnetCE Client, use the installation and configuration utility to download the new configuration files to the mobile device over an ActiveSync connection between the host system and the mobile device.

**NOTE** For more information about deploying configuration, see Deploying Configurations on page 16.

## Deploying Configurations

This section provides the following information:

- Deploying TelnetCE Client configurations via Avalanche Manager
- Deploying TelnetCE Client configurations via Microsoft ActiveSync
Deploying Configurations via Avalanche Manager

Use the Avalanche framework to deploy new TelnetCE Client configurations to the mobile device.

Deploying TelnetCE Client configurations to the mobile device involves the following tasks:

1. Prepare Avalanche Manager and the Avalanche Enabler on the mobile device for the update.

2. Create a connection to download the configuration to the mobile device.

Preparing for Updates

Avalanche Manager provides communication between the Avalanche Agent and the Avalanche Enabler on the mobile device over the following media:

- Serial port
- RAPI (Microsoft ActiveSync)
- IP

NOTE RAPI support is available in Avalanche Manager 3.5 (or greater version). On the device-side, RAPI connections are supported available for mobile devices with a 3.5 (or greater) version of the Avalanche Enabler and for some pre-3.5 Avalanche Enablers.

Before you can create a connection between the Avalanche Agent and the mobile device over which the new configuration will be download, you must prepare both the mobile device and Avalanche Manager for the update media.

Before you install the TelnetCE Client a mobile device, ensure that the host system and the mobile device are properly configured.

Preparing the host system and the mobile device depends on the type of media that you are using to connect the host system to the mobile device.

Avalanche Manager allows serial connections and RF connections.
Preparing for Serial Updates
Use the following guidelines to prepare the serial connection between the mobile device and Avalanche Manager:

- Ensure that the Avalanche Enabler is installed and functioning properly on the mobile device.
- Ensure that the Avalanche Enabler on the mobile device is configured properly. If you have problems, verify the following:
  - The Avalanche Enabler is configured to use serial updates.
  - The Avalanche Enabler is configured with the IP address of the Avalanche Manager.
- Ensure that the software collection in which you have installed the TelnetCE Client software package is configured to allow RF updates.
- Ensure that Avalanche Manager is configured to use the serial port on the host system that is connected to the mobile device (Figure 2-4).

![Avalanche Agents](image)

Figure 2-4. Serial Ports Enabled in Avalanche Manager

Preparing for RAPI Updates
Use the following guidelines to prepare the RAPI connection between the mobile device and the Avalanche Manager:

- Ensure that your Avalanche Manager supports RAPI gateways. (RAPI gateways are available in Avalanche Manager 3.5 and greater versions.)
• Ensure that the Avalanche Enabler on the mobile device supports RAPI connections. (RAPI connections are supported in 3.5 and greater versions of the Avalanche Enabler.)

• Because RAPI gateways use Microsoft ActiveSync, ensure that you can create a Microsoft ActiveSync connection between the mobile device and the host system (that is, the system that hosts the Avalanche Agent).

• Ensure that you have created a RAPI gateway in Avalanche Manager (Figure 2-5).

![Avalanche Agents](image)

Figure 2-5. RAPI Gateway in Avalanche Manager

**Preparing for IP Updates**
Use the following guidelines to prepare the IP connection between the mobile device and the Avalanche Manager:

• Ensure that the Avalanche Enabler is installed and functioning properly on the mobile device.

• Ensure IP connectivity between the mobile device and the host system. If you have problems, verify the following:
  
  • The host system has a valid IP address.
  
  • The mobile device has a valid IP address.
• The mobile device is configured with the correct ESSID.

• The mobile device is using the correct WEP key, if WEP is enabled on the wireless LAN.

• The host system has a valid IP route to the mobile device.

• The mobile device has a valid IP route to the host system.

• Any firewalls between the host system and the mobile device are configured to allow TCP traffic to port 1779 (the port that Avalanche uses for TCP communication).

• Ensure that the Avalanche Enabler on the mobile device is configured with the correct IP address of the Avalanche Manager.

• Ensure that the synchronization settings for the selection criteria for the software collection to which the TelnetCE Client package belongs allows IP synchronization (Figure 2-6).
After you have prepared the synchronization medium, create a connection between the Avalanche Agent and the mobile device to download the new configuration.

To deploy the new configuration to the mobile device:

1. Launch Avalanche Manager and connect to the Agent.

2. In the Avalanche Agents tree, locate and right-click the TelnetCE Client software package.

   A menu list appears.
3 From the menu list, select **Enable Package**.

The software package is enabled and ready to download to mobile devices.

4 Use one of the following methods to update the client:

- From the Avalanche Enabler on the mobile device, select **File > Connect**.

- In the Device View of Avalanche Manager, right-click the mobile device and select **Update Now (Allow User Override)** or **Update Now (Disallow User Override)**.

**NOTE** You cannot use Update Now to force an update over a serial or RAPI connection. Serial connections must be initiated from the mobile device. RAPI updates occur whenever a Microsoft ActiveSync connection is initiated between a mobile device and the host system.

- Wait for the mobile device to perform a periodic update according to the Avalanche Enabler configuration on the mobile device.

- Wait until Avalanche Manager instructs the mobile device to perform an update, which occurs according to the Scheduled Updates configuration of Avalanche Manager.

- For RAPI updates, connect the mobile device to the host system in a manner that will initiate a Microsoft ActiveSync connection between the mobile device and the host system.

When you create the connection between the host system and the mobile device, the configuration files are downloaded to the mobile device.

**NOTE** Only the configuration files that have changed are pushed down to the mobile device. The new configuration files replaced (overwrite) the existing configuration files on the device.
Deploying Configurations via Microsoft ActiveSync

Use a Microsoft ActiveSync connection between the host system and the mobile device to download new TelnetCE Client configurations to the mobile device.

To deploy a new configuration to the mobile device using Microsoft ActiveSync:

1. Ensure that you have a Microsoft ActiveSync between the host system and the mobile device.

**NOTE** For more information about using Microsoft ActiveSync, see Appendix A: Using Microsoft ActiveSync on page 187.

2. Launch the Microsoft ActiveSync TelnetCE Client installation and configuration utility (Figure 2-7).

![Wavelink Product Configuration Dialog Box](image)

**Figure 2-7. Wavelink Product Configuration Dialog Box**

3. Click Config Only.

The new configuration is downloaded to the mobile device. Any existing TelnetCE Client configuration files on the mobile device are overwritten.
NOTE All configuration files, including those for host profiles, emulation parameters, and localization settings are downloaded to the mobile device when you click the Config Only button.
Chapter 3: Host Profiles

This section provides the following information:

• Overview of host profiles
• Configuring host profiles
• Host profiles and SSL
• Host profiles and Wavelink TermProxy
• Host profile settings

Overview of Host Profiles

A host profile defines the parameters that the TelnetCE Client should use when it attempts to initiate a Telnet connection with a specific host. You may configure as many host profiles for the TelnetCE Client as you wish.

When a user at the mobile device attempt to use the TelnetCE Client to initiate a Telnet session with a host, the TelnetCE Client displays a list of available host profiles (Figure 3-1).
The user selects the host to which they wish to connect, and the TelnetCE Client uses the host profile settings to attempt to establish a session with the host.

You may configure the following settings for a host profile:

- **Alias.** This is the alias of the connection. Use a name that adequately describes the host system to which the user is connecting.

- **Emulation Type.** This is the emulation type that the TelnetCE Client should use when connecting to the host system.

- **IP Address.** This is the IP address of the host system to which the user is connecting.

- **Port.** This is the TCP listening port of the host system.

- **SSL Settings.** You may select to protect the Telnet connection to the host system via SSL. You may also configure the SSL connection for certificate validation and import trusted certificates.
• **TermProxy Settings.** You may configure the TelnetCE Client to connect to a Wavelink TermProxy server. You may define up to three TermProxy connections for failover purposes. You may configure the TermProxy connection to use SSL with certificate validation.

• **Language.** If your TelnetCE Client supports the language feature, you may configure the TelnetCE Client to display a certain set of characters while connected to the host system.

• **Workstation ID.** If you have configured the host profile for IBM-type emulation, then you may configure a unique and/or dynamic workstation ID that the TelnetCE Client will use when connecting to the host system.

• **Telnet Negotiation String.** If you have configured the host profile for VT-type emulation, then you may configure a Telnet negotiation string that the TelnetCE Client will use when connecting to the host system.

• **Autologin.** If you have configured the host profile for VT-type emulation, then you may configure autologin settings that the TelnetCE client will use when connecting to a host system.

• **Host-Specific Emulation Parameters.** You may configure host-specific emulation parameters. These parameters will override global emulation parameter settings during Telnet connections to the host system that the host profile specifies.

### Configuring a Host Profile

Use the *Host Profiles* dialog box to configure host profiles (Figure 3-2). See *Chapter 2: Installation and Configuration* on page 9 for information about using your specific installation and configuration utility to access the *Host Profiles* dialog box.
Each host profile that you configure appears in the left panel of the Host Profiles dialog box.

The following tasks outline the process of configuring host profiles for the TelnetCE Client:

1. Access the Host Profiles dialog box.
2. Add, modify, or remove host profiles and save the changes.
3. Download the configuration to mobile devices.

When you save the host profiles that you have configured, the changes you have made are saved to a configuration file.

**Adding a Host Profile**

You can use the Host Profiles dialog box to create a new host profile.

**To create a new host profile:**

1. Access the Host Profiles dialog box.
2 In the Host Profiles dialog box, click New.

Various tabs appear in the Host Profiles dialog box that allow you to configure the parameters for a new host profile. The tabs that appear are dependent on the type of emulation that you select for the host profile. The Host Profiles dialog box automatically defaults to an IBM 5250 emulation type.

3 Use the tabs in the Host Profiles dialog box to configure the host profile.

The name (alias) of the host profile appears in the left text box of the Host Profiles dialog box.

**NOTE** For information about the various tabs in the Host Profiles dialog box, see Host Profile Settings on page 41.

4 After you have finished configuring the host profile, click OK.

The new host profiles configuration is saved to the host system.

5 Download the new host profiles configuration to the mobile device.

**NOTE** For information about using the Microsoft ActiveSync utility or the Avalanche TelnetCE Client to download configurations to mobile devices, see Deploying Configurations on page 16.

**NOTE** To exit the Host Profiles dialog box without saving the changes that you have made, click Cancel.

### Modifying an Existing Host Profile

You can use the Host Profiles dialog box to modify an existing host profile.

**To modify an existing host profile:**

1 Access the Host Profiles dialog box.

2 From the list of host profiles in the text box in the left of the dialog box, select the host profile that you want to modify.
3 Use the various tabs in the Host Profiles dialog box to configure the host profile.

**NOTE** For information about the parameters in the various tabs of the Host Profiles dialog box, see Host Profile Settings on page 41.

4 After you have finished modifying the host profile, click **OK**.

   The new host profiles configuration is saved to the host system.

5 Download the new host profiles configuration to the mobile device.

**NOTE** For information about using the Microsoft ActiveSync utility or the Avalanche TelnetCE Client to download configurations to mobile devices, see Deploying Configurations on page 16.

**NOTE** To exit the Host Profiles dialog box without saving the changes that you have made, click **Cancel**.

### Deleting a Host Profile

You can use the Host Profiles dialog box to delete an existing host profile.

1 Access the Host Profiles dialog box.

2 In the text box on the left side of the Host Profiles dialog box, select the host profile that you want to remove.

3 Click **Delete**.

   The host profile is removed from the Host Profiles dialog box.

4 After you have finished configuring the host profile, click **OK**.

   The new host profiles configuration is saved to the host system.

5 Download the new host profiles configuration to the mobile device.
NOTE For information about using the Microsoft ActiveSync utility or the Avalanche TelnetCE Client to download configurations to mobile devices, see Deploying Configurations on page 16.

NOTE To exit the Host Profiles dialog box without saving the changes that you have made, click Cancel.

Host Profiles and SSL

The TelnetCE Client supports encryption-protect Telnet sessions via SSL. The TelnetCE Client supports SSL Telnet connections to host servers, as well as to the Wavelink TermProxy server.

NOTE Wavelink TermProxy provides SSL support for connections between the mobile device and the TermProxy server. Wavelink TermProxy does not support SSL connections between the TermProxy server and host systems.

The TelnetCE Client also supports certificate validation for SSL connections.

To enable and use SSL for the TelnetCE Client requires the following:

• Install the SSL support package on the host system.

• Install the SSL support package on the mobile device.

• Enable SSL for the host profile.

• Enable certificate validation for the host profile and import server certificates (optional, if you want to use SSL with certificate verification).

Installing the SSL Support Package on the Host System

Before you can begin configuring SSL and SSL certificates from the installation and configuration utility that you are using, you must install the SSL support package on the host system.
The SSL support package is a self-extracting executable that installs the required files that will allow you to configure SSL and SSL certificates.

**NOTE** To obtain the SSL support package, please contact Wavelink customer service. Appendix D: Wavelink Contact Information on page 233 contains Wavelink contact information.

### Installing the SSL Support Package on the Mobile Device

The TelnetCE Client will not be able to initiate SSL connections with hosts until you install the SSL support package on the mobile device.

Use one of the following methods to deploy the SSL support package to the mobile device:

- **Avalanche Manager.** The SSL support package is available as an Avalanche software package.

- **Microsoft ActiveSync.** The SSL support package is available as a bundled package that you can deploy over a Microsoft ActiveSync connection between a host system and the mobile device.

- **Third-Party Application.** The SSL support package is available for some third-party deployment applications.

**NOTE** To obtain the SSL support package for the mobile device, please contact Wavelink customer service. Appendix D: Wavelink Contact Information on page 233 contains Wavelink contact information.

### Enabling SSL

SSL is enabled via the *Host Profiles* dialog box. It enabled on a per-host profile basis.

When you configure a host profile to use SSL, the TCP port for the host profile is automatically changed to 992, which is the well-known port number for SSL Telnet communication. If the host system uses a different port, then change the port to the correct setting.
To configure a host profile to use SSL:

1. Access the Host Profiles dialog box.

2. From the left panel of the dialog box, select the host profile that you want to configure.

3. Depending on the connection requirements for the host profile, select one of the following:

   - If the host profile specifies a direct connection to a server, then enable the Use SSL/TLS Encryption option box in the Host tab (Figure 3-3).

   - If the host profile specifies a connection to a Wavelink TermProxy server, then enable the Use SSL/TLS Encryption option box in the TermProxy tab.

   **NOTE** You will not be able to configure the Use SSL/TLS Encryption option box in the TermProxy tab until you select an option from the TermProxy Server menu list.

![Host Profiles dialog box](image)

**Figure 3-3.** Enabling SSL for a Host Profile
4 After you have finished configuring the host profile, click **OK**.

The new host profiles configuration is saved to the host system.

5 Download the new host profiles configuration to the mobile device.

---

**NOTE** For information about using the Microsoft ActiveSync utility or the Avalanche TelnetCE Client to download configurations to mobile devices, see *Deploying Configurations* on page 16.

---

### Enabling Certificate Verification

When SSL is enabled, you may configure the TelnetCE Client to perform certificate verification. This prevents the TelnetCE Client from connecting to unauthorized servers.

Use the *Host Profiles* dialog box to import trusted certificates, which you can then download to the mobile device using the installation and configuration utility. When certificate verification is enabled for a host profile, the TelnetCE Client will test the credentials of the host system against the imported certificates and will refuse connections with host systems that present a certificate that is not in its list of imported certificates.

**To enable certificate validation and import valid certificates:**

1 Access the *Host Profiles* dialog box.

2 From the left panel of the dialog box, select the host profile that you want to configure.

3 Depending on the connection requirements for the host profile, select one of the following:

   - If the host profile specifies a direct connection to a host, then enable the **Verify Server Certificates** option box in the Host tab.

   - If the host profile specifies a connection to a Wavelink TermProxy server, then enable the **Verify Server Certificates** option box in the TermProxy tab (Figure 3-4).
4 Click the corresponding Select Verification Certificates button. The Certificate Manager dialog box appears.

5 Click Insert Certificate... to browse to and import a server certificate.

6 Click Create Certificate... to create a certificate and private key that you can then export to a TermProxy server or other host system (Figure 3-5).

Figure 3-4. Enabling Certificate Validation
NOTE The certificates that you import and/or configure are available for all host profiles that you configure. The imported certificates should be considered a database or list of certificates against which the TelnetCE Client will check when initiating an SSL Telnet session with a host. If the host does not present a certificate that is in the list, then the TelnetCE Client will not establish a connection with the host.

7 After you have finished importing/configuring certificates, click **OK**.

The Certificate Manager dialog box closes.

8 Click **OK** to close the Host Profiles dialog box and save your new host profile settings.

9 Download the new host profiles configuration to the mobile device.
**NOTE** For information about using the Microsoft ActiveSync utility or the Avalanche TelnetCE Client to download configurations to mobile devices, see *Deploying Configurations* on page 16.

## Host Profiles and Wavelink TermProxy

The TelnetCE Client provides integration with Wavelink TermProxy 2.x and 3.x.

Wavelink TermProxy provides proxy services, mainly for session persistence, between the TelnetCE Client and host systems.

**NOTE** For more information about Wavelink TermProxy, contact Wavelink customer service. *Appendix D: Wavelink Contact Information* on page 233 provides Wavelink contact information.

You may use the *Host Profiles* dialog box to configure the following:

- TermProxy-only connections
- TermProxy-failover connections

**NOTE** TermProxy support (via the *Host Profiles* dialog box) is only available in version 5.0 (and greater) of the TelnetCE Client. While TermProxy 2.x allows connections from any type of TelnetCE Client, TermProxy 3.x requires connections from a 5.0 (or greater) TelnetCE Client.

### Configuring a TermProxy-Only Connection

By default, if the TelnetCE Client cannot connect to the specified TermProxy server, then it will attempt a direct connection to the host. You may, however, configure the TelnetCE Client to only connect to a host through a Wavelink TermProxy server.

**To configure a TermProxy-only connection to a host system:**

1. Access the *Host Profiles* dialog box.
2. Select the host profile that you want to configure.
3 In the Host tab, enable the **Only Use TermProxy Connections** checkbox (Figure 3-6).

![Host Profiles](image)

*Figure 3-6. Enabling TermProxy-Only Connections*

4 Use the TermProxy tab to configure the settings for the TermProxy server.

**NOTE** For more information about settings in the TermProxy tab, see *Host Profile Settings* on page 41.

5 After you have finished configuring the host profile, click **OK**.

The new host profiles configuration is saved to the host system.

6 Download the new host profiles configuration to the mobile device.

**NOTE** For information about using the Microsoft ActiveSync utility or the Avalanche TelnetCE Client to download configurations to mobile devices, see *Deploying Configurations* on page 16.
Configuring TermProxy Failover

Use the TermProxy tabs in the Host Profiles dialog box to configure host and TermProxy failover. You may configure up to three failover connections for a host profile.

When the TelnetCE Client attempts to use the host profile to initiate a connection with a host, it will attempt connections in the following order:

- Host specified in the Host tab of the host profile. (If you have specified a TermProxy-only connection, then it will attempt the host specified in the TermProxy 1 tab.)
- Host specified in the TermProxy 1 tab
- Host specified in the TermProxy 2 tab
- Host specified in the TermProxy 3 tab

If the TelnetCE Client is unable to contact any of the specified host, then it will return an error message.

To configure TermProxy failure for a host profile:

1. Access the Host Profiles dialog box.
2. Select the host profile for which you want to configure TermProxy failover.
3. Configure the Host tab.
4. Configure the TermProxy 1 tab (Figure 3-7).
5 Configure the TermProxy 2 tab

6 Configure the TermProxy 3 tab

**NOTE** For more information about the settings in the Host and TermProxy tabs, see *Host Profile Settings* on page 41.

7 After you have finished configuring the host profile, click OK. The new host profiles configuration is saved to the host system.

8 Download the new host profiles configuration to the mobile device.

**NOTE** For information about using the Microsoft ActiveSync utility or the Avalanche TelnetCE Client to download configurations to mobile devices, see *Deploying Configurations* on page 16.
Host Profile Settings

This section describes the parameters of each tab in the Host Profiles dialog box.

Host Settings

Use the Host tab in the Host Profiles dialog box to configure the basic settings of the host profile (Figure 3-8).

Figure 3-8. Configuring Host Settings
The following list describes the options and configurable parameters in the Host tab.

**Name**
Indicates the name of the host profile, which should be synonymous with the name (alias) of the host system to which the mobile device connects when the host profile is used.

**Possible Values:** 1 - 50 alpha-numeric characters

**Default Value:** New Host

**Type**
Indicates the type of emulation that the mobile device uses when connected to the host system.

**Possible Values:** <IBM-5251-11> <IBM-3278-2> <IBM-3279-2> <IBM-3279-2-E> <VT100> <VT220> <HP>

**Default Value:** <IBM-5251-11>

**Address**
Indicates the IP address or host name of the host system to which the mobile device will connect.

**Possible Values:** Any valid IP address or host name

**Default Value:** <None>

**Port**
Indicates the TCP port number on which the host system is listening for Telnet requests from clients.

**Possible Values:** 0 - 65535

**Default Value:** 23

**Only Use TermProxy Connections**
Indicates whether the TelnetCE Client should only connect to the host through a TermProxy server. If you enable this checkbox, you must configure the host information (name, IP address, emulation type, and port) and you must also configure the TermProxy 1 tab.

**Possible Values:** <Enabled> <Disabled>

**Default Value:** <Disabled>
**Use SSL/TLS Encryption** Indicates whether the TelnetCE Client should use SSL to connect to the host system. When you enable SSL/TLS, the port will automatically change to 992, which is the well-known port for SSL Telnet communication.

**Possible Values:** <Enabled> <Disabled>

**Default Value:** <Disabled>

**Verify Server Certificates** Indicates whether the TelnetCE Client should use certificate verification before allowing a connection to the host. If you enable certificate verification, then use Certificate Manager to import trusted server certificates and/or to create your own server certificates.

**Possible Values:** <Enabled> <Disabled>

**Default Value:** <Disabled>

**Select Verification Certificates** Click this button to access the Certificate Manager, which allows you to import trusted server certificates and/or create your own server certificates for SSL certificate verification.

**TermProxy Settings**

You may configure up to three TermProxy connections. Use the TermProxy tabs to specify the parameters of the TermProxy connection (Figure 3-9).
Figure 3-9. Configuring TermProxy Settings
The following list describes the configurable options in the TermProxy tab:

**TermProxy Server**
Select the TermProxy server to which the TelnetCE Client will connect.

**Possible Values:**

- **None.** Specifies no TermProxy or alternate host is used.

- **Version 2.x.** Specifies TermProxy 2.x. TermProxy 2.x will accept connections from any TelnetCE Client.

- **Version 3.x.** Specifies TermProxy 3.x. TermProxy 3.x will only accept connections from 5.x (or greater) TelnetCE Clients.

- **Alternate Telnet Host.** Specifies an alternate host system for failover purposes.

**Default Value:** <None>

**Address**
Indicates the IP address of the TermProxy server or alternate host system.

**Possible Values:** Any valid IP address

**Default Value:** None

**Port**
Indicates the TCP listening port of the TermProxy server or alternate host system.

**Possible Values:** 0 - 65535

**Default Value:** 4430
**Terminate TermProxy Session**  Indicates when the TelnetCE Client should terminate the connection to the TermProxy server.

**Possible Values:**

- **Never.** The TelnetCE Client never terminates the session established with the TermProxy server. The TermProxy server is responsible for terminating the session.

- **On Network Error.** The TelnetCE Client terminates the session with the TermProxy server when a network error occurs, such as a loss of network connectivity.

- **On Session Exit.** The TelnetCE Client terminates the session with the TermProxy server when it disconnects from the host system.

- **Always.** The TelnetCE Client will terminate the session with the TermProxy server on a network error or when it disconnects from the host system.

**Default Value:** <On Session Exit>

**Reconnect String**  Specifies the reconnect string that the mobile device should use when connecting to the host. (You may also configure reconnect strings in TermProxy.)

**Possible Values:** Any valid reconnect string

**Default Value:** None

**Use SSL/TLS Encryption**  Specifies whether the TelnetCE Client should use SSL to connect to the TermProxy server or alternate Telnet host. (TermProxy 2.x does not support SSL connections.)

**Possible Values:** <Enabled> <Disabled>

**Default Value:** <Disabled>
IBM Settings

Use the IBM settings tab of the Host Profiles dialog box to configure the creation of a dynamic name for mobile devices that are loaded with this host profile (Figure 3-10).

The IBM Settings tab only appears you have configured the host profile for an IBM-type emulation in the Host tab.
Figure 3-10. Configuring IBM Settings

NOTE: The workstation ID MUST be different for each terminal. Use the following to create a unique workstation ID:

%a - %d = IP address
%m - %t = MAC address
%s = Session number
%t = terminal ID
The following list provides information about the configurable parameters in the IBM Settings tab.

**Workstation ID**

Indicates the workstation ID that mobile devices use to connect to the host system. This includes static characters and the following switches, which are used to capture dynamic data that is specific to each mobile device:

- **%a - %d.** Captures specific octets of the IP address of the mobile device. For example, use %a%b%c%d to capture all four IP octets of the address of the mobile device, or use %d to capture only the last octet of the IP address of the mobile device.

- **%m - %r.** Captures specific octets of the MAC address of the mobile device. (For example, use %p%q%r to capture the last three octets of the MAC address of the mobile device.)

- **%s.** Captures the session number.

- **%t.** Captures the Avalanche terminal ID of the mobile device. (If the mobile device is not an Avalanche client, then this parameter is not valid.)

**Possible Values:** 0 - 20 alpha-numeric characters plus switches (see above)

**Default Value:** None

**NOTE:** IBM hosts usually truncate workstation IDs that are more than 10 characters. Also, the workstation ID should not begin with a numeric character.

**VT Settings**

Use the VT Settings tab in the *Host Profiles* dialog box to configure a Telnet negotiation string for the host connection (Figure 3-11).
A Telnet negotiation string allows you to specify the function or type of mobile device that is sending the Telnet request to the host system. The host system can then supply information to the mobile device based on Telnet negotiation string (for example, menus or display options).

The VT Settings tab only appears if you have configured the host profile for VT- or HP-type emulation in the Host tab.

![Host Profiles](image)

**Figure 3-11. Configuring VT Settings**

The following list describes the configurable parameters in the VT Settings tab.

**Telnet Negotiation String**

Specifies the Telnet negotiation string that the client should use when connecting to the host system.

**Possible Values:** 0 - 20 alpha-numeric characters

**Default Value:** <None>
**Autologin Settings**

Use the Autologin tab in the Host Profiles dialog box to configure autologin parameters for the mobile device, such as a user name and password (Figure 3-12).

The Autologin tab only appears if you have selected VT- or HP-type emulation for the host profile in the Host tab.

![Figure 3-12. Configuring Autologin Settings](image)
The following list describes the configurable options Autologin tab.

**Name - Prompts**
Indicates the user name prompt that the host system uses.

**Possible Values:** 0 - 60 alpha-numeric characters

**Default Value:** login:

**Name - CFG in terminal**
Indicates whether users should configure the response to the login prompt at the mobile device.

**Possible Values:** <Enabled> <Disabled>

**Default Value:** <Disabled>

**Name - Responses**
Indicates the response that the mobile device should send to the login prompt.

**Possible Values:** 0 - 30 alpha-numeric characters

**Default Value:** <None>

**Password - Prompts**
Indicates the password prompt that the host system uses.

**Possible Values:** 0 - 60 alpha-numeric characters

**Default Value:** <None>

**Password - CFG in terminal**
Indicates whether users should configure the response to the password prompt at the mobile device.

**Possible Values:** <Enabled> <Disabled>

**Default Value:** <Disabled>

**Password - Responses**
Indicates the password that the mobile device should send to the host system at the password prompt.

**Possible Values:** 0 - 30 alpha-numeric characters

**Default Value:** <None>
Command - Prompts

Indicates the command prompt that the host system sends to the Telnet Client after the login is complete.

Possible Values: 0 - 60 alpha-numeric characters

Default Value: <None>

Command - CFG in terminal

Indicates whether users should configure the response to the command line prompt at the mobile device.

Possible Values: <Enabled> <Disabled>

Default Value: <Disabled>

Command - Responses

Indicates the command that the mobile device should send the host system at the command prompt.

Possible Values: 0 - 30 alpha-numeric characters

Default Value: <None>

Configuration Settings

Use the Configuration tab in the Host Profiles dialog box to access and configure per-host emulation parameters (Figure 3-13).

NOTE For more information about global and per-host emulation parameters, see Chapter 4: Emulation Parameters on page 55.
The following list describes the options in the Configuration tab.

**Modify**  
Click this button to access Configuration Manager and modify the emulation parameters for the host connection.

**Reset**  
Click this button to reset the emulation parameters for the host connection back to the default settings.

**Figure 3-13. Configuring Per-Host Emulation Settings**
**Chapter 4: Emulation Parameters**

This section provides the following information:

- An overview of global and per-host emulation parameters
- Using the Microsoft ActiveSync installation utility or the Avalanche TelnetCE Client software package to access global and per-host emulation parameters.
- Using Configuration Manager

**About Emulation Parameters**

The TelnetCE Client allows you to configure emulation parameters for host connections.

You make changes to emulation parameters with the Configuration Manager utility, which provides an organized list of the emulation parameters that you can modify.

Emulation parameters are divided into two groups:

- Per-host
- Global

**About Per-Host Emulation Parameters**

Per-host emulation parameters apply only to a specific host connection, as dictated by the host profile the TelnetCE Client is using to connect to the host system. You can access the emulation parameters for a specific host profile through the Host Profiles dialog box.

When you choose to modify per-host emulation parameters, you access and use Configuration Manager to modify the Hostcfg.bin configuration file. Configuration Manager displays the name of the file that it is modifying in the title bar.

**NOTE** Per-host parameters are a subset of parameters. Not all TelnetCE Client emulation parameters are available for modification on a per-host basis.
About Global Emulation Parameters

Global emulation parameters apply to all of the host profiles with which you have configured a client. Per-host emulation parameter configurations preempt global emulation parameter configurations.

When you choose to modify global emulation parameters, you access and use Configuration Manager to modify the Termcfg.bin configuration file. Configuration Manager displays the name of the file that it is modifying in the title bar.

Configuring Emulation Parameters

This section provides information about accessing Configuration Manager to modify global and per-host emulation parameters.

Overview of Configuring Emulation Parameters

The following tasks outline the process of configuring emulation parameters:

1. Use the product configuration utility or the TelnetCE Client Avalanche software package to access the Configuration Manager.

2. Use the Configuration Manager to modify emulation parameters and save the new emulation parameters configuration file.

3. Download the new configuration file to the mobile device.

When you download the configuration file to the mobile device, any existing configuration file is overwritten.

Accessing Global Emulation Parameters

This section provides the following information:

- Using the Microsoft ActiveSync installation utility to access the Configuration Manager for global and parameters

- Using the Avalanche software package to access the Configuration Manager for global emulation parameters
Using Microsoft ActiveSync

If you used the product installation and configuration utility to install the TelnetCE Client to the mobile device via a Microsoft ActiveSync connection, use the same product installation and configuration utility to access the Configuration Manager and modify global emulation parameters.

To access global emulation parameters from the Microsoft ActiveSync utility:

1. On the host system, launch the Microsoft ActiveSync installation utility. The Wavelink Product Configuration dialog box appears (Figure 4-1).

   ![Wavelink Product Configuration Dialog Box](image)

   **Figure 4-1. Wavelink Product Configuration Dialog Box**

2. Click the Emulation Parameters icon button. The Configuration Manager appears (Figure 4-2).
Use the Configuration Manager to configure the global emulation parameters for the TelnetCE Client.

NOTE For information about using Configuration Manager, see Using Configuration Manager on page 68.

After you have configured the emulation parameters, use one of the following methods to save the configuration to the host system:

- Click the save icon button in the Configuration Manager tool bar.
- Select File > Save.

Close the Configuration Manager.

Download the new emulation parameters to the mobile device.
Chapter 4: Emulation Parameters

NOTE For more information about downloading configuration to mobile devices, see Deploying Configurations on page 16.

Using Avalanche Manager

If you used Avalanche Manager to install the TelnetCE Client on the mobile device, use Avalanche Manager to access the Configuration Manager and modify global emulation parameters.

To access global emulation parameters from Avalanche Manager:

1. On the host system, launch Avalanche Manager and connect to the Agent.

2. In the Avalanche Agents tree, locate and right-click the TelnetCE Client software package.

   A menu list appears.

3. From the menu list, select Configure Package > Emulation Parameters (Figure 4-3).

   ![Configure Package Menu](image)

   **Figure 4-3. Configuring Emulation Parameters from Avalanche**

   The Configuration Manager appears (4-4).
4 Use the Configuration Manager to configure the global emulation parameters for the TelnetCE Client.

**NOTE** For information about using the Configuration Manager, see *Using Configuration Manager* on page 68.

5 After you have configured the emulation parameters, use one of the following methods to save the configuration to the host system:

- Click the save icon button in the Configuration Manager tool bar.
- Select **File > Save**.

6 Close the Configuration Manager.

7 Download the new emulation parameters to the mobile device.
NOTE For more information about downloading configuration to mobile devices, see Deploying Configurations on page 16.

Accessing Per-Host Emulation Parameters

This section provides the following information:

• Using the Microsoft ActiveSync installation utility to access the Configuration Manager for per-host settings

• Using the Avalanche TelnetCE Client software package to access the Configuration Manager for per-host settings

Per-host emulation parameters are specific to a host connection and are accessed through the corresponding host profile in the Host Profiles dialog box.

Using Microsoft ActiveSync

If you used the product configuration utility to install the TelnetCE Client on the mobile device via a Microsoft ActiveSync connection, use the same product configuration utility to access and configure per-host emulation parameters.

To access per-host emulation parameters from the Microsoft ActiveSync utility:

1 On the host system, launch the Microsoft ActiveSync installation utility.

   The Wavelink Product Configuration dialog box appears (Figure 4-5).
2 Click the Host Profiles icon button.
   
   The Host Profiles dialog box appears.

3 From the list of host profiles, select the host profile that you want to configure.

4 Select the Configuration tab (Figure 4-6).
Click **Modify**.

The Configuration Manager appears (Figure 4-7).
6 Use the Configuration Manager to configure emulation parameters for the host profile that you have selected.

NOTE For information about using Configuration Manager, see Using Configuration Manager on page 68.

7 After you have configured the emulation parameters, use one of the following methods to save the configuration to the host system:

- Click the save icon button in the Configuration Manager tool bar.
- Select File > Save.

8 Close the Configuration Manager.

9 Close the Host Profiles dialog box.

10 Download the new emulation parameters to the mobile device.
NOTE For more information about downloading configuration to mobile devices, see Deplo"y"ng Configurations on page 16.

Using Avalanche Manager

If you used Avalanche Manager to deploy the TelnetCE Client to the mobile device, use the TelnetCE Client software package in Avalanche Manager to access and configure per-host emulation parameters.

To access per-host emulation parameters from Avalanche Manager:

1. On the host system, launch Avalanche Manager and connect to the Agent.

2. In the Avalanche Agents tree, locate and right-click the TelnetCE Client software package.

   A menu list appears.

3. From the menu list, select Configure Package > Host Profiles (Figure 4-8).

   ![Figure 4-8. Configuring Per-Host Emulation Parameters from Avalanche](image)

   The Host Profiles dialog box appears.

4. From the list of host profiles, select the host profile that you want to configure.

5. Select the Configuration tab (Figure 4-9).
6 Click Modify.

The Configuration Manager appears (Figure 4-10).
Figure 4-10. Configuration Manager for Per-Host Emulation Parameters

7 Use the Configuration Manager to configure emulation parameters for the host profile that you have selected.

NOTE For information about using Configuration Manager, see Using Configuration Manager on page 68.

8 After you have configured the emulation parameters, use one of the following methods to save the configuration to the host system:

   • Click the save icon button in the Configuration Manager tool bar.

   • Select File > Save.

9 Close the Configuration Manager.

10 Close the Host Profiles dialog box.
11 Download the new emulation parameters to the mobile device.

**NOTE** For more information about downloading configuration to mobile devices, see *Deploying Configurations* on page 16.

### Using Configuration Manager

This section provides the following information:

- An overview of Configuration Manager
- Using the Configuration Manager to modify emulation parameters
- Using the Configuration Manager find function

The Configuration Manager (Figure 4-11) is the utility that allows you to modify global and per-host emulation parameters.
Chapter 4: Emulation Parameters

Figure 4-11. Configuration Manager

The left pane of the Configuration Manager displays the emulation parameters that you can modify. The emulation parameters are grouped by category.

The following list describes the different categories:

**COM**
Parameters in this category configure the function of the COM port on mobile devices.

**Emulation**
Parameters in this category configure terminal emulation functions on mobile devices.

**Scanner**
Parameters in this category configure the function of bar code scanners on mobile devices.

When you select a parameter in the left pane, information about the parameter displays in the right pane (Figure 4-12).
Modifying Emulation Parameters

Determine the emulation parameters that you want to modify and use the Configuration Manager to make modifications.

To modify an emulation parameter:

1. Access the Configuration Manager.

2. In the left pane of the Configuration Manager, locate the parameter that you want to modify.

3. Double-click the emulation parameter or right-click the emulation parameter and choose Edit from the menu list.

A dialog box appears that allows you to modify the parameter configuration (Figure 4-13).
4 Use the dialog box to configure the parameter.

5 After you have configured the parameter, click OK to keep the setting.

**NOTE** Click Cancel or the Close button to cancel any changes you have made.

6 Use one of the following methods to save the new configuration:

- Click the save icon button.
- Select File > Save.

7 Close the Configuration Manager.

8 Download the new configuration to the mobile device.

**NOTE** For more information about deploying new TelnetCE Client configurations to mobile devices, see Deploying Configurations on page 16.

**Using the Find Function**

Use the Find function of the Configuration Manager to locate parameters or information by supplying a partial or full string that the Configuration Manager can use to locate the parameter or information that you want to find.

**To use the find function:**

1 From the Configuration Manager Edit menu, select Find.

   The Find dialog box appears.

2 Input a partial or full string for the parameter or information that you want to find (Figure 4-14).
Enable the **Search all text** checkbox to search not only the parameters, but also the help files.

Click **Find Next** to begin the search.

Continue to click **Find Next** until you locate the parameter or information for which you are searching.

### Switching to Alphabetized View

By default, emulation parameters are displayed in a hierarchical tree view. You may switch to an alphabetized view, if you desire. When the alphabetized view is enabled, the Configuration Manager displays the emulation parameters in alphabetical order.

**To switch to the alphabetized view in Configuration Manager:**

1. In the Configuration Manager, access the **View** menu.

2. In the **View** menu, disable the **Tree Mode** option.

The Configuration Manager now displays the emulation parameters in an alphabetized list (Figure 4-15).
Figure 4-15. Alphabetized View in the Configuration Manager
Chapter 5: Scripting

This section provides the following information

- Overview of Scripting
- Launching the Script Editor
- Creating Scripts Using the Script Editor
- Performing Script Capturing
- Editing Scripts
- Importing Scripts
- Saving and Exporting Scripts
- Deploying Scripts
- Executing Scripts

Overview of Scripting

Wavelink TelnetCE Client includes a Script Editor that gives you the ability to create and execute scripts that automate processes on the TelnetCE Client.

NOTE The Script Editor is included in TelnetCE Client 5.1 and later versions.

The following steps outline the process of creating scripts using the Script Editor:

1. **Launch the Script Editor.** You can launch the script editor Avalanche Manager.

2. **Create a script using the Script Editor.** You can use the Script Editor to manually create the script code.

-or-


Create a script using the Script Capture option. You can turn on Screen Capture and perform the actions you want included in your script.

3 Configure an execution method for your script. You need to select from the available options the way you want to execute your script.

4 Execute your script from the Telnet Client. Using the activation method you selected for the script, you can activate and execute your script.

TelnetCE Client allows one active script per emulation session. While one script is running, other scripts are not allowed to run. Scripts should be designed to do their action and then immediately exit. This allows the next script to run.

Scripts can only be run while a session is connected to a host. When a connection is dropped, the script is terminated. If you switch between sessions, the script running in the first session will be suspended until that session is returned to being active.

**NOTE** For detailed information about the using the Script Editor in Telnet CE Client, refer to the *TelnetCE Client Scripting Reference Guide*.

---

**Launching the Script Editor**

If you are using Avalanche Manager to deploy the TelnetCE Client, you can launch the Script Editor from the Avalanche Manager. Then scripts created by or imported into the Avalanche Script Editor will automatically be deployed to the remote devices.

**To launch the Script Editor from Avalanche Manager:**

1 Ensure the TelnetCE Client package is installed in Avalanche Manager.

2 From the Tree View in the Avalanche console, right-click the TelnetCE Client software package.

3 Select Configure Package > Script Editor (Figure 5-1).
Figure 5-1. Launching the Script Editor from Avalanche Manager

The Script Editor opens (Figure 5-2).

Figure 5-2. Script Editor

4 Click Add to open the Script Editor configuration dialog box (Figure 5-3).
Creating Scripts Using the Script Editor

This section provides information on how to create scripts manually using the Script Editor and includes the following information:

- Configuring the script name
- Configuring the activation method
- Creating the script code
- Creating variables
- Selecting host profiles

Use the following steps to create a script manually:

1. Enter a script name and select an activation method.
2. Use the Actions tab to select actions and build the script code.
3. Use the Boolean Variables, Number Variables, or String Variables tabs to create Variables as needed to complete the script (not required).
4 Use the Host Profile tab to select host profiles that will be associated with this script.

**Configuring the Script Name**

The script name is the name you will select from when activating the scripts (Figure 5-4).

![Figure 5-4. Entering the Script Name](Image)

**Selecting the Activation Method**

You need to select how you want to activate your script, once it is created. A script with no activation method selected can still be called by another script, but it cannot be activated by itself.

This section provides information about assigning a method of activation to a script. The following is a list of the activation methods:

- Select from menu
- On key combination
- When session connects
- On barcode, MSR or RFID scan
• On screen update

Select from Menu

Scripts with the Select from Menu option selected can be run using the menu option in the Telnet Client.

To configure the Select from Menu method:

1. Select the General tab or the Activate tab in the Script Editor.

2. Enable the Select from Menu option (Figure 5-5).

![Script Editor](image)

Figure 5-5. Select from Menu

3. Click OK.

On Key Combination

This option lets you launch a script whenever a specific key combination is pressed.

NOTE Use the Diagnostics utility to obtain the key value. Refer to Using the TelnetCE Client Diagnostics Utility on page 141 for more information.
To configure the On Key Combination method:

1. Select the General tab or Activate tab in the Script Editor.

2. Enable the **On Key Command** option (Figure 5-6).

![Figure 5-6. On Key Combination](image)

3. Use the drop-down menu and text box to assign a key combination to the script.

**When Session Connects**

This option causes the script to activate when the host profile it supports is activated.

If you use this option, it is strongly recommended that you limit the script to the appropriate host profiles. Since the script will be activated before any information appears on the emulation screen, you will need to have your script wait for the appropriate screen to appear before it does anything. You should not have more than one script set to start when a session begins because the first script started will prevent any other scripts from running while it waits for the initial screen.

Refer to *Selecting Host Profiles* on page 86 for more information.
To configure the When Session Connects method:

1. Select the General tab or Activate tab in the Script Editor.

2. Enable the **When Session Connects** option (Figure 5-7).

![Figure 5-7. When Session Connects](image)

3. Click **OK**.

**On Barcode, MSR or RFID Scan**

This option allows the script to run with each barcode, MSR or RFID scan.

For detailed information on configuring scripts for barcode, MSR or RFID scan refer to the *TelnetCE Client Scripting Reference Guide*.

To configure the On Barcode, MSR, or RFID Scan method:

1. Create the **Scan_String** and **Scan_Type** variables.

   Once you create these variables, the **On Barcode, MSR or RFID Scan** options becomes available.

   You will need to create these variables in the String Variables and Number Variables tabs. Refer to *Creating Variables* on page 84 for information on creating variables.
1  Select the General tab or Activate tab in the Script Editor.

2  Enable the **On Barcode, MSR, or RFID Scan** option.

3  From the drop-down menu, select the **Scan_String**.

4  From the drop-down menu select the **Scan_Type**.

5  Click **OK**.

**On Screen Update**

This option will cause the script to be activated (if activation is allowed) every time the text on the emulation screen changes. This includes updates from the Telnet host or when the user presses a key and the key value is shown on the screen. It is recommended that you limit the host profiles that the script supports.

For detailed information on configuring scripts for on screen update execution refer to the *Telnet CE Client Scripting Reference Guide*.

---

**NOTE**  This option should be used carefully, since it can cause a script to be executed very frequently.

---

**To configure the On Screen Update method:**

1  Select the General tab or Activate tab in the Script Editor.

2  Enable the **On Screen Update** option (Figure 5-8).
Creating the Script Code

Once you have named your script and selected an activation method, you can use the Actions tab in the Script Editor to build the script.

For detailed information and examples about building the script code refer to the Telnet CE Client Scripting Reference Guide.

Creating Variables

There are three types of values recognized by scripting: booleans (TRUE or FALSE values only), numbers (integers), and strings. Every argument for every action is one of these three value types. Every action that returns a value returns one of these types. Variables provide a way to save the result of an action for use later as an argument for another command.

Variables can be created and edited under the appropriate Variable tab while editing the script. It is also possible to create new variables while editing an action.

When a script first starts, all the variables will have known values: boolean variables will be FALSE, number variables will be 0, and string variables will
be empty. One possible exception to this is when a script activates another script.

**To create a variable:**

1. Determine which type of variable you want to create: boolean, number or string.
2. From the Script Editor, select the tab that corresponds with the type of variable you want to create.
3. Click **Add**.
4. In the *Edit Variable* dialog box, enter the name of the new variable (Figure 5-9).

![Edit Variable](image)

*Figure 5-9. Adding a New Variable*

5. Click **OK**.

    The new variable appears in the corresponding tab (Figure 5-10).
For each script, you can specify which host profiles will be supported by that script. You may select host profiles from the Host Profiles tab.

If the script is generated by script capturing, it is a good idea to limit the script to a host profile that was in use when the script was captured. The default - no host profile - allows the script to be run when any host profile is used.

To select host profiles:

1. From the Script Editor, select the Host Profiles tab (Figure 5-11).
2  Click **Add**.

The *Select Host* dialog box opens (Figure 5-12).

3  Select which host you want to use from the list of hosts.
NOTE If you have not created any host profiles, this dialog box will be empty.

4 Click OK.

The host appears in the Host tab (Figure 5-13).

Performing Script Capturing

Script capturing is an easy way to generate a script that will automate doing something you can do manually. While script capturing is turned on, it will capture the key presses and mouse/pen cursor movements so they can be replayed with the script is activated.

To perform a script capture:

1 Position your mouse or cursor at the emulation screen you want to be at when the automated process starts.

2 From the Term or Options menu, select Scripting > Start Capture (Figure 5-14).
At the prompt, select \texttt{Yes} to verify the current screen text (Figure 5-15).

Select \texttt{No} if you do not want to verify the current screen text.
Selecting Yes makes the captured script start with an If_not command that tells the script to exit if the correct screen is not currently shown. Unless you know that your script will only run from the correct screen (for example, a script that is run only when a session first starts, or a script called by another script), you should select Yes.

**NOTE** If you select No, click Verify Screen Contents and Save Cursor Position buttons when you start your script capture. This will cause your script to wait for Telnet to finish updating the screen before processing script actions.

4. Perform any actions you want to include in the script.

5. Each time the screen changes, click Verify Screen Contents button (Figure 5-16).
NOTE Some devices may only display buttons labeled Screen, Cursor and Stop. The Screen button refers to the Verify Screen Contents button. The Cursor button refers to the Save Cursor Position button. The Stop button refers to the Stop Capturing button.

Figure 5-16. Verify Screen Contents and Save Cursor Position Buttons

NOTE Clicking the Verify Screen Contents button will cause the generated script to pause and wait for the screen to be updated. The pauses are necessary because the scripts can run much faster than the interaction with the Telnet host.

6 When you are finished capturing the behaviors you want in the script, click Stop Capture.

Once you have captured a script, Script Editor opens. This allows you to name the script and select an activation method. You would also use the Actions tab to add actions for any error condition that the user may encounter.
Editing Scripts

You can edit scripts that are created manually and scripts that are generated from the script capture option.

To edit scripts:
1. Launch the Script Editor.
2. Select the script you want to edit from the Script Editor script list.
3. Click Edit.
4. Make the desired changes in the Script Editor configuration dialog box.
5. Click OK to save your changes.

Once you have completed editing the script you have two options:

- Export the script to a specified location using the Export button in the Script Editor. Refer to Saving and Exporting Scripts on page 94 for more information.
- Execute the script by launching the Telnet CE Client and performing the activation method you assigned to this script. Refer to Executing Scripts on page 96 for more information.

Importing Scripts

You can use the import button in the Script Editor to import previously created scripts.

NOTE You can only import scripts that have been created using the Script Editor.

To import a script:
1. From the Script Editor, click the Import button.

   The Select the Script File dialog box opens (Figure 5-17).
Chapter 5: Scripting

2 Navigate to and select the script file.

3 Click Open.

The name of the file is imported into the Script Editor (Figure 5-18).
Once you have imported the file, you can edit the script. Refer to *Editing Scripts* on page 92 for more information.

**Saving and Exporting Scripts**

After you finish building a script, your script is automatically saved in the Script Editor. You can also export a script and save it in a specific location on the network.

**NOTE** Scripts are saved as .wls files. Scripts can not be viewed outside the Script Editor and must be imported back in to the Script Editor to view or edit.

**To export a script:**

1. From the Script Editor script list, select which script you want to export (Figure 5-19).
Chapter 5: Scripting

Figure 5-19. Selecting a Script to Export

2. Click the Export button. The Create the Script File dialog box opens (Figure 5-20).

Figure 5-20. Exporting a Script

3. Navigate to the location to which you want to export your script.
4 Click Save.

To view an exported script you will need to import that script into the Script Editor. Refer to Importing Scripts on page 92 for more information.

**Deploying Scripts**

Scripts are deployed to the TelnetCE Client the next time the client syncs with the Avalanche Manager.

**Executing Scripts**

When you create a script, you configure an activation method for that script. This section provides information about activating scripts using each of the following activation methods:

- Select from Menu
- On Key Combination
- When Session Connects
- On Barcode, MSR, or RFID Scan
- On Screen Update

For information on assigning an activation method to a script, refer to Selecting the Activation Method on page 79.

**NOTE** Screen captures may differ according to device type.

**Select from Menu**

This option allows you to activate a script from the menu.

**To activate a script using the Select from Menu option:**

1. Launch the TelnetCE Client.

2. From the Term menu, select Scripting > Execute Script (Figure 5-21).
3 If more than one script is available for the current host profile, select which script you want to use from the list.

**NOTE** This option will not be available while a script is running for the current session or if the session is not connected.

### On Key Combination

This option lets you launch a script whenever a specified key combination is pressed (as long as it is currently possible for script to run).

**To execute a script on key combination:**

1. Launch the TelnetCE Client.
2. Enter the key combination you assigned to execute the script.

### When Session Connects

This option causes the script to activate when the host profile it supports is activated.
**To execute when the session connects:**

1. Launch the TelnetCE Client.

2. From the **Term or Options** menu, select **Connect**.

3. Select to which host you want to connect.

4. Click **OK**.

The script will run upon connection.

**On Barcode, MSR, or RFID Scan**

When this option is assigned to a script, the script will activate with each barcode, MSR, or RFID scan.

**On Screen Update**

This option causes the script to be activated (if activation is allowed) every time the text on the emulation screen changes. This includes updates from the Telnet host or when the user presses a key and the key value is shown on the screen.
Chapter 6: Keyboard Creator

This section provides the following information:

• Overview of Keyboard Creator
• Launching the Keyboard Creator
• Selecting Keyboard Files
• Creating Keyboards
• Importing Keyboard Graphics
• Creating and Configuring Keys
• Sizing and Positioning Keys and Rows
• Deploying the Keyboard to the Telnet CE Client

Overview of Keyboard Creator

The Keyboard Creator allows you to create or modify the TelnetCE Client virtual keyboard.

Use the following steps to create a keyboard using Keyboard Creator:

1. Launch the Keyboard Creator.
2. Select the appropriate keyboard file.
3. Create a new keyboard.
4. Import a keyboard graphic, if desired.
5. Create and configure the keys of the keyboard.
6. Deploy the keyboard to the TelnetCE Client.

Launching the Keyboard Creator

The Keyboard Creator is installed as part of the TelnetCE Client Avalanche software package.
NOTE The Keyboard Creator is only available in the Avalanche TelnetCE Client. You will not be able to access the Keyboard Builder from the ActiveSync install utility or any other third-party TelnetCE Client installation and configuration utilities.

To launch from Avalanche:

1. Select the TelnetCE Client software package in the Tree View of the Avalanche Manager.

2. Right-click the package and select Keyboard Creator.

   The Keyboard Creator opens (Figure 6-1).

![Figure 6-1. Launching the Keyboard Creator]
Selecting Keyboard Files

Keyboard files contain all the keyboards needed for a given emulation (5250, 3270, VT100, VT220, or HP). Use Table 6-1 to determine the name of the keyboard file that should be edited for a particular emulation.

<table>
<thead>
<tr>
<th>Emulation</th>
<th>File Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>5250</td>
<td>EM5250.KB</td>
</tr>
<tr>
<td>3270</td>
<td>EM3270.KB</td>
</tr>
<tr>
<td>VT100, VT220</td>
<td>EMVT.KB</td>
</tr>
<tr>
<td>HP</td>
<td>EMHP.KB</td>
</tr>
</tbody>
</table>

Table 6-1: Emulation Types and File Names

There are two additional keyboards:

- EMNONE.KB are the keyboards displayed when a session is not connected to a host.
- EMNUM.KB are the keyboards displayed for the Numeric keyboard option.

When the keyboard file is saved, a matching file with the .KBB extension will also be saved. This file is a binary representation of the keyboard file and will be used by the terminal to display the keyboards. (TelnetCE Client ignores the .KB files if they are present.)

To select a keyboard file:

1. Determine the name of the Keyboard file you are creating.
2. Select the file type from the drop-down list (Figure 6-2).
Creating Keyboards

There are two default keyboards: the default alpha keyboard and the default numeric keyboard. The default alpha keyboard is displayed by default. The default numeric keyboard is displayed when in a numeric field (5250 and 3270 only).

This section provides the following keyboard information:

- Adding a new keyboard
- Sizing keyboards
- Deleting keyboards

**Adding a new keyboard**

Multiple keyboards can be included in each keyboard file. The keyboards are linked together by shift keys (special keys which display another keyboard).
To add a keyboard:

1. Launch the Keyboard Creator.

2. Select Keyboard > New Keyboard from the menu.

3. Enter a new name for the keyboard (Figure 6-3).

![Figure 6-3. Creating a New Keyboard](image1)

**NOTE** Keyboard names must start with a letter, may only contain numbers or letters, and can only be 11 characters long.

![Figure 6-4. Creating a New Keyboard](image2)
4 Use the Key configuration options to configure each key of the keyboard. Refer to *Creating and Configuring Keys* on page 105 for more information.

**Sizing Keyboards**

You can use the mouse to resize a keyboard. As you increase the size of the keyboard, the size of the application area will decrease.

**To resize the keyboard:**

1. Mouse over the top border, right-side border, or the upper-right corner of the keyboard.

2. When the double-sided arrows appear, click and drag the keyboard to the desired size.

**Deleting Keyboards**

When deleting a keyboard that has keys which connect to it, an option will be presented for dealing with any connections to the keyboard. Keys that are references to the keyboard being deleted can be deleted, set to an empty value or redirected to another keyboard.

**To delete a keyboard:**

1. Select **Keyboard > Delete Keyboard** from the menu.

2. Select what action to take for referenced keys (Figure 6-5).

![Deleting Keyboard](image-url)
Importing Keyboard Graphics

The default keyboard draws the keys on the computer screen. However, you can import a graphic to be displayed instead of the created keys. An imported graphic will be embedded in the .KB and .KBB files, so you will not need to save the imported graphic file.

Key locations and values will still be used to determine which key the you clicked when you click on the keyboard graphic. You will need to create and position keys in the same position as the buttons on the imported graphic. Use the slider bar change how dark the graphic and buttons are while editing so that you can size and position the buttons correctly.

NOTE Be sure to label the buttons you create. If the mobile device is unable to use the bitmap image, the labeled buttons will still appear.

To import a graphic:
1 In the Keyboard Creator, click Import.
2 Navigate to the location of the bitmap image you want to import.
3 Click Open.
4 Click the Size Keyboard to Graphic button to make the keyboard the same size as the imported graphic.
5 Use the slider bar to adjust the how dark and how light the graphics and buttons appear when editing.

Creating and Configuring Keys

There are three types of keys that can be on a keyboard:

- Normal keys represent letters, numbers, or other characters in the emulation and can also represent special emulation specific function keys.
- Shift keys can point to any other keyboard in the current keyboard file.
- Hide keys hide the keyboard and allows an unobstructed view of the emulation screen.
This section provides the following information:

- Adding new keys
- Sizing and positioning keys and rows
- Deleting keys

**Adding a new key**

You can add new keys to a keyboard and configure the key values and configure the following options:

- **Label.** Enter the text that will appear on the virtual key when it is displayed.

- **Reverse.** Enable this option for a key that indicates the active keyboard type.

- **Key Value.** Select from Key, Normal, Keyboard (shift), or Hide. Key values allow you to select emulation-specific actions to be assigned to the keys. The list of keys available will vary depending on the emulation type selected.

**NOTE** Normal key values can be displayed or entered as a character value (the actual character created by the keystroke is shown), a decimal value (for characters which cannot be shown), or a hexadecimal value (for scan codes of special function keys).

**To add a new key:**

1. Select Keyboard > Add Key.

   The new key will appear in the top left corner of the keyboard, or directly to the right of a selected key (if it will fit) (Figure 6-6).
2 Modify the values for the key using the key configuration options (Figure 6-7).
3 Repeat to create additional keys for the keyboard.

Sizing and Positioning Keys and Rows

You can use the configuration options in the Key region of the Keyboard Creator to modify the size and position of the keys on the keyboard.

The Fine Adjustments drop-down menu allows you to select what object you want to modify:

- **Key Position.** Select this option to move a selected key on the keyboard. You can also adjust the key position by clicking on the key and dragging it to the desired position.

- **Row Position.** Select this option to move an entire row.

- **Keyboard Position.** Select this option to move all the keys on the keyboard.

- **Key Size.** Select this option to adjust the size of the key.

Once you select the object you want to modify, you can use the arrow buttons to position or size the keys and rows. The Adjust Distance slider...
determines the distance that the arrow buttons move or adjust the keys or rows. You can use the slider to change the distance from 1-10 pixels.

To position a key:
1. Click New Key.
2. From the Fine Adjustments drop-down menu, select Key Position.
3. Use one of the following methods to move the key:
   - Use the arrow buttons to position the key in the desired location.
   - Drag and drop the key to the desired location.

To position a row:
1. Click a key in the row you want to position.
2. From the Fine Adjustments drop-down menu, select Row Position.
3. Use the arrow buttons to position the row in the desired location.

To resize a key:
1. Click New Key or select an existing key.
2. From the Fine Adjustments drop-down menu, select Key Size.
3. Use the arrows to adjust the size.

Deleting Keys

You can delete keys that you do not want from the keyboard.

To delete a key:
1. Select the key you want to delete.
2. Select Keyboard > Remove Key.

Deploying the Keyboard to the Telnet CE Client

Once you have completed creating your keyboard and keys, click the Save icon to save your keyboard, and then exit the Keyboard Creator. Your Telnet CE Client will update with the new keyboard the next time the mobile device syncs with Avalanche Manager.
Chapter 7: Licensing

This section provides the following information:

- Overview of licensing
- Types of licenses
- Licensing methods

Overview of Licensing

The TelnetCE Client requires a license for full functionality. You can use the TelnetCE Client without a license, but you will be limited to the demo version, which does not provide full TelnetCE Client functionality.

TelnetCE Client licensing is on a per-client basis, not on a per-connection basis. This means that a single license allows the TelnetCE Client to engage in the maximum number of Telnet sessions that the TelnetCE Client is configured to support (up to four concurrent sessions).

When the TelnetCE Client does not have a valid license, it operates in demo mode. When the TelnetCE Client is operating in demo mode, it will behave as followings:

- **Attempt to contact a license server.** Each time that you attempt to initiate a terminal emulation session, the TelnetCE Client will begin broadcasting in an attempt to locate a license server. At that point, you are prompted to either enter a license or to initiate the session in demo mode.

- **Prematurely disconnect emulation sessions.** While in demo mode, you may initiate terminal emulation sessions with hosts. However, each terminal emulation session that you initiate will automatically time out after one hour (Figure 7-1).
Authorization Methods

There are three ways to license (authorize) the TelnetCE Client:

- **Pre-licensing.** The TelnetCE Client may come pre-installed and pre-licensed on your mobile device. For pre-licensing information, please consult the TelnetCE Client reference guide for your mobile device manufacturer.

- **Manually.** You may manual input licensing information at the mobile device through the TelnetCE Client interface.

- **License Server.** You may use License Server to automatically provide TelnetCE Client licenses to the mobile devices on your network.

**NOTE** To obtain TelnetCE Client licenses, please contact Wavelink customer service. Appendix D: Wavelink Contact Information on page 233 provides Wavelink contact information.
Types of Licenses

There are two types of TelnetCE Client licenses:

- Platform
- Maintenance

**NOTE** Maintenance licenses were added to the 5.0 version of the TelnetCE Client. Only platform license are available for 4.x TelnetCE Clients.

About Platform Licenses

A platform license authorizes you to the version of the TelnetCE Client that you purchased and any builds associated with that version. For example, if you purchased a 5.0 TelnetCE Client license, then you are entitled to use 5.00-xx TelnetCE Client builds. If you want to use the features available in the 5.10-xx TelnetCE Client, then you must either buy a 5.1 platform license for your mobile devices, or you must purchase a maintenance license for your devices.

A platform license provides for minor upgrades and code changes, but does not allow major upgrades and updates to the TelnetCE Client.

Platform licenses do not expire, but they do not allow you to upgrade to a greater version of the TelnetCE Client.

About Maintenance Licenses

A maintenance license allows you to upgrade your TelnetCE Client when new major versions of the TelnetCE Client become available. For example, a maintenance license allows you to upgrade from TelnetCE Client 4.x to TelnetCE Client 5.x.

Maintenance licenses are valid only through a specific date. After the expiration date, if you upgrade the TelnetCE Client, it will revert to operating in demo mode.

Licensing Methods

This section provides the following information:
• Authorizing the TelnetCE Client manually

• Using a License Server to authorize the TelnetCE Client

**Manually Licensing the TelnetCE Client**

You may key in your authorization information manually through the TelnetCE Client interface.

**To manually configure a TelnetCE Client license:**

1. Obtain the TelnetCE Client licensing information from Wavelink Corporation.
2. On the mobile device, launch the TelnetCE Client.
3. Attempt to establish a connection to a host.

---

**NOTE** For information about connecting to a host, see *Using the TelnetCE Client and Connecting to Hosts* on page 121.

---

If the TelnetCE Client has not attained a license, when you attempt to connect to a host, the Authorizing Terminal dialog box appears.

4. In the Authorizing Terminal dialog box, select *Add License*.

   The *Authorization* dialog box appears.

5. From the **Platform** drop-down list, select your license type (Figure 7-2).
6 In the **License Name** text box, type the name of the license.

7 In the **Serial #** text box, type the serial number for the license.

8 In the **Exp. Date** text box, type the expiration date of the license, in the format of MMDDYYYY.

9 In the **Code** text box, type the authorization code for the license.

10 In the **User #** text box, enter a user number.

**NOTE** The user number can be any number between 1 and the number of users (the limit) for which the license provides. Each TelnetCE Client should be configured with a unique user number.

11 In the **Limit** text box, enter the user limit for the license.

12 Click **Authorize**.

**Using License Server to License the TelnetCE Client**

License Server is a Wavelink application that runs on a host system. The license server is responsible for supplying licenses to mobile devices that are using the TelnetCE Client.
**NOTE** The TelnetCE Client license server should not be confused with the Avalanche license server. Both are separate Wavelink applications.

**NOTE** For information about installing and using the Telnet license server, see Appendix C: Using the TelnetCE Client License Server on page 141.

### Using a Local License Server

When you attempt to initiate a Telnet session with a host, if the TelnetCE Client is not already licensed, it will automatically attempt to obtain a license from a license server by using the following steps:

1. The TelnetCE Client broadcasts a request for a license on the local IP network.

   The *Authorizing Terminal* dialog box displays on the mobile device while the TelnetCE Client attempts to locate a license server (Figure 7-3).

![Figure 7-3. Authorizing Terminal Dialog Box](image)
2 Any license servers on the local IP network with an available license respond by offering a license.

3 The TelnetCE Client accepts the first license that it receives and sends back a reply to the license server.

The Authorizing Terminal dialog box on the mobile device indicates that a license has been obtained.

If no license server responds to the request for a license, then the Authorizing Terminal dialog box continues to display until you close the dialog box, elect to use a demo license, or elect to manually add a license.

Using a Remote or Specific License Server

If the license server is on a remote IP network or you want to specify the license server from which the TelnetCE Client should request a license, you must configure the TelnetCE Client with the IP address of the license server.

NOTE For more information about configuring the IP address of the license server, see Configuring License Server IP Address on page 125.

When you attempt to initiate a Telnet session with a host, if the TelnetCE Client is not already licensed, it will automatically attempt to obtain a license from the specified license server using the following steps:

1 The TelnetCE Client sends a request for a license to the specified license server.

The Authorizing Terminal dialog box displays on the mobile device while the TelnetCE Client attempts to locate a license server (Figure 7-4).
2 The license server on the local IP network respond by sending the TelnetCE Client a license.

3 The TelnetCE Client accepts the first license that it receives and sends back a reply to the license server.

**Using the Demo License**

If you cannot obtain a license for the TelnetCE Client, you may use the demonstration license.

The demonstration license automatically disconnects an active Telnet session after one hour.

**To use the TelnetCE Client demo license:**

1 Launch the TelnetCE Client.

2 Use the TelnetCE Client to initiate a Telnet session with a host.

3 The Select Host dialog box appears.
NOTE If you have configured the TelnetCE Client with only one host profile, the Authorizing Terminal dialog box appears.

4 In the Select Host dialog box, select the host with which you want to establish a Telnet session.

The Authorizing Terminal dialog box appears in the Authorizing Terminal dialog box, select Start Demo.

The TelnetCE Client uses the demonstration license and attempts to connect to the host that you selected. Before displaying the host emulation screen, the TelnetCE Client displays a screen that indicates that you are using a demonstration license (Figure 7-5).

![Figure 7-5. TelnetCE Client Running in Demonstration Mode](image-url)
Chapter 8: Using the TelnetCE Client

This section provides the following information:

- Using the TelnetCE Client and connecting to hosts
- Working with multiple concurrent sessions
- Accessing and using the virtual keyboards
- Using Screen Panning and ActiveText
- Using the TelnetCE Client Diagnostic Utility
- Using the TelnetCE Client Options Menu

Using the TelnetCE Client and Connecting to Hosts

This section provides the following information:

- Launching the TelnetCE Client
- Initiating a Telnet session
- Disconnecting a Telnet session
- Exiting the TelnetCE Client

Launching the TelnetCE Client

Depending on the method that you used to install the TelnetCE Client, you will have different options for launching the TelnetCE Client.

If you installed the TelnetCE Client through Microsoft ActiveSync or another third-party application, then you will be able to launch the application from the Windows CE Start menu or from the desktop.

If you installed the TelnetCE Client through Avalanche Manager, then you will also be able to launch the TelnetCE Client from the Avalanche Enabler interface on the mobile device.
Launching the TelnetCE Client From Windows

You can launch the TelnetCE Client from the Programs menu or, in some instances, from the desktop.

To launch the TelnetCE Client:

1. On the mobile device, access the Windows CE Start menu.

2. In the Windows CE Start menu, access the Programs group.

3. In the Programs folder, double-click the TelnetCE Client shortcut icon (Figure 8-1).

Figure 8-1. TelnetCE Client Shortcut Icon

The TelnetCE Client launches on the mobile device and displays the default screen (Figure 8-2)
Launching the TelnetCE Client from Avalanche

If you used Avalanche Manager to install the TelnetCE Client, then a shortcut icon for the TelnetCE Client appears in the Programs screen of the Avalanche Enabler.

To launch the TelnetCE Client from the Avalanche Enabler:

1. On the mobile device, launch the Avalanche Enabler.

2. If the Programs view is not available in the Avalanche Enabler, access the View menu and enable the Programs view.

   The TelnetCE Client shortcut icon appears in the Programs view of the Avalanche Enabler (Figure 8-3).
In the Programs view of the Avalanche Enabler, double-click the TelnetCE Client icon.

The TelnetCE Client launches on the mobile device and displays the default screen (Figure 8-4).
Initiating a Telnet Session

Use the TelnetCE Client to initiate a Telnet session with any host for which you have configured a host profile.

NOTE For more information about host profiles and configuring host profiles for the TelnetCE Client, see Chapter 3: Host Profiles on page 25.

To initiate a Telnet session with a host:

1 On the mobile device, launch the TelnetCE Client.
   The TelnetCE Client launches and displays the default screen.

2 Press the Enter key.
   The Select Host dialog box appears (Figure 8-5).
NOTE If you have configured only one host profile for the TelnetCE Client, the Select Host dialog box does not appear. Instead, the TelnetCE Client automatically attempts to connect to the host for which you have configured the single host profile.

3 In the Select Host dialog box, select the host to which you want to connect.

4 Click OK.

The TelnetCE Client attempts to establish a Telnet session with the host.

NOTE If the client does not have a license, then the Authorizing Terminal dialog box appears. For more information about TelnetCE Client licensing, see Chapter 7: Licensing on page 111.
**Disconnecting a Telnet Session**

Use the TelnetCE Client **Options** menu to disconnect from an active Telnet session.

To disconnect from a Telnet session:

1. Access the TelnetCE **Options** menu.

2. In the **Options** menu, select Disconnect Session [n]-[name] (Figure 8-6), where:

   - `<n>` is the session number that you want to disconnect, as displayed in the **Options** menu.
   - `<name>` is the name of the host from which you want to disconnect, as displayed in the **Options** menu.

![Figure 8-6. Disconnecting a Telnet Session](image)

When you make the selection, the session that you selected is terminated.
Exiting the TelnetCE Client

You can use the TelnetCE Client Options menu to exit the TelnetCE Client. Depending on the configuration of the TelnetCE Client, you may be required to supply an exit password before you can exit the TelnetCE Client.

**NOTE** By default, the TelnetCE Client is not configured with an exit password. For more information about configuring an exit password for the TelnetCE Client, see Configuring Passwords on page 121.

To exit and close the TelnetCE Client:

1. Access the TelnetCE Client Options menu.

2. In the TelnetCE Client Options menu, select Exit (Figure 8-7).

![Figure 8-7. Exiting the TelnetCE Client](image)

If you have configured the TelnetCE Client with an exit password, the Input Password dialog box appears.
If you have not configured an exit password, the TelnetCE Client closes.

3 In the Input Password dialog box, type the exit password.

4 Select OK.

The TelnetCE Client closes.

Working with Multiple Concurrent Telnet Sessions

This section provides the following information:

• An overview of the TelnetCE Client and multiple concurrent sessions
• Initiating an additional Telnet session
• Switching between active Telnet sessions
• Disconnecting an active Telnet session

Overview of Multiple Concurrent Sessions

The TelnetCE Client supports up to four concurrent Telnet sessions. These may include simultaneous sessions to the same host or to different hosts.

By default, the TelnetCE Client is configured to allow a user to engage in only one Telnet session. To provide for more than one active Telnet session, you must configure the TelnetCE Client to allow multiple concurrent sessions.

NOTE For information about configuring the TelnetCE Client to support multiple concurrent sessions, see Configuring the Number of Concurrent Sessions on page 123.

When the TelnetCE Client is configured to support multiple sessions, then multiple connection options appear in the TelnetCE Client Options menu.

Initiating an Additional Telnet Session

If you have configured the TelnetCE Client to allow multiple Telnet sessions and the TelnetCE Client is engaged in one or more Telnet sessions, you may initiate a new Telnet session from the Options menu.
To initiate an additional Telnet session:

1. Ensure that the TelnetCE Client is configured to allow multiple concurrent sessions.

2. Access the TelnetCE Client **Options** menu.

   The **Options** menu displays the available sessions (between 1 and 4) and indicates which sessions are connected to a host and which are unconnected.

3. From the **Options** menu, select an unconnected session that you want to use to connect to the host (Figure 8-8).

![Options Menu](image)

**Figure 8-8. Available Unconnected Telnet Session**

The TelnetCE Client now displays the default screen. (The default screen prompts you to press **ENTER** to connect to a host.)

4. Press the **Enter** key.

   The **Select Host** dialog box appears.
Chapter 8: Using the TelnetCE Client

5 Use the Select Host dialog box to select the host with which you want to establish a Telnet session.

6 Select OK.

The TelnetCE Client attempts to connect to the host that you have selected.

**Switching Between Active Telnet Sessions**

If the TelnetCE Client is engaged in more than one Telnet session, use the Options menu to switch between the sessions.

**To switch between Telnet sessions:**

1 In the TelnetCE Client, access the Options menu.

2 In the Options menu, select the active session that you want to view (Figure 8-9).

![Options Menu](image)

**Figure 8-9. Switching to a Different Telnet Session**

The TelnetCE Client switches the view to the Telnet session that you selected.
**NOTE** You can also use the Next Sess or Prev Sess keys in the virtual emulation keyboard to switch between sessions. For information about accessing the virtual emulation keyboard, see *Using the Standard Virtual Emulation Keyboard* on page 133.

**Disconnecting a Session**

Use the Options menu to disconnect a session. You must switch to the session that you want to disconnect, before you can disconnect it.

**To disconnect a Telnet session:**

1. In the TelnetCE Client, access the Options menu.

2. From the list of sessions in the Options menu, select the session that you want to disconnect.

   The TelnetCE Client switches the view to the session that you selected.

3. Access the Options menu again.

4. In the Options menu, select Disconnect Session [n], where [n] is the session number that is currently active (Figure 8-10).
Using the Standard Virtual Emulation Keyboard

The TelnetCE Client contains a default virtual emulation keyboard. You can access the keyboard through the TelnetCE Client Options... menu.

To access the virtual emulation keyboard:
1. Access the TelnetCE Client Options... menu.
2. Select View > Emulation Keyboard (Figure 8-11).
The virtual emulation keyboard appears.

The type of emulation keyboard that displays is dependent on the emulation type of the current Telnet session. The VT/HP virtual emulation keyboard is different than the 5270/3270 virtual emulation keyboard. If there is not active session, then the basic virtual emulation keyboard appears.

**Using the Basic Virtual Emulation Keyboard**

Figure 8-12 shows the basic TelnetCE Client virtual emulation keyboard.
The following list describes the function of the keys in the basic virtual emulation keyboard:

**TermConfig**
- Allows you to access and configure the emulation parameters for a specific host profile.

**Prog Info**
- Shows/hides the following information about the mobile device:
  - TelnetCE Client version information
  - MAC address
  - IP address
  - ESSID

**Next Session**
- Cycles to the next TelnetCE Client session.

**Host Config**
- Allows you to access and configure the host profiles for the TelnetCE Client.

**Prev Session**
- Cycles to the previous TelnetCE Client session.

**Keyclks**
- Turns keyclicks on/off.

**Quiet**
- Turns quiet mode on/off.

**Diags**
- Allows you to access the TelnetCE Client diagnostic tools.

**Enter**
- Connects the session.

**Close**
- Disconnects the session. (Only available when the session is connected.)

### Using the 5250/3270 Virtual Emulation Keyboard

Figure 8-13 shows the TelnetCE Client virtual emulation keyboard for 5250/3270 emulation.
The following list describes the function of the control keys that appear at the bottom of the virtual emulation keyboard:

**Alpha**
Displays the alpha keys for 5250/3270 emulation, including:

- a - z
- Tab, Caps Lock, Shft, Res, Backspace, FieldExit, Enter, Space, Alt

**Num**
Displays the numeric keys for 5250/3270 emulation, including:

- 0 - 10
- Mathematical symbols
- Reset, Backspace, FieldExit, Enter, Arrow Keys
- Tab, Shft, Space

**Func1**
Displays the function keys for 5250/3270 emulation, including:

- F1 - F24
- Roll Up, Roll Down, Enter
Using the VT/HP Virtual Emulation Keyboard

Figure 8-14 shows the TelnetCE Client virtual emulation keyboard for VT/HP emulation.

<table>
<thead>
<tr>
<th>Shft</th>
<th>Esc</th>
<th>q</th>
<th>w</th>
<th>e</th>
<th>r</th>
<th>t</th>
<th>y</th>
<th>u</th>
<th>i</th>
<th>o</th>
<th>p</th>
<th>&lt;--</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl</td>
<td>Tab</td>
<td>a</td>
<td>s</td>
<td>d</td>
<td>f</td>
<td>g</td>
<td>h</td>
<td>j</td>
<td>k</td>
<td>l</td>
<td>Enter</td>
<td></td>
</tr>
<tr>
<td>Alt</td>
<td>Caps</td>
<td>z</td>
<td>x</td>
<td>c</td>
<td>v</td>
<td>b</td>
<td>n</td>
<td>m</td>
<td></td>
<td></td>
<td></td>
<td>Space</td>
</tr>
<tr>
<td>Alpha</td>
<td>Num</td>
<td>Func</td>
<td>Punc</td>
<td>Cfg</td>
<td>Off</td>
<td>←→↓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Figure 8-14.** TelnetCE Client VT/HP Virtual Emulation Keyboard
The following list provides information about the various control keys that appear at the bottom of the VT/HP virtual emulation keyboard.

**Alpha** Displays the alpha keys for VT/HP emulation, including:

- a - z
- Esc, Caps lock, Tab, Space, Enter, Backspace
- Shft, Ctl, Alt

**Num** Display the numeric keyboard for VT/HP emulation, which contains the following keys:

- 0 - 9
- Esc, Tab, Ins, Rem, Backspace, Enter, Space
- Shft

**Func** Displays the function keys for VT/HP emulation, including:

- F1 - F10
- Esc, Tab, Prev, Next, Find, Sel, Space, Backspace, Enter
- Shft, Ctrl, Alt

**Punc** Display the punctuation keys for VT/HP emulation, including:

- Punctuation Keys
- Backspace, enter, Space

**Cfg** Display the basic virtual emulation keyboard. For information about the keys in the basic emulation keyboard, see *Using the Basic Virtual Emulation Keyboard* on page 134.
Using Screen Panning

By default, the screen panning feature of the TelnetCE Client is enabled.

Screen panning feature of the TelnetCE Client allows a user to use the stylus to move around an emulation screen. When screen panning is enabled, a user can tap-and-drag the stylus and scroll across the emulation screen.

Screen panning has two modes of operation:

- **Standard.** By default, standard screen panning is enabled on the TelnetCE Client. When standard screen panning is enabled, the screen scrolls in the direction that the user drags the stylus across the screen. Standard screen panning simulates the effect of dragging the display of the mobile device over the emulation screen.

- **Reversed.** When reversed screen panning is enabled, the screen scrolls in the opposite direction that the user drags the stylus. Reverse screen panning simulates the effect of dragging the emulation screen beneath a fixed view port (that is, mobile device display).

**NOTE** For information about configuring screen panning, see Configuring Screen Panning on page 130.

Using ActiveText

By default, the ActiveText feature of the TelnetCE Client is enabled.

ActiveText allows the TelnetCE Client to identify menu items and functions in an emulation screen and convert them to interactive objects that a user can double-click to execute.

When a string of text is turned into ActiveText, a user can perform the following actions on the ActiveText object:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Hides the virtual keyboard.</td>
</tr>
<tr>
<td>Arrow Keys</td>
<td>Moves the cursor in the direction of the arrow key that you press.</td>
</tr>
</tbody>
</table>
• **Single-click.** A single click highlights the string of text and indicates that it has become an ActiveText object.

• **Double-click.** A double-click executes the menu item or the function that has been converted to an ActiveText object.

You can configure the TelnetCE Client to recognize two types of text strings that will be converted to ActiveText objects:

• Simple number menu item

• AS/400-style function key

**NOTE** For information about configuring ActiveText, see *Configuring ActiveText* on page 132.

**Simple Number Menu Item**

The TelnetCE Client can recognize numbered options in a menu and convert them to an ActiveText object.

The TelnetCE Client recognizes a string of characters in the following list as a simple number menu item:

• A beginning of line or a space

• A number (a string of digits)

• A period (‘.’)

• A space

• A non-space character

For example, the TelnetCE Client would convert the menu item **90. Sign Off** in an emulation to ActiveText. The user could then double-click the ActiveText to invoke the **90. Sign Off** menu option.

**AS/400-Style Function Key**

The TelnetCE Client can recognize AS/400-style function key commands in an emulation screen.
The TelnetCE Client recognizes the following string of characters as an AS/400-/style function key:

- A beginning of line or a space
- The character ‘F’
- A number (string of digits)
- An equal-to character (‘=’)
- A non-space character

For example, the TelnetCE Client would convert the function key command F3=Exit to ActiveText. The user could then double-click the ActiveText to invoke the F3=Exit command.

**Using the TelnetCE Client Diagnostics Utility**

The TelnetCE Client diagnostics utility allows you to perform the following tasks:

- Capture scan codes for external keyboard character sequences
- Perform a scan test
- Capture scan codes for the Windows virtual keyboard

**Accessing the TelnetCE Client Diagnostics Utility**

Use the TelnetCE Client virtual keyboard to access the diagnostics utility.

**To access the diagnostics utility:**

1. In the TelnetCE Client, access the virtual emulation keyboard.
2. In the virtual keyboard, click **Diags**.

---

**NOTE**  
Diags appears in the basic virtual emulation keyboard. For VT/HP emulation, Diags appears in the Cfg display of the virtual keyboard. For 5250/3270 emulation, Diags appears in the Alt display of the virtual keyboard.
The Program Diagnostics screen appears in the TelnetCE Client (Figure 8-15).

![Program Diagnostics Screen]

**Figure 8-15. TelnetCE Client Diagnostics Utility**

3. Select one of the options in the Program Diagnostics screen:

- Press **K** to perform a keyboard test, which allows you to obtain scan codes for the external keyboard and the TelnetCE Client virtual keyboard.

- Press **S** to perform a scan test, which allows you to determine the type of barcode for a scan.

- Press **W** to perform a Windows keyboard test, which allows you to obtain scan codes for the Windows virtual keyboard.

- Press **Q** to quick the diagnostics utility.
Performing a Keyboard Test

Use the TelnetCE Client to obtain scan codes for the external keyboard and the TelnetCE Client virtual keyboard.

To perform a keyboard test:

1. Ensure that you have an active VT/HP or 5250/3270 Telnet session.

**NOTE** An active session is required to test the TelnetCE Client virtual keyboard. The virtual keyboard displays keys based on the current Telnet session type.

2. Use the TelnetCE Client virtual keyboard to access the Program Diagnostics screen.

3. Press **K** for Keyboard Test.

   The Keyboard Test screen appears.

4. Use the external keyboard or the virtual keyboard to submit a character sequence to the TelnetCE Client.

   The TelnetCE Client displays the scan code for the character sequence (Figure 8-16).
5 Press Q to exit the Keyboard Test screen.

6 Press Q to exit the TelnetCE Client diagnostics utility.

Performing a Scan Test

Use the TelnetCE Client diagnostics utility to perform a scan test. A scan test allows you to verify the type and value of scanned data. The scan test utility does not process any scan handlers, scan identifiers, or pre- or post-amble strings. However, scan identifiers that you have configured are added to the scan.

To use the diagnostics utility to perform a scan test:

1 In the TelnetCE Client, access the diagnostics utility.

   The Program Diagnostics screen appears.

2 Select S for Scan/MSR Test.

   The Scan/MSR Test screen appears.
3  Use the scanner on the mobile device to perform a test scan.

The *Scan/MSR Test* screen displays the results of the scan (Figure 8-17).

![Options](image)

**Figure 8-17. Performing a Scan Test**

4  Press `Q` to close the *Scan/MSR Test* screen.

**Performing a Windows Keyboard Test**

Use the TelnetCE Client diagnostics utility to obtain scan codes for the Windows virtual keyboard.

To use the diagnostics utility to obtain Windows scan codes:

1  In the TelnetCE Client, access the diagnostics utility.

   The *Program Diagnostics* screen appears.

2  Select `W` for Windows Keyboard Test.

   The *Windows Keyboard Test* screen appears.
3 Access the Windows virtual keyboard.

4 Select a character sequence in the Windows virtual keyboard.

The diagnostics utility displays the scan code for the character sequence that you submitted to the TelnetCE Client (Figure 8-18).

![Figure 8-18. Performing a Windows Keyboard Test](image)

5 Press Q to exit the Windows Keyboard Test screen.

6 Press Q to exit the diagnostics utility.
Using the TelnetCE Client Options Menu

This section provides a description of each option in the TelnetCE Client Options menu.

**Connect Session [n]**  
Select this option to use the current session to initiate a Telnet connection with a host, where [n] is the session number that is currently active.

**Disconnect Session [n]**  
Select this option to disconnect the current session, where [n] is the session number that is currently active.

**Session [n] - [name] unconnected**  
Select this option to switch between sessions, where:

- [n] indicates the session number
- [name] indicates that the session is currently connected to [name] host
- unconnected is a constant that indicates that the session is not currently in use

**Scripting > Execute Script**  
XXX

**Scripting > Cancel Script**  
XXX

**Scripting > Start Capture**  
XXX

**Scripting > Stop Capture**  
XXX

**Scripting > Verify Screen Contents**  
XXX

**Scripting > Save Cursor Position**  
XXX

**Configure > Host Profiles**  
Select this option to configure host profiles for the TelnetCE Client.

**Configure > Emulation**  
Select this option to configure emulation parameters for the TelnetCE Client.

**Configure > Scripting**  
XXX
Configure > Authorization
Select this option to configure licensing for the TelnetCE Client.

Configure > Localization
Select this option to configure localization for the TelnetCE Client.

View > Emulation Keyboard
Shows/hides the virtual emulation keyboard.

View > Numeric Keyboard
Shows/hides the numeric keyboard.

View > Font
Displays the font settings for the Telnet session. Use the Font tab in the dialog box to modify the font settings for the Telnet session.

About TelnetCE...
Displays the About window, which provides information about the TelnetCE Client.

Exit
Select this option to exit and close the TelnetCE Client. Depending on the configuration of the TelnetCE Client, you may need to supply an exit password.
Chapter 9: Avalanche Integration

This section provides the following information:

- Overview of Avalanche integration
- Avalanche Manager Session Monitor
- Avalanche Manager Real-Time Statistics

Overview of Avalanche Integration

A number of additional features are available for the TelnetCE Client when you choose to install the TelnetCE Client via the Avalanche framework.

Avalanche-installed TelnetCE Clients offer the following Avalanche-integrated features:

- **Session Monitor.** Allows you to monitor and to take control of the TelnetCE Client remotely from the Avalanche Management Console.

- **Real-Time Statistics.** Allows you to view real-time statistics, including session length and number of scans, from the *Avalanche Client Controls* dialog box in the Avalanche Management Console.

To take advantage of the Avalanche features of the TelnetCE Client, your Avalanche environment must meet the following requirements:

- Avalanche Manager 3.5 (or greater version) for Session Monitor
- Avalanche Manager 3.4 (or greater version) for Real-Time Statistics
- Avalanche Enabler 3.x (or greater version)
- A valid Avalanche license for the mobile device running the TelnetCE Client
- A valid platform or maintenance license for the TelnetCE Client
- TelnetCE Client 5.x (or greater version)
Using Session Monitor

The Session Monitor utility allows you to view the TelnetCE Client on a mobile device from the Avalanche Management Console. Session Monitor includes an override feature that allows you to take control of the Telnet Client on the mobile device. Session Monitor also includes a logging feature that allows you to create a trace for Telnet sessions.

This sections provides the following information:

- Enabling Session Monitor.
- Configuring Session Monitor.
- Launching Session Monitor.
- Using Session Override.
- Tracing a Session Monitor session.

**NOTE** Session Monitor requires Avalanche Manager 3.5 (or greater version) and a valid Avalanche license.

Enabling Session Monitor

The following tasks are required to enable Session Monitor.

1. Install the Telnet Client 5.0 package in Avalanche Manager.
2. Configure the Telnet Client to use Session Monitor.
3. Perform an Avalanche update to deploy the Telnet Client to the mobile device.
4. Launch the Telnet Client on the mobile device.
5. Launch Session Monitor from Avalanche Manager.

Configuring Session Monitor

Configure the following Session Monitor parameters in the Telnet Emulation Parameters:
• **Session Monitor Address.** These are the IP addresses of computers that the Telnet Client allows to do session monitoring. If no addresses are specified, the Telnet allows session monitoring from any computer.

• **Session Monitor Override Timeout.** This is the maximum number of minutes that Session Monitor is allowed to override the session. After the time expires, the override setting is disabled and control returns to the client device. The default time-out for override mode is set to 0 (never). This means the override mode will never time-out and the client regains control only if override mode is disabled manually.

• **Session Monitor Password.** This is the password required for Session Monitor connections. The password is loaded in the Emulation Parameters file and is never entered by the user. It has a 63 character limit. If no password is entered, the Telnet Client will not accept Session Monitor connections.

• **Session Monitor Port.** This is the port that the Telnet Client listens to for Session Monitor connections.

**To configure Session Monitor**

1. Locate the Telnet Client software package in the Tree View of the Avalanche Manager.

2. Right-click the software package.

3. Select Configure Package > Emulation Parameters.

   Configuration Manager launches.

4. Expand the Emulation folder.

5. Expand the Session Monitor folder.

6. Double-click the Session Monitor menu items to change the parameters.

**NOTE** The Session Monitor Password is the only required configuration. The other parameters are optional configurations.

7. Once you have configured the Session Monitor parameters, click the Save button.
8 Close the configuration utility.

9 Perform an Avalanche update to download the new configuration to the mobile device.

Launching Session Monitor

You can launch Session Monitor from the Avalanche Management Console.

To launch Session Monitor

1 From the Device View of Management Console, right-click the device you want to monitor.

2 Select the Launch Session Monitor option (Figure 9-1).

![Figure 9-1. Launching Session Monitor]

**NOTE** The client device and the Avalanche Manager need to be communicating over the network.

The Telnet Session Monitor screen opens and connects to the session. The yellow-lined box represents what the device user can see (Figure 9-2).
If both the mobile device and the Avalanche PC have SSL support installed, the Session Monitor network information will be encrypted.

**Session Override**

Use the session override option of Session Monitor to take control of the Telnet Client. When you enable session override, the mobile device user will not be able to interact with the Telnet Client.

**To enable override mode**

1. In Session Monitor, access the Monitor menu.
2. Select the Session Override option (Figure 9-3).
The session remains in override mode until the override timeout minutes expire or until you manually disable the session override option.

**Tracing Sessions**

Use the *Log File Settings* dialog box to configure the Session Monitor log file to trace Session Monitor sessions.

**To trace a session**

1. In Session Monitor, access the *File menu*.
2. Select the *Log to File* option.
3. Configure the log file settings.
4. In the *Log File Path* text box, enter the path to the directory where you want to save the log file (Figure 9-4).
5. Click *OK*. 

![Figure 9-3. Enabling Session Override](image-url)
The log file is saved as sessionlog.txt in the directory specified in Log File Path text box. If sessionlog.txt already exists, the log file will attempt to save as sessionlog2.txt, sessionlog3.txt, etc. until it finds a non-existing file name in the specified log file path.

**Using Real-Time Statistics**

The TelnetCE Client periodically transmits emulation-specific information to Avalanche Manager. Avalanche Manager displays the information it receives in the Properties tab of the Avalanche Client Controls dialog box for the mobile device.

The Avalanche Manager displays Telnet session information including:

- **Telnet-Specific Information.** This includes information on the current Telnet Client version, the mobile device battery power, and SSL support and use.

- **Session-Specific Information.** This includes information on barcode, MSR and RFID scanning, session connect time, and running time of the current session.
By default, the Telnet Client transmits emulation-specific information to Avalanche Manager every five minutes (300 seconds). You can modify this RealTimeStatsInterval property in the Properties tab of the Avalanche Client Controls dialog box.

This document provides the following information:

- Viewing real-time statistics
- Modifying real-time statistics

**NOTE** Real-Time Statistics requires Avalanche Manager 3.4 (or greater version) and a valid Avalanche license for the mobile device.

### Viewing Real-Time Statistics

You can view the real-time statistics from the Properties tab of the Avalanche Client Controls dialog box.

**To view the statistics:**

1. From the Device View of Management Console, right-click the device you want to monitor.

2. Select **Client Settings**.

   The **Avalanche Client Controls** dialog box opens.

3. Click the Properties tab.

   The Properties tab contains a number of entries specific to the TelnetCE Client (Figure 9-5).
The following list describes the TelnetCE Client real-time statistics that are displayed in the Properties tab.

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
<th>Changeable</th>
<th>Change Pending</th>
</tr>
</thead>
<tbody>
<tr>
<td>RealTimeStatsInterval</td>
<td>3600</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Telnet Version</td>
<td>5.00-01</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Telnet SSL Supported</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Telnet Battery Power</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Telnet Average Time Total</td>
<td>600</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Telnet Average Time Display</td>
<td>60</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Telnet Time Running</td>
<td>1.9 Minutes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Telnet Session 1.Connect Time</td>
<td>10.0 Minutes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Telnet Session 1.SSL In Use</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Telnet Session 1.Barcode Scans</td>
<td>0.0 Scans per Minute</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Telnet Session 1.MSR Scans</td>
<td>0.0 Scans per Minute</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Telnet Session 1.Transactions</td>
<td>0.4 per Minute</td>
<td>Yes</td>
<td></td>
</tr>
</tbody>
</table>

**Figure 9-5. Viewing Real-Time Statistics in Avalanche Manager**

The following list describes the TelnetCE Client real-time statistics that are displayed in the Properties tab.

- **RealTimeStatsInterval**: Indicates how often the Telnet Client sends real-time statistics information to Avalanche Manager. The interval is measured in seconds.
  
  Default: 300 seconds

  Note: It is recommended to change the time to five (5) seconds when you are monitoring a device.

- **Telnet Version**: Displays the current version of the Telnet Client.

- **Telnet SSL Supported**: Indicates whether SSL is supported.

- **Telnet Battery Power**: Indicates the remaining battery power of the mobile device.
| **Telnet Average Time**<br>**Total** | Indicates the length of time the session statistics are tracked. | **Default:** 600 seconds |
| **Telnet Average Time**<br>**Display** | Indicates the interval time for barcode, MSR, and RFID scans and transactions. The default setting (60 seconds) means that scans display as a number of scans per minute. If you change this to property to 120 seconds, the scans display as number of scans per two minutes. | **Default:** 60 seconds |
| **Telnet Time Running** | Displays the current running time for the TelnetCE Client. | |
| **Telnet Session <n>**<br>**Connect Time** | Displays the amount of time the Telnet session has been running, where <n> indicates the Telnet session (1 - 4). | |
| **Telnet Session <n> SSL**<br>**in Use** | Indicates whether the Telnet session is using SSL, where <n> indicates the Telnet session (1–4). | |
| **Telnet Session <n>**<br>**Barcode Scans** | Displays the number of barcode scans per <x> seconds for the Telnet Session, where <n> indicates the Telnet session (1–4) and <x> indicates the time set in the Telnet Average Time Display property. | |
| **Telnet Session <n>**<br>**MSR**<br>**Scans** | Displays the number of MSR scans per <x> seconds for the Telnet Session, where <n> indicates the Telnet session (1–4) and <x> indicates the time set in the Telnet Average Time Display property. MSR scan information displays only if the mobile device supports MSR scanning. | |
Modifying Real-Time Statistics

While many of the Telnet session parameters indicate they are changeable, you should only modify RealTimeStatsInterval, Telnet Average Time Total, and Telnet Average Time Display.

To modify a statistic:

1. From the Device View of Management Console, right-click the device you want to monitor.
2. Select Client Settings.

   The Avalanche Client Controls dialog box opens.
3. Click the Properties tab.
4. Click the Value column of the statistic you want to change.
5. Type the new Value.
6. Click the Apply Changes button.
7. Update the device to download the new property values to the device.

**NOTE** If the TelnetCE Client is currently running, modified real-time statistics will not display until the next real-time statistics transmit to Avalanche Manager. For example, if you modify the RealTimeStatsInterval property.

| **Telnet Session <n> Transaction** | Displays the number of transactions per <x> seconds for the Telnet Session, where <n> indicates the Telnet session (1–4) and <x> indicates the time set in the Telnet Average Time Display property. |
| **Telnet Session <n> RFID** | Displays the number of RFID scans per <x> seconds for the Telnet Session, where <n> indicates the Telnet session (1–4) and <x> indicates the time set in the Telnet Average Time Display property. RFID scan information displays only if the mobile device supports RFID scanning. |
from 300 seconds to five (5) seconds, it may take the remaining seconds of the previous 300-second setting before the statistics begin to update every five seconds.
Chapter 10: Manually Configuring the TelnetCE Client

This section provides the following information:

You can configure certain TelnetCE Client parameters manually (that is, at the mobile device), including:

- Host profiles
- Per-host emulation parameters

Manually Configuring Host Profiles

You can manually perform the following tasks with the TelnetCE Client interface:

- Create a new host profile
- Modify an existing host profile
- Delete a host profile

**NOTE** When you download a new TelnetCE Client configuration to the mobile device using Microsoft ActiveSync or Avalanche Manager, any manual changes that you have made will be overwritten.

**NOTE** For information about host profiles, see Chapter 3: Host Profiles on page 25.

Accessing Host Profiles

To add, modify, or delete host profile, you must access the Host Profiles dialog box.

To access the host profiles dialog box:

1. On the mobile device, launch the TelnetCE Client.

2. In the TelnetCE Client, access the Options menu.
3 From the **Options** menu, select **Configure > Host Profiles**.

The *Input Password* dialog box appears.

4 In the **Input Host Config Password** text box, type the RF Config Password.

**NOTE** The default RF Config Password is “system”. For information about modifying the RF Config Password, see *Configuring Passwords* on page 121. If no RF Config Password is configured, the TelnetCE Client will not prompt you for a password.

5 Press the **Enter** key.

The *Edit Host Profile* dialog box appears.

6 Use the *Edit Host Profile* dialog box to add, modify, or delete host profiles.

**Creating a New Host Profile**

You can use the *Edit Host Profile* dialog box to create a new host profile for the TelnetCE Client.

**To create a new host profile:**

1 On the mobile device, launch the TelnetCE Client.

2 Use the TelnetCE Client **Options** menu to access the *Edit Host Profiles* dialog box.

3 In the *Edit Host Profile* dialog box, click **Add**.

A new *Edit Host Profile* dialog box appears.

4 Use the *Edit Host Profile* dialog box to configure the basic parameters of the host profile (alias, IP address, TCP port number, and emulation type).

5 Select **More** to access and configure other configuration parameters that are specific to the emulation type that you have selected.

**NOTE** For more information about other configurable parameters for a host profile, see *Host Profile Settings* on page 165.
6  After you have finished configuring the host profile, select **Save** in the *Edit Host Profile* dialog box.

   The *Edit Host Profiles* dialog box appears, and you are returned to the first *Edit Host Profile* dialog box, which now displays the new host profile.

7  Select **Done**.

   The *Edit Host Profile* dialog box closes and you return to the primary TelnetCE Client interface.

---

**NOTE** To exit either of the *Edit Host Profile* dialog box without saving the changes that you have made, press **Esc**.

---

**Modifying an Existing Host Profile**

You can use the *Edit Host Profile* dialog box to modify the parameters of an existing host profile.

**To modify an existing host profile:**

1  On the mobile device, launch the TelnetCE Client.

2  From the TelnetCE Client **Options** menu, access the *Edit Host Profile* dialog box.

3  In the list of profiles in the *Edit Host Profile* dialog box, select the host profile dialog box that you want to modify.

4  Select **Edit**.

5  Use the *Edit Host Profile* dialog box to modify the basic parameters of the host profile (alias, IP address, TCP port number, and emulation type).

6  Select **More** to access and configure other emulation type-specific parameters for the host profiles.

---

**NOTE** For more information about the parameters in the *Edit Host Profile* dialog box and the parameters in the other emulation type-specific dialog boxes, see *Host Profile Settings* on page 165.

---

7  After you have modified the parameters for the host profile, select **Save**.
The changes that you have made are applied to the host profile. The Edit Host Profile dialog box closes and you return to the first Edit Host Profile dialog box.

8 Select Done.

The Edit Host Profile dialog box closes and you return to the primary TelnetCE Client interface.

NOTE To exit either of the Edit Host Profile dialog boxes without saving the changes that you have made, press Esc.

**Deleting an Existing Host Profile**

You can use the Edit Host Profile dialog box to delete an existing profile.

To delete an existing host profile:

1 On the mobile device, launch the TelnetCE Client.

2 From the TelnetCE Client Options menu, access the Edit Host Profile dialog box.

3 From the list of host profiles in the Edit Host Profile dialog box, select the host profile that you want to delete.

4 Select Delete.

The host profile is deleted from the list of host profiles in the Edit Host Profiles dialog box.

5 Select Done.

The Edit Host Profile dialog box closes and you return to the primary TelnetCE Client interface.

NOTE To exit the Edit Host Profile dialog box without saving the changes that you have made, press Esc.
Host Profile Settings

This section provides details about the configurable parameters that are available in the various host profile dialog boxes.

**Edit Host Profile Parameters**

The following list describes the options and configurable parameters in the *Edit Host Profile* dialog box.

**Alias**

Indicates the name of the host profile. Usually, this is the name or alias of the host system with which the mobile device creates a Telnet session.

**Possible Values:** 1 - 50 alpha-numeric characters

**Default:** <None>

**Address**

Indicates the IP address or host name of the host system.

**Possible Values:** Any valid IP address or host name

**Default:** <None>

**Port**

Indicates the TCP port on which the host system is listening for Telnet connections.

**Possible Values:** 0 - 65535

**Default:** 23

**Emulation**

Indicates the type of emulation that the host system uses.

**Available Options:** <IBM-5251-11> <IBM-3278-2> <IBM-3279-2> <IBM-3279-2E> <VT100> <VT220> <HP>

**Default:** <IBM-5251-11>

**Save**

Select this button to save the host profile and close the *Edit Host Profile* dialog box.
**More**  
Select this button to access other, emulation type-specific parameters for the host profile.

**Config**  
Select this button to modify the emulation parameters for the host profile.

**More 5250 Options**
The *More 5250 Options* dialog box appears when the following criteria are met:

- You set the emulation type is to 5250 in the *Edit Host Profile* dialog box.
- You click **More** in the *Edit Host Profile* dialog box.
The following list describes the options and configurable parameters in the
*More 5250 Options* dialog box.

**Device Name**

Indicates the workstation ID that mobile devices use to connect to the host system. This includes static characters and the following switches, which are used to capture dynamic data that is specific to each mobile device:

- **%a - %d.** Captures specific octets of the IP address of the mobile device. For example, use %a%b%c%d to capture all four IP octets of the address of the mobile device, or use %d to capture only the last octet of the IP address of the mobile device.

- **%m - %r.** Captures specific octets of the MAC address of the mobile device. (For example, use %p%q%r to capture the last three octets of the MAC address of the mobile device.)

- **%s.** Captures the session number.

- **%t.** Captures the Avalanche terminal ID of the mobile device. (If the mobile device is not an Avalanche client, this parameter is invalid.)

**Possible Values:** 1 - 20 alpha-numeric characters plus switches (see above)

**Default Value:** None

**NOTE:** IBM hosts usually truncate workstation IDs that are more than 10 characters. Also, the workstation ID should not begin with a numeric character.

**OK**

Select this button to save the changes that you have made and return to the *Edit Host Profile* dialog box.

**More VT Options**

The *More VT Options* dialog box appears when the following criteria are met:
- You have set the emulation type in the *Edit Host Profile* dialog box to VT100, VT220, or HP.

- You click **More** in selected in the *Edit Host Profile* dialog box.

The following list describes the options and configurable parameters in the *More VT Options* dialog box.

<table>
<thead>
<tr>
<th><strong>Telnet Negotiation String</strong></th>
<th>Indicates the Telnet negotiation string that the mobile device should use when establishing a Telnet session with the host system.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Possible Values:</strong></td>
<td>Any valid Telnet negotiation string</td>
</tr>
<tr>
<td><strong>Default:</strong></td>
<td>&lt;None&gt;</td>
</tr>
</tbody>
</table>

- **OK**
  Select this button to save the changes that you have made and return to the *Edit Host Profile* dialog box.

- **Login**
  Select this button to access the *Edit AutoLogin* dialog box, which allows you to configure auto login parameters for the host connection.

### Edit AutoLogin

The *Edit AutoLogin* dialog box is accessed through the **Login** button in the *More VT Options* dialog box.

The following list describes the options and configurable parameters in the *Edit AutoLogin* dialog box.

<table>
<thead>
<tr>
<th><strong>Name Prompt</strong></th>
<th>Indicates the user name prompt that the host system uses.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Possible Values:</strong></td>
<td>Any valid user name prompt</td>
</tr>
<tr>
<td><strong>Default:</strong></td>
<td>&lt;None&gt;</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Name</strong></th>
<th>Indicates the user name that the mobile device supplies at the user name prompt.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Possible Values:</strong></td>
<td>Any valid user name</td>
</tr>
<tr>
<td><strong>Default:</strong></td>
<td>&lt;None&gt;</td>
</tr>
<tr>
<td><strong>Password Prompt</strong></td>
<td>Indicates the password prompt that the host system uses.</td>
</tr>
<tr>
<td>---------------------</td>
<td>----------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Possible Values</strong>: Any valid password prompt</td>
<td></td>
</tr>
<tr>
<td><strong>Default</strong>: &lt;None&gt;</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Password</strong></th>
<th>Indicates the password that the mobile device supplies at the password prompt.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Possible Values</strong>: Any valid user password</td>
<td></td>
</tr>
<tr>
<td><strong>Default</strong>: &lt;None&gt;</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Command Prompt</strong></th>
<th>Indicates the command prompt that the host system uses.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Possible Values</strong>: Any valid command prompt</td>
<td></td>
</tr>
<tr>
<td><strong>Default</strong>: &lt;None&gt;</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Command</strong></th>
<th>Indicates the command that the mobile device supplies at the command prompt.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Possible Values</strong>: Any valid command</td>
<td></td>
</tr>
<tr>
<td><strong>Default</strong>: &lt;None&gt;</td>
<td></td>
</tr>
</tbody>
</table>

| **OK** | Select this button to save the changes that you have made and return to the *More VT Options* dialog box. |

### Manually Configuring Emulation Parameters

You can manually configure certain TelnetCE Client emulation parameters on a per-host basis.

**NOTE** For more information about global and per-host emulation parameters, see *Chapter 4: Emulation Parameters* on page 55.
NOTE You must use the Configuration Manager to modify most emulation parameters. For information about using Configuration Manager, see Using Configuration Manager on page 68.

Accessing and Modifying Per-Host Emulation Parameters

You can manually modify certain per-host emulation parameters.

To access and modify global emulation parameters:

1. On the mobile device, launch the TelnetCE Client.
2. Access the TelnetCE Client Options menu.
3. From the TelnetCE Client Options menu, select Configure > Emulation.
   
   The Input Password dialog box appears.
4. In the Input Terminal Config Password text box, type the term config password.

   NOTE The default Term Config password is “config”. For information modifying the term config password, see Configuring Passwords on page 121. If no Term Config password is configured, the TelnetCE Client will not prompt you for a password.
5. Select OK.
   
   The Select Host dialog box appears.
6. In the Select Host dialog box, select the host profile that contains the emulation parameters that you want to modify.
7. Select OK.
   
   The Settings dialog box appears for the host profile.
8. Use the various tabs in the Settings dialog box to modify the emulation parameters for the host profile.
NOTE For more information about the tabs and the configurable parameters in each tab of the Settings dialog box, see *Per-Host Emulation Parameters* on page 171.

9 After you have configured the emulation parameters for the host profile, select the **OK** button in the upper right corner of the *Settings* dialog box.

The *Settings* dialog box closes and you return to the primary TelnetCE Client interface.

**Per-Host Emulation Parameters**

This section provides information about the parameters in the various tabs of the *Settings* dialog box.

**VTXX Settings**

Use the VTXX tab in the *Settings* dialog box to configure parameters for VT-type emulation. If the host profile is configured for IBM-type emulation, you do not need to configure the VTXX tab.

The following list describes the parameters in the VTXX tab.

**Local Echo**

Indicates whether the TelnetCE Client echoes characters that it received from a VT host.

**Possible Values:** <Enabled> <Disabled>

**Default:** <Disabled>
IBM Host Settings

Use the IBM Host tab in the Settings dialog box to configure parameters for IBM-type emulation. If the host profile is configured for VT-type emulation, you do not need to configure the IBM Host tab.

The following table describes the configurable options in the IBM Host tab.

<table>
<thead>
<tr>
<th>5250 - Column Separator Dot</th>
<th>Indicates whether the TelnetCE Client displays a period or vertical line between each character when the host system uses a special column format mode.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Possible Values:</td>
<td>&lt;Enabled&gt; &lt;Disabled&gt;</td>
</tr>
<tr>
<td>Default:</td>
<td>&lt;Enabled&gt;</td>
</tr>
</tbody>
</table>
Message Settings

Use the Message tab of the Settings dialog box to configure the settings for messages that the mobile device receives from the host system. Certain parameters in the Message tab are applicable only to 5250- and 3270-type emulation.

5250 Swap Enter Key / Field Exit
Indicates whether the enter key is mapped to the field exit key and the clear key is mapped to the enter key.

Possible Values: <Enabled> <Disabled>
Default: <Disabled>

3270 - Alternate System Request
Indicates whether the TelnetCE Client encodes 3270 system requests as requests instead of default interrupt processes.

Possible Values: <Enabled> <Disabled>
Default: <Disabled>
The following list describes the configurable options in the Message tab.

**Message Line**  
*5250/3270 Only*  
Specifies the line from the host screen that the TelnetCE Client reads to display as the message line. The TelnetCE Client displays the message line each time its contents change. When the contents of the message line are not valid, the line appears in reverse video at the top of the display.

**Possible Values:** 0 - 24

**Default:** 24

**NOTE:** Use a value of 0 to prevent the display message.

**Auto Reset Delay**  
*5250/3270 Only*  
Indicates the amount of time (in seconds) the TelnetCE Client waits before sending a reset to the host when the Reset Required parameter is set to Never.

**Possible Values:** 0 - 5 (seconds)

**Default:** 2

**Message Beeps**  
*5250/3270 Only*  
Indicates the number of additional beeps that occur on the mobile device when the TelnetCE Client receives a system message.

**Possible Values:** Up to 255 characters, but only integer values are valid

**Default:** 0
Reset Required  
(5250/3270 Only)  
Indicates the situations that require the user to press the reset key.  
Options include:  
  
  • **On All Messages.** Requires a reset on screens that display information on line 24 (the bottom display line).  
  
  • **On Errors.** Requires a reset on screens that have an error indicator.  
  
  • **Never.** Requires the user to use a reset, but TelnetCE Client automatically performs the reset when it detects an error indicator.  

Possible Values: <OnErrors> <On All Messages> <Never>  
Default: <Disabled>  

Use Enter As Reset  
Indicates whether the enter key on the mobile device functions as the reset key when the mobile device is in an error state.  

Possible Values: <Enabled> <Disabled>  
Default: <Disabled>  

Font Settings  
Use the Font tab in the Settings dialog box to configure the way that text displays for the host connection.
The following list describes the configurable options in the Font tab.

**Name**
Indicates the font that the TelnetCE Client uses to display text in the emulation screen.

**Possible Values:** Any font installed on the mobile device

**Default Values:** <Courier New>

**Size**
Indicates the size (in points) in which text displays in the emulation screens.

**Possible Values:** 6 - 24

**Default Value:** 7

**Weight**
Indicates the weight that is applied to text in the emulation screens.

**Possible Values:** <Normal> <Bold>

**Default Value:** <Normal>

**Left (Clipping)**
Indicates the amount of white space (in font points) that the TelnetCE Client crops from the left of the font.

**Possible Values:** Up to 255 characters, but only integer values are valid

**Default Value:** 0

**Right (Clipping)**
Indicates the amount of white space (in font points) that the TelnetCE Client crops from the right of the font.

**Possible Values:** Up to 255 characters, but only integer values are valid

**Default Values:** 0
Display Settings

Use the Display tab in the Settings dialog box to configure how the TelnetCE Client displays.

The following list describes the configurable options in the Display tab.

**Top (Clipping)**

Indicates the amount of white space (in font points) that the TelnetCE Client crops from the top of the font.

**Possible Values:** Up to 255 characters, but only integer values are valid

**Default Values:** 0

**Bottom (Clipping)**

Indicates the amount of white space (in font points) that the TelnetCE Client crops from the bottom of the font.

**Possible Values:** Up to 255 characters, but only integer values are valid

**Default Value:** 0
**Vertical Scrollbar**
Indicates whether the TelnetCE Client displays the vertical scrollbar during a Telnet session.

**Possible Values:** <Enabled> <Disabled>

**Default Value:** <Disabled>

**Horizontal Scrollbar**
Indicates whether the TelnetCE Client displays the horizontal scrollbar during a Telnet session.

**Possible Values:** <Enabled> <Disabled>

**Default Value:** <Disabled>

**Hide Keyboard (Button)**
Click this button to access a dialog box that will allow you to configure a key sequence that hides/reveals the TelnetCE Client emulation keyboard.

**Hide Keyboard (Text Box)**
Indicates the key sequence that is configured to hide/reveal the TelnetCE Client emulation keyboard.

**View Settings**
Use the View tab in the Settings dialog box to configure how the view screen functions for the host connection.

The following list describes the configurable options in the View tab.

**Free Cursor**
Indicates whether a user is allowed to move the cursor into “protected” areas of the screen.

**Possible Values:** <Enabled> <Disabled>

**Default Value:** <Enabled>

**Scrolling (Full Screen Mode)**
Indicates whether the TelnetCE Client uses full-screen mode, which allows the user to scroll around the virtual display.

**Possible Values:** <Enabled> <Disabled>

**Default Value:** <Enabled>
Scroll Offsets - Vert  
(Full-Screen Mode Only)  
Specifies the number of columns that the vertical display moves when the cursor crosses the vertical edge of the screen.

Possible Values: 0 - 80

Default Value: 0

NOTE: Use 0 to indicate the current vertical display size.

Scroll Offsets - Horz  
(Full-Screen Mode Only)  
Specifies the number of rows that the virtual display moves when the cursor crosses the horizontal edge of the screen.

Possible Values: 0 - 24

Default Value: 0

NOTE: Use 0 to indicate the current horizontal display size.

Fixed Screen Mode  
Indicates whether the TelnetCE Client fixes the display on the mobile device to a specific position in the virtual display. When fixed-screen mode is enabled, the same portion of the virtual display appears on the display screen without regard to the location of the cursor.

Possible Values: <Enabled> <Disabled>

Default Value: <Disabled>

NOTE: If you enable fixed-screen mode, you must also specify the position in the Fixed Screen Window Origin group.
Cursor Settings

Use the Cursor tab in the Settings dialog box to configure the function of the cursor in emulation screens for the host connection.

The following list describes the configurable options in the Cursor tab.

**Window Origin - Left**

*Fixed-Screen Mode Only*

Specifies the virtual screen column where the display screen of the mobile device is fixed.

**Possible Values:** 1 - 79

**Default Value:** 1

**Window Origin - Top**

*Fixed-Screen Mode Only*

Specifies the virtual screen row where the display screen of the mobile device is fixed.

**Possible Values:** 1 - 24

**Default Value:** 1

**Cursor Edge Zones - Left**

Specifies the left border of the cursor zone in the virtual display. When the cursor moves outside of the border, the TelnetCE Client repositions the screen over the virtual display, centering the cursor on the display screen of the mobile device.

**Possible Values:** Up to 255 characters, but only integer values are valid

**Default Value:** 4

**Cursor Edge Zones - Right**

Specifies the right border of the cursor zone in the virtual display. When the cursor moves outside of the border, the TelnetCE Client repositions the screen over the virtual display, centering the cursor on the display screen of the mobile device.

**Possible Values:** Up to 255 characters, but only integer values are valid

**Default Value:** 1
**Tiling - Vert Mode**  
Determines how the TelnetCE Client handles vertical tiling. Options include:

- **None.** The TelnetCE Client repositions the screen on the cursor.
- **TopOnly:** The TelnetCE Client repositions the screen in the uppermost row of tiles.
- **All.** The TelnetCE Client always tiles vertically.

**Possible Values:** <All> <None> <TopOnly>

**Default Value:** <TopOnly>

**Tiling - Horz Mode**  
Determines how the TelnetCE Client handles horizontal tiling. Options include:

- **None.** The TelnetCE Client positions the screen around the cursor.
- **LeftOnly.** The TelnetCE Client positions the screen around the leftmost column of tiles.
- **All.** The TelnetCE Client always tiles horizontally.

**Possible Values:** <All> <LeftOnly> <None>

**Default Value:** <LeftOnly>
<table>
<thead>
<tr>
<th><strong>Tiling - Vert</strong></th>
<th>Specifies the height of the logical screen in “tiles” for tiling mode.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Possible Values:</strong></td>
<td>0 - screen height (in rows)</td>
</tr>
<tr>
<td><strong>Default Value:</strong></td>
<td>0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Tiling - Horz</strong></th>
<th>Specifies the width of the logical screen in “tiles” for tiling mode.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Possible Values:</strong></td>
<td>0 - screen width (in rows)</td>
</tr>
<tr>
<td><strong>Default Value:</strong></td>
<td>0</td>
</tr>
</tbody>
</table>

**Beeps Settings**

Use the Beeps tab in the *Settings* dialog box to configure the beeps that the mobile device plays when it receives messages or errors from the host system.

The following list describes the configurable options in the Beeps tab.

<table>
<thead>
<tr>
<th><strong>Message Beep</strong></th>
<th>Indicates the sound that the mobile device generates when it receives a message from the host system.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Possible Values:</strong></td>
<td>&lt;Default&gt; &lt;SystemAsterisk&gt; &lt;SystemExclamation&gt; &lt;SystemExit&gt; &lt;SystemHand&gt; &lt;SystemQuestion&gt;</td>
</tr>
<tr>
<td><strong>Default Value:</strong></td>
<td>&lt;Default&gt;</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Error Beep</strong></th>
<th>Indicates the sound that the mobile device generates when it receives an error from the host system.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Possible Values:</strong></td>
<td>&lt;Default&gt; &lt;SystemAsterisk&gt; &lt;SystemExclamation&gt; &lt;SystemExit&gt; &lt;SystemHand&gt; &lt;SystemQuestion&gt;</td>
</tr>
<tr>
<td><strong>Default Value:</strong></td>
<td>&lt;Default&gt;</td>
</tr>
<tr>
<td><strong>Silent Mode</strong></td>
<td>Indicates whether silent mode is enabled. If silent mode is enabled, the mobile device will not play beeps when it receives messages or errors from the host system.</td>
</tr>
<tr>
<td>---------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Possible Values:</strong></td>
<td>&lt;Enabled&gt; &lt;Disabled&gt;</td>
</tr>
<tr>
<td><strong>Default Value:</strong></td>
<td>&lt;Disabled&gt;</td>
</tr>
<tr>
<td><strong>Test</strong></td>
<td>Tests the beep settings that are configured. The mobile device will play the beeps that are configured for messages and errors, in that order.</td>
</tr>
</tbody>
</table>

**Telnet Settings**

Use the Telnet tab in the Settings dialog box to configure the Telnet auto-connect feature for connections to the host system.

The following list describes the configurable options in the Telnet tab.

<table>
<thead>
<tr>
<th><strong>Auto Connect</strong></th>
<th>Indicates whether the mobile device should attempt to reconnect to the host system when the host system terminates the session.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Possible Values:</strong></td>
<td>&lt;Enabled&gt; &lt;Disabled&gt;</td>
</tr>
<tr>
<td><strong>Default Value:</strong></td>
<td>&lt;Disabled&gt;</td>
</tr>
</tbody>
</table>

**Printer Settings**

Use the Printer tab in the Settings dialog box to configure the printer that the mobile device is using for the host connection.
The following list describes the options and configurable parameters in the Printer tab.

**Printer**

Indicates the printer that the mobile device uses.

**Possible Values:** <PS1000> <PS1001> <PS1004> <LINEPRINTER> <DUMB> <COMTEC> <PATHFINDER> <RASCAL> <RENEGADE> <COMTECL_PS> <CODE_COURIER> <COMTEC_RF> <COMTEC_RF_960> <TEC> <User Defined>

**Default Value:** <PS1000>

**Port**

Indicates the COM port on the mobile device to which the printer is connected.

**Possible Values:** <COM1>

**Default Value:** <COM1>

**Baud**

Indicates the baud rate of the serial connection to the printer.

**Possible Values:** <9600> <14400> <19200> <38400> <57600> <115200>

**Default Value:** <9600>

**Parity**

Indicates the parity of the serial connection to the printer.

Possible Values: <None> <Even> <Mark> <Odd> <Space>

Default Value: <None>

**Data**

Indicates the data bits (the number of bits in each octet) of the serial connection to the printer.

**Possible Values:** <4> <5> <6> <7> <8>

Default Value: <8>
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Stop</strong></td>
<td>Indicates the number of stop bits that the serial connection to the printer uses.</td>
</tr>
<tr>
<td><strong>Possible Values:</strong></td>
<td>&lt;1&gt; &lt;2&gt;</td>
</tr>
<tr>
<td><strong>Default Value:</strong></td>
<td>&lt;1&gt;</td>
</tr>
<tr>
<td><strong>Wakeup</strong></td>
<td>Indicates the string of characters that the mobile device sends to the printer as a wakeup. You can represent the wakeup string as an ASCII or hex value.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Hex Value.</strong> Type the hex values of the characters that you want the mobile device to send to the printer. For example, 0000 sends two nulls to the printer.</td>
</tr>
<tr>
<td></td>
<td>• <strong>ASCII Value.</strong> Use “&lt;&gt;” to enclose ASCII hex values. For example, &lt;00&gt; &lt;00&gt; sends two nulls to the printer.</td>
</tr>
<tr>
<td><strong>Possible Values:</strong></td>
<td>Any valid wakeup string</td>
</tr>
<tr>
<td><strong>Default Value:</strong></td>
<td>&lt;None&gt;</td>
</tr>
<tr>
<td><strong>Hardware Flow Control</strong></td>
<td>Indicates whether the serial connection to the printer uses hardware flow control.</td>
</tr>
<tr>
<td><strong>Possible Values:</strong></td>
<td>&lt;Enabled&gt; &lt;Disabled&gt;</td>
</tr>
<tr>
<td><strong>Default Value:</strong></td>
<td>&lt;Disabled&gt;</td>
</tr>
<tr>
<td><strong>Software Flow Control</strong></td>
<td>Indicates whether the serial connection to the printer uses software flow control.</td>
</tr>
<tr>
<td><strong>Possible Values:</strong></td>
<td>&lt;Enabled&gt; &lt;Disabled&gt;</td>
</tr>
<tr>
<td><strong>Default Value:</strong></td>
<td>&lt;Disabled&gt;</td>
</tr>
</tbody>
</table>
Appendix A: Using Microsoft ActiveSync

This section provides information about creating Microsoft ActiveSync connections between host systems and mobile devices.

Requirements

Before you create a Microsoft ActiveSync partnership, ensure that you have the following:

• Microsoft ActiveSync 3.7 (or better) installed on the host system
• Serial cable or USB cable to connect the host system to the mobile device
• Device cradle for the mobile device

Overview of Creating a Partnership

Creating a partnership involves the following tasks:

10 Select the ActiveSync method on the mobile device.
11 Select the ActiveSync method on the host system.
12 Free the COM port on the host system (serial connections only).
13 Create the partnership with the mobile device.

Selecting the Microsoft ActiveSync Connection Method on the Mobile Device

Most mobile devices allow Microsoft ActiveSync connections over a serial or USB connection. Before you can establish a Microsoft ActiveSync partnership, you must select the connection method (serial or USB) on the mobile device.

To select the Microsoft ActiveSync connection method on the mobile device:

1 On the mobile device, launch Microsoft ActiveSync.
2 From the Microsoft ActiveSync Tools menu, select Options.
NOTE The Options option is only available when the mobile device is not engaged in an active partnership with a host system.

The PC Synchronization dialog box appears.

3 In the PC tab of the PC Synchronization dialog box, enable the Sync with this PC during manual sync checkbox.

4 Click Options....

The PC Synchronization Options dialog box appears.

5 Enable the Enable PC sync using this connection checkbox.

6 From the Enable PC sync using this connection menu list, select the connection method.

   • If you are using a USB cable to connect the host system and the mobile device, then select USB Default.

   • If you are using a serial cable to connect the host system and the mobile device, select the appropriate baud rate.

7 Click OK.

The PC Synchronization Options dialog box closes.

8 Click OK.

The PC Synchronization dialog box closes and you are returned to the Microsoft ActiveSync interface.

The mobile device is now configured with the correct synchronization method.

Selecting the Microsoft ActiveSync Method on the Host System

Use the Microsoft ActiveSync interface on the host system to configure the connection method (USB or serial).
To configure the connection method on the host system:

1. On the host system, launch Microsoft ActiveSync.

2. From the Microsoft ActiveSync File menu, select Connection Settings....

   The Connection Settings dialog box appears.

3. Use the Connection Settings dialog box to configure the connection method between the host system and the mobile device:
   
   - If you are using a USB connection, then enable the Allow USB connection with this desktop computer checkbox.
   
   - If you are using a serial connection, then enable the Allow serial or infrared connection to this COM port checkbox, and then use the corresponding menu list to select the COM port that you are using.

Figure A-1 provides an example.
Figure A-1. Selecting the Connection Method on the Host System

4 Click **OK**.

The Connection Settings dialog box closes and you are returned to the Microsoft ActiveSync interface.

The host system is now configured with the correct Microsoft ActiveSync connection method.
Freeing a COM Port

If you are using a serial cable to connect the host system and the mobile device, you may need to ensure that the COM port to which you connect the serial cable is available for Microsoft ActiveSync to use.

Applications, including Microsoft ActiveSync, contend for “ownership” or exclusive use of the COM ports on the host system. Before you attempt to create a partnership, ensure that no other applications are using the COM port through which you will establish the partnership with the mobile device.

To free the COM port for Microsoft ActiveSync, shut down the application or stop the service that has control of the COM port.

For example, if you have installed Avalanche Manager on the host system and have used Avalanche Manager to perform serial updates on the mobile device, then Avalanche Manager may have exclusive control of the COM ports on the host system. To free the COM port(s), access the Services administrative tool on the host system and stop the Wavelink Avalanche Manager service.

Creating a Partnership

Microsoft ActiveSync uses two types of partnerships:

- **Standard.** A standard partnership allows you to synchronize data (for example, scheduling information) between the host system and the mobile device. Additionally, when you create a standard partnership, you do not have to recreate the partnership each time you reconnect the host system and the mobile device, which is the case with guest partnerships.

- **Guest.** A guest partnership does not synchronize data between the host system and the mobile device, but it requires less setup time than a standard partnership. However, because no synchronization takes place, you must re-establish a partnership each time you reconnect the host system and the mobile device.

You may use either a standard or guest partnership to install the TelnetCE Client and to download TelnetCE Client configurations to the mobile device.
Creating a Standard Partnership

You may use a standard partnership to install the TelnetCE Client and
download TelnetCE Client configurations to the mobile device.

A standard partnership synchronizes data and settings between the host
system and the mobile device.

To create a standard Microsoft ActiveSync partnership:
1 Connect the mobile device to the host system with a serial or USB cable.
2 On the mobile device, ensure that you have selected the correct connection
   method.

NOTE For more information about selecting the connection method, see
Selecting the Microsoft ActiveSync Connection Method on the Mobile Device on
page 187.

3 On the host system, ensure that you have enabled the correct connection
   method.

NOTE For more information about configuring the connection method on the
host system, see Selecting the Microsoft ActiveSync Method on the Host System
on page 188.

4 If you are using a serial port to connect to the mobile device, ensure that
   the serial port on the host system is free for Microsoft ActiveSync to use.

NOTE For more information about freeing a COM port on the host system, see
Freeing a COM Port on page 191.

5 On the host system, launch Microsoft ActiveSync.

6 From the Microsoft ActiveSync File menu, select Get Connected....
   The Get Connected dialog box appears (Figure A-2).
7 Click Next.

Microsoft ActiveSync attempts to communicate with the mobile device.

Once Microsoft ActiveSync establishes a connection with the mobile device, the New Partnership dialog box appears.

8 In the New Partnership dialog box, enable the Standard Partnership option.

9 Click Next.

The Specify how to synchronize data dialog box appears (Figure A-3).
In the Specify How to Synchronize Data dialog box, enable the synchronization option that you want to use.

11 Click Next.

The Select Synchronization Settings dialog box appears.

12 In the Select Synchronization Settings dialog box, enable the checkboxes the components that you want to synchronize between the host system and the mobile device.

**NOTE** You do not have to synchronize any data types to install the TelnetCE Client and download TelnetCE Client configurations to the mobile device.

Figure A-4 shows the Select Synchronization Settings dialog box.
13 Click Next.

The Setup Complete dialog box appears.

14 Click Finish.

Microsoft ActiveSync indicates that the mobile device and the host system are connected and synchronized (Figure A-5).
The standard partnership is complete. You are now able to disconnect and re-connect the mobile device to the host system without having to re-create the partnership.

**Creating a Guest Partnership**

You may use a guest partnership to install the TelnetCE Client and download TelnetCE Client configurations to the mobile device.

**To create a guest partnership:**

1. Connect the mobile device to the host system with a serial or USB cable.
2. On the mobile device, ensure that you have selected the correct connection method.
3 On the host system ensure that you have selected the correct connection method.

**NOTE** For more information about selecting the connection method, see Selecting the Microsoft ActiveSync Connection Method on the Mobile Device on page 187.

4 If you are using a serial port to connect to the mobile device, ensure that the serial port on the host system is free for Microsoft ActiveSync to use.

**NOTE** For more information about freeing a COM port on the host system, see Freeing a COM Port on page 191.

5 On the host system, launch Microsoft ActiveSync.

6 From the Microsoft ActiveSync **File** menu, select **Get Connected**.

The **Get Connected** dialog box appears (Figure A-6).
7 Click Next.

Microsoft ActiveSync attempts to communicate with the mobile device.

Once Microsoft ActiveSync establishes a connection with the mobile device, the New Partnership dialog box appears.

8 In the New Partnership dialog box, select the Guest Partnership option.

9 Click Next.

Microsoft ActiveSync indicates that the guest partnership has been created (Figure A-7).
Figure A-7. Microsoft ActiveSync Guest Partnership
Appendix B: Common Configuration Tasks

This section provides information about where to locate and configure common parameters for the TelnetCE Client, including:

- Passwords
- Number of concurrent sessions
- IP printing
- License server IP address
- Display settings
- Lockdown
- Key Macros
- Screen Panning
- ActiveText
- Scan Handlers
- Autologin for VT emulation
- Telnet negotiation strings for VT emulation
- Workstation IDs for 5250/3270 emulation
- Battery power and signal strength indicators

Configuring Passwords

Certain components of the TelnetCE Client are password protected. Users at the mobile device must supply a password to perform the following functions:

- Manually configure host profiles
- Manually configure per-host emulation parameters
• Exit the TelnetCE Client

**NOTE** By default, an exit password is not configured. If an exit password is not configured, users are not prompted for a password when they choose to exit the TelnetCE Client application.

Table B-1 provides information about and describes where each of these parameters can be configured in host profiles.

<table>
<thead>
<tr>
<th>Function</th>
<th>Location in Configuration Manager</th>
<th>Parameter Name</th>
<th>Default Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure Host Profiles</td>
<td>Emulation &gt; Common</td>
<td>RF Config Password</td>
<td>SYSTEM</td>
</tr>
<tr>
<td>Configure Per-Host Emulation Parameters</td>
<td>Emulation &gt; Common</td>
<td>Term Config Password</td>
<td>CONFIG</td>
</tr>
<tr>
<td>Exit TelnetCE Client</td>
<td>Emulation &gt; Common</td>
<td>Program Exit Password</td>
<td>&lt;None&gt;</td>
</tr>
</tbody>
</table>

**Table B-1: Configuring TelnetCE Client Passwords**

**To configure a password:**

1. Access the Configuration Manager.

2. In the Configuration Manager, locate the password parameter (see Table B-1) that you want to modify.

3. Use the dialog box for the password parameter to configure the password (Figure B-1).

![Figure B-1. Configuring the Terminal Configuration Passwords](image-url)
4  Click OK.

5  Save the new configuration.

6  Close the Configuration Manager and download the new configuration to the mobile device.

**NOTE** For more information about using the Configuration Manager, see Chapter 4: Emulation Parameters on page 55.

### Configuring the Number of Concurrent Sessions

The TelnetCE Client allows up to four concurrent Telnet sessions. However, by default, the TelnetCE Client is configured to allow a user to initiate and maintain one session. Use the Configuration Manager to specify the number of concurrent Telnet sessions that the TelnetCE Client should support.

**To modify the maximum number of concurrent sessions:**

1  Access the Configuration Manager.

2  Locate the Emulation > Common > Number of Sessions parameter.

3  Use the Number of Sessions dialog box to specify the maximum number of sessions (Figure B-2).

![Number of Sessions dialog box](image)

**Figure B-2. Modifying the Maximum Number of Concurrent Sessions**

4  Click OK.

5  Save the new configuration.
6 Close the Configuration Manager and download the new configuration to the mobile device.

NOTE For more information about using the Configuration Manager, see Chapter 4: Emulation Parameters on page 55.

### Configuring IP Printing

Most mobile devices do not use a printer that is directly connected. Instead, mobile devices print over the network via IP.

Use the Configuration Manager to configure mobile devices for IP printing.

**To configure the TelnetCE Client for IP printing:**

1. Access the Configuration Manager.

2. In the Configuration Manager, locate the **Emulation > Printing > Printer Protocol** parameter.

3. In the **Printer Protocol** dialog box, select **TCPIP** (Figure B-3).

![Printer Protocol dialog box](image)

**Figure B-3. Configuring Mobile Devices for IP Printing**

4. Click **OK**.

5. Save the new configuration.

6. Close the Configuration Manager and download the new configuration to the mobile device.
NOTE For more information about using the Configuration Manager, see *Chapter 4: Emulation Parameters* on page 55.

**Configuring License Server IP Address**

The TelnetCE Client requires a valid license for full functionality. You can configure a license at the mobile device manually, or you can configure the client to obtain a license from a license server on the network.

A mobile device will automatically find the license server on the local IP subnet. However, if your license server is located on another subnet, you will need to configure the mobile device with the IP address of the license server.

Use the Configuration Manager to configure the license server IP address.

**To configure the IP address of a remote license server:**

1. Access the Configuration Manager.

2. In the Configuration Manager, locate the Emulation > Common > License Server Address parameter.

3. Use the *License Server Address* dialog box to configure the IP address of the license server (Figure B-4).

![License Server Address Dialog Box](image_url)

*Figure B-4. Configuring the License Server IP Address*

4. Click **OK**.

5. Save the new configuration.

6. Close the Configuration Manager and download the new configuration to the mobile device.
NOTE For more information about using the Configuration Manager, see Chapter 4: Emulation Parameters on page 55.

Configuring TelnetCE Client Display Settings

You can modify and customize the way that the TelnetCE Client displays, including:

- Whether the Windows Start menu displays while the TelnetCE Client is active.

- Whether the TelnetCE Client menu displays while the TelnetCE Client is engaged in a Telnet session.

- Whether the vertical or horizontal scrollbars display during an active Telnet session.

Use the Configuration Manager to customize these (and other) display features of the TelnetCE Client.

Table B-2 provides a list of display options and the parameters (in the Configuration Manager) that are used to customize these options.

<table>
<thead>
<tr>
<th>Display Option</th>
<th>Location in the Configuration Manager</th>
<th>Parameter Name</th>
<th>Default Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide Windows Start Menu</td>
<td>Emulation &gt; Display</td>
<td>WinCE Hide Start Menu</td>
<td>&lt;Show Standard Start Menu&gt;</td>
</tr>
<tr>
<td>Hide TelnetCE Client Menu</td>
<td>Emulation &gt; Display</td>
<td>WinCE Hide Menu</td>
<td>&lt;No&gt;</td>
</tr>
<tr>
<td>Hide the TelnetCE Client Vertical Scrollbar</td>
<td>Emulation &gt; Display</td>
<td>WinCE Hide Vertical Scrollbar</td>
<td>&lt;Yes&gt;</td>
</tr>
<tr>
<td>Hide the TelnetCE Client Horizontal Scrollbar</td>
<td>Emulation &gt; Display</td>
<td>WinCE Hide Horizontal Scrollbar</td>
<td>&lt;Yes&gt;</td>
</tr>
<tr>
<td>Create a Key Sequence to Hide/Reveal the TelnetCE Client command bar</td>
<td>Emulation &gt; Display</td>
<td>WinCE Menu Toggle Key</td>
<td>&lt;Default&gt; (No key sequence configured)</td>
</tr>
</tbody>
</table>

Table B-2: Customizing the TelnetCE Client Display
Appendix B: Common Configuration Tasks

To configure a display setting:

1. Access the Configuration Manager.

2. In the Configuration Manager, locate the display option that you want to modify (see Table B-2).

3. Use the dialog box for the parameter to configure the display option (Figure B-5).

4. Click OK.

5. Save the new configuration.

6. Close the Configuration Manager and download the new configuration to the mobile device.

**NOTE** For more information about using the Configuration Manager, see Chapter 4: Emulation Parameters on page 55.

<table>
<thead>
<tr>
<th>Display Option</th>
<th>Location in the Configuration Manager</th>
<th>Parameter Name</th>
<th>Default Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specify the Font that Emulation Uses</td>
<td>Emulation &gt; Display</td>
<td>WinCE Font Name</td>
<td>&lt;Standard&gt;</td>
</tr>
<tr>
<td>Specify the Font Size that Emulation Uses</td>
<td>Emulation &gt; Display</td>
<td>WinCE Font Size</td>
<td>&lt;7&gt;</td>
</tr>
</tbody>
</table>

Table B-2: Customizing the TelnetCE Client Display

Figure B-5. Configuring the TelnetCE Client to Hide the Windows Start Menu
Configuring TelnetCE Client Lockdown

You can configure several TelnetCE Client parameters to effectively lockdown the TelnetCE Client and prevent users at the mobile device from launching other applications on the mobile device.

NOTE When you configure TelnetCE Client lockdown, record your passwords and key sequences in a secure location for administrative purposes. By configuring lockdown, you can effectively lock yourself out of the mobile device. If you forget the passwords that you have configured, you will be required to reboot the system and reconfigure the TelnetCE Client.

Use the Configuration Manager to lockdown the mobile device.

Table B-3 lists the parameters in the Configuration Manager that you must use to effectively lockdown the TelnetCE Client.

<table>
<thead>
<tr>
<th>Parameter to Modify</th>
<th>Location in the Configuration Manager</th>
<th>Parameter Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>WinCE Hide Start Menu</td>
<td>Emulation &gt; Display</td>
<td>&lt;Hide Start Menu&gt;</td>
</tr>
<tr>
<td>WinCE Hide Menu*</td>
<td>Emulation &gt; Display</td>
<td>&lt;Yes&gt;</td>
</tr>
<tr>
<td>WinCE Menu Toggle Key*</td>
<td>Emulation &gt; Display</td>
<td>Do not configure a toggle key (by default, no toggle key is configured)</td>
</tr>
<tr>
<td>RF Config Password</td>
<td>Emulation &gt; Common</td>
<td>Configure a secure password</td>
</tr>
<tr>
<td>Term Config Password</td>
<td>Emulation &gt; Common</td>
<td>Configure a secure password</td>
</tr>
<tr>
<td>Program Exit Password</td>
<td>Emulation &gt; Common</td>
<td>Configure a secure password</td>
</tr>
<tr>
<td>Program Exit Key</td>
<td>Emulation &gt; Common</td>
<td>Configure an exit key</td>
</tr>
</tbody>
</table>

* Hiding and preventing access to the TelnetCE Client is not mandatory to locking down the TelnetCE Client, but provides an additional layer of security.

Table B-3: Configuring TelnetCE Client Lockdown

To configure TelnetCE Client lockdown:

1. Access the Configuration Manager.

2. In the Configuration Manager, modify the lockdown parameters (see Table B-3).
Figure B-6 provides an example.

![WinCE Hide Menu](image)

**Figure B-6. Configuring One of the Parameters for Lockdown**

3 Save the new configuration.

4 Close the Configuration Manager and download the new configuration to the mobile device.

---

**NOTE** For more information about using the Configuration Manager, see Chapter 4: Emulation Parameters on page 55.

---

**Configuring Key Macros**

Use the Configuration Manager to create, configure, or remove key macros for emulation.

**To configure a key macro:**

1 Access the Configuration Manager.

2 In the Configuration Manager, locate and right-click the **Emulation > Common > Key Macro** parameter.

   A menu list appears.

3 From the menu list, select **Add**.

   The **Key Macros** dialog box appears.

4 Use the **Key Macros** dialog box to configure the new key macro (Figure B-7).
5 After you have configured the key macro, click **OK**.

The new key macro now appears beneath the **Key Macros** parameters in the Configuration Manager (Figure B-8).

6 Save the new configuration.

7 Close the Configuration Manager.

8 Download the new configuration to the mobile device.

**NOTE** For more information about modifying configuration parameters and using the Configuration Manager, see *Chapter 4: Emulation Parameters* on page 55.
Configuring Screen Panning

Use the Configuration Manager to configure TelnetCE Client screen panning.

The screen panning feature of the TelnetCE Client allows a user to scroll around the screen by tapping and dragging the stylus. By default, screen panning is enabled on the TelnetCE Client.

Screen panning has two methods of operation:

- Standard
- Reversed

If you want to use reverse screen panning, you must enable standard screen panning.

To configure screen panning:
1. Access the Configuration Manager.

2. In the Configuration Manager, locate and right-click Emulation > Display > Screen Panning. The Screen Panning dialog box appears.

3. Use the Screen Panning dialog box to enable or disable screen panning for the TelnetCE Client (Figure B-9).

![Screen Panning Dialog Box]

Figure B-9. Configuring Screen Panning

4. Click OK.

5. If you want to enable/disable reverse screen panning, locate and right-click Emulation > Display > Screen Panning Reversed parameters. The Screen Panning Reversed dialog box appears.
6 Use the Screen Panning Reversed dialog box to enable or disable reverse screen panning.

**NOTE** For reverse screen panning to work, you must also enable screen panning.

7 Click OK.

8 Save the new configuration.

9 Close the Configuration Manager.

10 Download the new configuration to the mobile device.

**NOTE** For more information about modifying configuration parameters and using the Configuration Manager, see Chapter 4: Emulation Parameters on page 55.

**Configuring ActiveText**

Use the Configuration Manager to configure the ActiveText feature of the TelnetCE Client.

The ActiveText feature of the TelnetCE Client identifies certain strings of text and converts them to objects that a user can select-and-click.

The ActiveText feature can identify two types of strings:

- Simple menu item
- AS/400-style function key

By default, both types of ActiveText are enabled on the TelnetCE Client.
Table B-4 indicates the parameters in Configuration Manager that control the different types of ActiveText.

<table>
<thead>
<tr>
<th>ActiveText Type</th>
<th>Configuration Manager Parameter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple Menu Item</td>
<td>Emulation &gt; Common &gt; Simple Number Menu Active Text</td>
</tr>
<tr>
<td>AS/400-Style Function Key</td>
<td>Emulation &gt; Common &gt; Function Key Active Menu</td>
</tr>
</tbody>
</table>

Table B-4: ActiveText Parameters in Configuration Manager

**To configure ActiveText:**

1. Access the Configuration Manager.

2. In the Configuration Manager, locate and right-click the parameter for the type of ActiveText that you want to configure (see Table B-4).

   A dialog box for the ActiveText type appears.

3. Use the dialog box to enable or disable the ActiveText (Figure B-10).

   ![Function Key Active Menu](image)

   *Figure B-10. Configuring ActiveText*

4. Click OK.

5. Save the new configuration.

6. Close the Configuration Manager.

7. Download the new configuration to the mobile device.

**NOTE** For more information about modifying configuration parameters and using the Configuration Manager, see *Chapter 4: Emulation Parameters* on page 55.
Configuring Scan Handlers

Use the Configuration Manager to configure scan handlers.

Scan handlers allow you to define special functions that are applied to the processing of a scan. A scan handler allows you to strip data from the beginning or end of a scan and/or to replace certain characters within a scan.

To configure a scan handler:

1. Access the Configuration Manager.

2. In Configuration Manager, locate and right-click the Scanner > Common > Scan Handler parameter.

   A menu list appears.

3. Click Add.

   The Scan Handler dialog box appears.

4. Use the Scan Handler dialog box to configure a new scan handler (Figure B-11).

![Scan Handler Dialog Box]

Figure B-11. Configuring a Scan Handler

5. Click OK.

6. The new scan handler now appears beneath the Scan Handler parameter in the Configuration Manager (Figure B-12.).
7 Save the new configuration.

8 Close the Configuration Manager.

9 Download the new configuration to the mobile device.

NOTE For more information about modifying configuration parameters and using the Configuration Manager, see Chapter 4: Emulation Parameters on page 55.

**Configuring Autologin for VT Emulation**

You can configure the mobile device to send automatic responses to prompts from a host. This allows for automatic login for VT/HP emulation.

Because autologin is specific to each host system, autologin is configured in the Host Profiles dialog box.
To configure a mobile device for automatic login to a host:

1. Access the Host Profiles dialog box.

2. From the list of host profiles in the Host Profiles dialog box, select the host for which you want to configure autologin parameters.

3. Ensure that you have selected a VT-type or HP emulation type from the Emulation drop-down menu in the Host tab of the Host Profiles dialog box. (If you have not selected VT/HP emulation, you will not be able to configure an autologin.)

4. Select the Autologin tab.

5. Configure the Autologin tab (Figure B-13).

![Host Profiles dialog box](image)

**Figure B-13. Configuring VT Autologin**

**NOTE** For information about the parameters in the Autologin tab, see Chapter 3: Host Profiles on page 25.

6. After you have configured the Autologin tab, click **OK**.

7. Download the new configuration to the mobile device.
Configuring Telnet Negotiation Strings for VT Emulation

A Telnet negotiation string is used to identify a mobile device to a host system and to present a client with the appropriate emulation options.

Because Telnet negotiation strings are host specific, they configured in the Host Profiles dialog box.

To configure a Telnet negotiation string:

1. Access the Host Profiles dialog box.

2. From the list of host profiles in the Host Profiles dialog box, select the host for which you want to configure the Telnet negotiation string.

3. Ensure that you have selected a VT-type or HP emulation type from the Type drop-down list in the Host tab of the Host Profiles dialog box. (If you have not selected VT/HP emulation, you will not be able to configure a Telnet negotiation string.)

4. In the Host Profiles dialog box, select the VT Settings tab.

5. In the Telnet Negotiation String text box, configure the Telnet negotiation string that the mobile device should use when connecting to the host system (Figure B-14).
6 Click OK.

7 Download the new configuration to the mobile device.

**NOTE** For more information about configuring host profiles, see *Chapter 3: Host Profiles* on page 25.

### Configuring Workstation IDs for 5250/3270 Emulation

The TelnetCE Client allows you to dynamically generate a workstation ID for a mobile device. Because workstation IDs are specific to each host connection, workstation IDs are configured in the *Host Profiles* dialog box.

**To configure the TelnetCE Client to dynamically generate a workstation ID:**

1 Access the *Host Profiles* dialog box.

2 From the list of host profiles in the *Host Profiles* dialog box, select the host connection for which you want to configure a workstation ID.
3 Ensure that you have selected 5250/3270 emulation from the **Type** dropdown list in the Host tab. (If you have not selected a 5250/3270 emulation type, you will not be able to configure a workstation ID.)

4 Select the IBM Settings tab.

5 Use the **Workstation ID** text box to configure the dynamic generation of a workstation ID for mobile devices that use the host profile (Figure B-15).

![Host Profiles](image)

**Figure B-15. Configuring the Workstation ID**

6 Click **OK**.

   The new configuration is saved to the host system and the **Host Profiles** dialog box closes.

7 Download the new configuration to the mobile device.

**NOTE** For more information about configuring host profiles, see Chapter 3: **Host Profiles** on page 25.
Enabling Battery Strength and Signal Strength Icons

Battery-strength and wireless signal-strength indicator icons are available in TelnetCE Client 5.1 (and greater versions). You may configure the following indicator-icon settings:

- Whether to display the signal strength icon
- Whether to display the batter power icon
- Whether to display the icon(s) on the Windows system tray, the TelnetCE Client command bar, or elsewhere on the screen
- The relative size (large or small) of the icon(s)

To enable the battery power indicator:

1. Access the Configuration Manager for the TelnetCE Client global emulation parameters.

2. In Configuration Manager, locate Emulation > Display > Indicators (Figure B-16).
3 Use the **Enable Battery Strength Indicator** parameter to enable/disable the battery strength indicator icon.

4 Use the **Enable Signal Strength Indicator** parameter to enable/disable the wireless signal strength indicator.

5 Use the **Indicators Preferred Off-Screen** parameter to configure where the icon(s) are displayed (the Windows system tray, the TelnetCE Client command bar, or on the screen itself).

6 If you did not use the **Indicators Preferred Off-Screen** parameter to display icons only in the Windows system tray or TelnetCE Client command bar, then use the **Indicators Screen Settings** parameter to configure the location and relative size (large or small) of the indicator icon(s) on the screen.
7 Save the new configuration.

8 Close the Configuration Manager.

9 Download the new configuration to the mobile device.

NOTE For more information about configuring global emulation parameters, see Chapter 4: Emulation Parameters on page 55.

Configuring Indicator Settings

Table B-5 provides information about configuring the indicator settings to meet your needs:

<table>
<thead>
<tr>
<th>Desired Effect</th>
<th>Parameter in Configuration Manager</th>
<th>Setting</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display icon(s) in Windows task-tray only</td>
<td>Emulation &gt; Display &gt; Indicators &gt; Indicators Preferred Off-Screen</td>
<td>&lt;System Tray Only&gt;</td>
<td>Do not hide the Windows start menu</td>
</tr>
<tr>
<td>Display icon(s) in TelnetCE Client command bar only</td>
<td>Emulation &gt; Display &gt; Indicators &gt; Indicators Preferred Off-Screen</td>
<td>&lt;Command Bar Only&gt;</td>
<td>Do not hide the TelnetCE Client command bar</td>
</tr>
<tr>
<td>Display icon(s) in TelnetCE Client command bar or Windows system tray (whichever is available, starting with the Windows system tray)</td>
<td>Emulation &gt; Display &gt; Indicators &gt; Indicators Preferred Off-Screen</td>
<td>&lt;Command Bar or System Tray&gt;</td>
<td>—</td>
</tr>
<tr>
<td>Display icon(s) on emulation screen (not in the command bar or the system tray)</td>
<td>Emulation &gt; Display &gt; Indicators &gt; Indicators Preferred Off-Screen</td>
<td>&lt;No&gt;</td>
<td>—</td>
</tr>
<tr>
<td>Specify location and size of icons</td>
<td>Emulation &gt; Display &gt; Indicators &gt; Indicators Screen Settings</td>
<td>Select your preferred option for location and size</td>
<td>Set Indicators Preferred Off-Screen to No</td>
</tr>
</tbody>
</table>

Table B-5: Configuring Battery and Signal Strength Indicators
Appendix C: Using the TelnetCE Client License Server

This section provides the following information:

- Overview of the TelnetCE Client license server
- Installing the TelnetCE Client license server
- Using the TelnetCE Client license server

TelnetCE Client License Server Overview

The TelnetCE Client license server is a Windows-based application that provides licenses to mobile devices that are using the TelnetCE Client.

NOTE The TelnetCE Client license server should not be confused with the Avalanche license server. They are separate applications.

The TelnetCE Client license server allows you to store licenses for TelnetCE Clients at a central location. Those licenses are then automatically distributed to mobile devices that request them.

TelnetCE Client licenses are distributed to mobile devices in the following manner:

1. When the TelnetCE Client application is first activated on a mobile device, the mobile device broadcasts a request for a license.

2. The license server responds to the mobile device with a license.

3. The mobile device accepts a license and responds to the license server.

Once a TelnetCE Client obtains a license, it keeps the license until one of the following criteria are met:

- The license expires.
- The TelnetCE Client discovers that another mobile device is using the same license.
When either of these criteria are met, the TelnetCE Client discards the license and requests a new license from the license server.

**NOTE** You can also configure the TelnetCE Client to request a license from a license server on a remote network. For more information about configuring the TelnetCE Client to request a license from a specific license server, see Configuring License Server IP Address on page 205.

**License Server Versions and Maintenance Licenses**

Currently, two versions of license server are available: version 1.0 and version 2.0. Version 1.0 does not support TelnetCE Client maintenance licenses or 5.0 (or greater) platform licenses.

If you will be using a license server to distribute 5.0 (or greater) platform licenses or maintenance licenses, please contact Wavelink customer service to obtain the latest version of license server.

**NOTE** Appendix D: Wavelink Contact Information on page 233 contains Wavelink contact information.

**To see which version of license server you have:**

1. Launch the license server application.

2. Right-click the title bar of the license server window.

   A menu list appears.

3. **Select** About License Server....

   The About License Server dialog box appears (Figure C-1).
The About License Server dialog box displays the license server version number.

### Installing the TelnetCE Client License Server

This section provides information about installing the TelnetCE Client license server as a basic Windows application or as a dedicated Windows service.

#### Installation Methods

You may use one of the following methods to install the TelnetCE Client license server:

- **Windows Application.** When you use this method, the TelnetCE Client license server runs as a basic application on the host system. If you reboot the host system, you must manually re-launch the license server.

- **Windows Service.** When you use this method, you configure the TelnetCE Client to run as a dedicated Windows service on the host system. This allows you to automatically restart the license server in the event that the host system must be rebooted. It also allows the license server to operate without requiring a Windows login.

#### Installing the License Server as a Windows Application

You can install the TelnetCE Client as a basic Windows application. In the event that the host system is rebooted, you must manually relaunch the license server application on the host system.
Installation Requirements

Ensure that the system on which you will install the TelnetCE Client license server meets the following specifications:

- Microsoft Windows 2000/XP
- 1MB hard disk space
- Network connection that provides bi-directional communication with TelnetCE Clients that will receive licenses from the license server.

Installing the License Server

The TelnetCE Client license server is a simple executable that should be transferred to the host system.

To install the license server:

1. Obtain the LicenseServer.exe file.

   NOTE For information about obtaining client licenses and the TelnetCE Client license server, contact Wavelink Corporation or your Wavelink representative. Appendix D: Wavelink Contact Information on page 233 contains Wavelink contact information.

2. Copy LicenseServer.exe to an accessible location on the host system.

   NOTE You may want to create a shortcut to LicenseServer.exe on the desktop of the host system.

3. Double-click LicenseServer.exe to begin running the TelnetCE Client license server.

   The license server interface appears.

   NOTE For information about using the license server, see Using the License Server on page 227.
Installing License Server as a Windows Service

It is possible to create a dedicated Windows service from the LicenseServer.exe file.

To create a license server service, you will need the Service Installer application that is included in the Microsoft Windows 2000 Resource Kit.

Because creating the license server service requires you to modify Windows registry settings, the exact process that is required is not detailed in this document. Please work directly with Microsoft to configure the license server to run as a dedicated Windows service.

Using the License Server

This section provides information about using the TelnetCE Client license server, including:

• Launching the license server.
• Adding a license to the license server.
• Removing a license from the license server.
• Releasing a license.
• Viewing license information.

Launching the License Server

To launch the license server and access the GUI that will allow you to add, remove, and view licenses, execute LicenseServer.exe.

When you launch LicenseServer.exe, the License Server GUI appears (Figure C-2).
The following is a list of notes about running the license server.

- Only one instance of a license server may be running on the network. If you launch the license server and another license server is running, you will receive an error message.

- If you are running the license server as a Windows service, stop the service before you launch_licenseServer.exe.

**Adding a License**

Add a license to the license server that the license server can then distribute to mobile devices running the TelnetCE Client.

**To add a license to license server:**

1. Launch the license server.
   
   The license server GUI appears.

2. Click Add Licenses.
The *Wavelink Authorization* dialog box appears (Figure C-3).

![Figure C-3. Wavelink Authorization Dialog Box](image)

3 In the Wavelink Authorization dialog box, input the information for the license, where:

- **Licensee Name** is the name of the party to which the license was distributed.
- **Platform Version** is the list of emulation types that the license supports. (The platform version is case sensitive.)
- **Serial Number** is the serial number of the license.
- **User Limit** is the number of users that the license supports.
- **Expiration Date** is the expiration date of the license in the format MMDDYYYY.
- **Authorization Code** is the authorization code for the license.

4 After you have input the license information, click **Add**.

A dialog box appears that indicates that the license was successfully added as shown.

5 Click **OK**.

6 Click **Close** to exit the *Wavelink Authorization* dialog box.
The license now appears in the license server GUI.

7 Expand the license to view how many of the user spaces in the license have been taken.

Licenses that have been taken display the MAC address of the mobile device that acquired the license.

**Releasing a License**

You can use the license server GUI to free up a license. This does not immediately force the client that holds the license to release that license. Instead, it frees the license for the license server to distribute to another mobile device. You should make sure that the mobile device that previously acquired the license is not operating on the network.

**To release a license:**

1 Access the license server GUI.

2 Locate the license that you want to release.

3 Click **Release License**.

   The **LicenseServer** dialog box appears.

4 Click **Yes**.

   The license server GUI now indicates that the client license is unassigned and can be distributed to another mobile device.

**Viewing License Information**

You can use the license server GUI to view information about a license.

**To view information about a license:**

1 Access the license server GUI.

2 From the list of installed licenses, select the license that you want to view.

3 Click **View License**.

   The **View License** dialog box appears and displays the details of the license.
4  Click Close to close the View License dialog box.

Removing a License

If a license is no longer valid, you may remove it from license server.

To remove a license from license server:
1  Access the license server GUI.

2  From the list of licenses that are installed, select the license that you want to remove.

3  Click Remove License.

   The LicenseServer dialog box appears and requests confirmation of the deletion.

4  Click Yes.

   The license is deleted from the license server and removed from the license server GUI.
Appendix D: Wavelink Contact Information

If you have comments or questions regarding this product, please contact Wavelink Customer Service via email or telephone.

Email: customerservice@wavelink.com

Phone: 425-823-0111
### Glossary

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>802.11/a/b</strong></td>
<td>The IEEE standards for wireless Ethernet. 802.11 provides for wireless networking speeds up to 2 Mbps at 2.4 GHz. 802.11b provides wireless networking speeds up to 11 Mbps at 2.4 GHz. 802.11a provides wireless networking speeds up to 54 Mbps at 5 GHz.</td>
</tr>
<tr>
<td><strong>access point</strong></td>
<td>A device that acts as a bridge between wireless LANs and wired LANs.</td>
</tr>
<tr>
<td><strong>ad hoc mode</strong></td>
<td>A mode of operation in wireless networks wherein wireless devices communicate directly with each other without the use of an access point. Also sometimes referred to as peer-to-peer mode or an independent basic service set (IBSS).</td>
</tr>
<tr>
<td><strong>Agent</strong></td>
<td>In the context of Avalanche Manager, an Avalanche Agent. See Avalanche Agent.</td>
</tr>
<tr>
<td><strong>AP</strong></td>
<td>Access Point. See Access Point.</td>
</tr>
<tr>
<td><strong>automatic WEP</strong></td>
<td>A dynamic implementation of WEP keys, wherein the key used on the wireless network changes periodically. Clients must synchronize their WEP key use with the AP.</td>
</tr>
<tr>
<td><strong>Avalanche Agent</strong></td>
<td>An Avalanche Manager Agent. A software component that provides the core functionality of Avalanche Manager. The Agent facilitates communication with Avalanche clients.</td>
</tr>
<tr>
<td><strong>Avalanche Client</strong></td>
<td>A mobile device with an installed Avalanche Enabler, which allows the client to communicate with an Avalanche Agent and to be configured and managed through Avalanche Manager.</td>
</tr>
<tr>
<td><strong>Avalanche Enabler</strong></td>
<td>A software component that is installed on mobile devices which allows you to configure and manage the device through Avalanche Manager. The Enabler facilitates communication between the mobile device and an Agent.</td>
</tr>
<tr>
<td><strong>Avalanche Enabler SDK</strong></td>
<td>A software development kit that allows you to create Avalanche Enablers for Windows CE devices.</td>
</tr>
<tr>
<td>--------------------------</td>
<td>---------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Avalanche Management Console</strong></td>
<td>The GUI that allows you to interact with and configure Avalanche Agents.</td>
</tr>
<tr>
<td><strong>Avalanche Manager</strong></td>
<td>Wavelink Corporation's management application that allows you to configure and manage mobile devices throughout your network infrastructure.</td>
</tr>
<tr>
<td><strong>Avalanche Monitor</strong></td>
<td>A component of certain Avalanche Enablers that communicates with the Avalanche Agent and, at certain times, checks for available updates.</td>
</tr>
<tr>
<td><strong>Avalanche Update Utility</strong></td>
<td>A component of certain Avalanche Enablers that provides most of the functionality. You can use the Avalanche Update Utility to configure the network parameters of the mobile device, view the progress of a download, and/or install updates that have been downloaded to the client.</td>
</tr>
<tr>
<td><strong>Avalanche Software Package</strong></td>
<td>A specially bundled piece of software, for example a firmware update to a radio card or a commonly used application, that you can download to a client through Avalanche Manager.</td>
</tr>
<tr>
<td><strong>Avalanche Update</strong></td>
<td>A download (or modification) that is available to a client through Avalanche Manager. Examples of updates include software packages and network profiles. The deletion of orphaned packages from a client through Avalanche Manager is another type of update.</td>
</tr>
<tr>
<td><strong>BOOTP</strong></td>
<td>Bootstrap Protocol. A protocol that allows clients to automatically obtain IP parameters from a BOOTP server.</td>
</tr>
<tr>
<td><strong>client</strong></td>
<td>In the context of Avalanche Manager, an Avalanche client. See <em>Avalanche Client</em>. In the context of the TNCE Client, a mobile device that connects via the TNCE Client to a host system.</td>
</tr>
<tr>
<td><strong>DHCP</strong></td>
<td>Dynamic Host Configuration Protocol. An IP service that allows DHCP clients to automatically obtain IP parameters from a DHCP server.</td>
</tr>
<tr>
<td><strong>DNS</strong></td>
<td>Domain Name System. A service that provides host name-to-IP address mapping.</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td><strong>.edf</strong></td>
<td>Enabler Definition File</td>
</tr>
<tr>
<td><strong>Emulation Parameters</strong></td>
<td>A feature of the TNCE Client that allows you to pre-configure and install terminal emulation-related functions to a mobile device.</td>
</tr>
<tr>
<td><strong>Emulation Parameters, global</strong></td>
<td>Terminal emulation-related functions that apply to all host profiles that are configured on a mobile device.</td>
</tr>
<tr>
<td><strong>Emulation Parameters, host specific</strong></td>
<td>Terminal emulation-related functions that apply to only a specific host profile that is configured on a mobile device.</td>
</tr>
<tr>
<td><strong>Enabler</strong></td>
<td>In the context of Avalanche Manager, an Avalanche Enabler. See <em>Avalanche Enabler</em>.</td>
</tr>
<tr>
<td><strong>Enabler Configuration Utility</strong></td>
<td>A software package that allows you to configure the various Avalanche Windows Enabler settings on a client from the Avalanche Management Console. (Specific to the Windows Enabler.)</td>
</tr>
<tr>
<td><strong>Enabler Profile</strong></td>
<td>In the context of the Avalanche Enabler SDK, a set of parameters that a developer specifies that are used by the Avalanche Enabler SDK to produce an Avalanche Enabler. The parameters of the profile are stored in an .edf file.</td>
</tr>
<tr>
<td><strong>Enabler SDK</strong></td>
<td>See <em>Avalanche Enabler SDK</em>.</td>
</tr>
<tr>
<td><strong>ESS ID</strong></td>
<td>Extended Service Set ID. The identifier of an extended service set for devices that are participating in an infrastructure mode wireless LAN.</td>
</tr>
<tr>
<td><strong>FTP</strong></td>
<td>File Transfer Protocol. A TCP-based service that provides connection-oriented file transfers.</td>
</tr>
<tr>
<td><strong>FTP Server</strong></td>
<td>A host system that provides FTP services. Users are required to log into the FTP service to gain access to files that can be downloaded from the server.</td>
</tr>
<tr>
<td><strong>term</strong></td>
<td><strong>definition</strong></td>
</tr>
<tr>
<td>---------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>gateway</td>
<td>A device on a local network through which data to other networks is routed. Also called a router.</td>
</tr>
<tr>
<td>GUI</td>
<td>Graphical User Interface</td>
</tr>
<tr>
<td>host</td>
<td>A server or workstation that hosts a specific software or network service.</td>
</tr>
<tr>
<td>host profile</td>
<td>A service of the TNCE Client that allows you to install pre-configured host information (such as IP address and Telnet service TCP port) on mobile devices.</td>
</tr>
<tr>
<td>IBSS</td>
<td>Independent Basic Service Set. See <em>ad hoc mode</em>.</td>
</tr>
<tr>
<td>ICMP</td>
<td>Internet Control Messaging Protocol. Part of the TCP/IP protocol suite that provides services for testing IP network connections.</td>
</tr>
<tr>
<td>infrastructure mode</td>
<td>A wireless network configuration wherein devices communicate with each other through an access point.</td>
</tr>
<tr>
<td>IP address</td>
<td>Internet Protocol address. A virtual address that uniquely identifies a network connection.</td>
</tr>
<tr>
<td>LAN</td>
<td>Local Area Network</td>
</tr>
<tr>
<td>lease</td>
<td>A DHCP lease. The parameters surrounding the IP address a client has obtained from a DHCP server.</td>
</tr>
<tr>
<td>localization</td>
<td>A service of the TNCE Client that allows you to configure the TNCE Client to display in a specific language.</td>
</tr>
<tr>
<td>MAC address</td>
<td>Media Access Controller address. The hard-coded layer-2 address of a network connection which consists of a 12-digit hexadecimal number. The first 6 hexadecimal characters identify the manufacturer. The last 6 hexadecimal numbers are unique for each network device produced by the manufacturer. The MAC address is also sometimes called the hardware address.</td>
</tr>
<tr>
<td><strong>Management Console</strong></td>
<td>In the context of Avalanche Manager, the Avalanche Management Console. See <em>Avalanche Management Console</em>.</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>MB</strong></td>
<td>Megabytes</td>
</tr>
<tr>
<td><strong>Mbps</strong></td>
<td>Megabits / second</td>
</tr>
<tr>
<td><strong>mobile device</strong></td>
<td>A wireless device or a PC with a wireless network connection.</td>
</tr>
<tr>
<td><strong>net mask</strong></td>
<td>See <em>subnet mask</em>.</td>
</tr>
<tr>
<td><strong>network profile</strong></td>
<td>A set of pre-configured network parameters (ESS ID, IP address, and so forth) that can be downloaded to a client through Avalanche Manager.</td>
</tr>
<tr>
<td><strong>orphaned package</strong></td>
<td>A software package that has been deployed to a client through Avalanche Manager, but has been disabled or is not recognized by the Agent. You must orphan a software package before you can use Avalanche Manager to delete it from the client.</td>
</tr>
<tr>
<td><strong>ping</strong></td>
<td>An IP service that is used to test IP connectivity. Part of the ICMP service.</td>
</tr>
<tr>
<td><strong>RAM</strong></td>
<td>Random Access Memory. Volatile memory in a computer system.</td>
</tr>
<tr>
<td><strong>real-time statistics</strong></td>
<td>A feature that allows the TelnetCE Client to send Telnet session information to Avalanche Manager. That information can then be viewed from the <em>Avalanche Client Controls</em> dialog box. The real-time statistics feature is only available for Avalanche-deployed TelnetCE Clients.</td>
</tr>
<tr>
<td><strong>RF</strong></td>
<td>Radio Frequency. Usually used in the context of a type of network connection.</td>
</tr>
<tr>
<td><strong>router</strong></td>
<td>See <em>gateway</em>.</td>
</tr>
<tr>
<td><strong>SDK</strong></td>
<td>Software Development Kit.</td>
</tr>
</tbody>
</table>
**selection criteria**  
A feature of Avalanche Manager that allows you to configure a set of filters that target specific mobile devices on the network. You can filter by MAC address, IP address, device type, operating system, and so forth. Selection criteria are used to target specific mobile devices on the network for Avalanche Updates.

**Session Monitor**  
An Avalanche-integrated component of the TelnetCE Client that allows a user at the Avalanche Management Console to monitor or control the TelnetCE Client. Session Monitor is available for Avalanche-deployed TelnetCE Clients only.

**silent install**  
A feature of the Avalanche Enabler that allows for the installation of software packages on clients without the consent of the user at the client.

**silent mode**  
A feature of the Avalanche Enabler that allows the Avalanche Monitor to run in the background on the client in a manner that is transparent to the user at the client.

**software package**  
In the context of Avalanche Manager, an Avalanche software package. See *Avalanche Software Package*.

**SSID**  
Service Set Identifier. A unique name, up to 32 characters long, that is used to identify a wireless LAN. The SSID is attached to wireless packets and acts as a password to connect to a specific BSS or ESS.

**static WEP**  
Static (or manual) implementation of WEP keys. When the administrator of the network changes the WEP key, users must manually select the correct key.

**subnet**  
A logical network wherein each client is participating on the same IP network.

**subnet mask**  
A type of filter that allows IP clients to determine which part of their IP address defines the network and which part defines the host.
| **TCP/IP** | Transmission Control Protocol/Internet Protocol. A suite of protocols that provides virtual addressing, connection-oriented and connectionless communication, and a number of other network services and utilities. |
| **Telnet** | A TCP/IP utility that is used for terminal emulation and that allows a client to connect and interact with a remote host system. |
| **TFTP** | Trivial File Transfer Protocol. A UDP-based service that provides connectionless file transfers. |
| **TelnetCE Client** | Wavelink Corporation application that provides client-side terminal emulation services for Microsoft Windows CE-based mobile devices. |
| **update** | In the context of Avalanche Manager, an Avalanche update. See *Avalanche Update*. |
| **WEP** | Wired Equivalent Privacy. An encryption standard for wireless networks that provides the equivalent security of a wired connection for wireless transmissions. |
| **Windows CE** | A Microsoft Windows-based operating system for mobile devices. |
| **Windows Enabler** | An Avalanche Enabler that is designed for Microsoft Windows 9x/ME/NT/2000/XP systems with installed 802.11b wireless cards. |
| **WINS** | Windows Internet Naming Service. A service that provides Windows name-to-IP address mapping. |
Index

Numerics
5250/3270 virtual keyboard 135
802.11/a/b 235

A
about
  emulation parameters 55
  global emulation parameters 56
  maintenance licenses 113
  per-host emulation parameters 55
  platform licenses 113
access point 235
accessing
  global emulation parameters 56
  per-host emulation parameters 61
activation method 79
  on barcode, MSR or RFID Scan 82
  on key combination 80
  on screen update 83
  select from menu 80
  when session connects 81
activetext
  configuring 212
  using 139
ad hoc mode 235
adding
  a license 228
  host profiles 28
agent 235
alphabetized view, configuration manager 72
AP 235
authorization 111
autologin for VT emulation, configuring 215
automatic WEP 235
Avalanche Agent 235
Avalanche client 235
Avalanche Enabler 235
Avalanche Enabler SDK
  edf, defined 237
  enabler profile, defined 237
Avalanche Management Console, defined 236
Avalanche Manager, defined 236
Avalanche Monitor, defined 236
Avalanche software package, defined 236
Avalanche update 236
Avalanche update utility, defined 236

B
battery strength icon 220
beeps settings 182
BOOTP 236

C
certificate verification, enabling 34
client 236
cold boot recovery 10
COM port, freeing 191
concurrent telnet sessions, configuring 203
configuration manager
  alphabetized view 72
  find 71
  using 68
configuration support matrix 12
configuring
  activetext 212
  autologin for VT emulation 215
  emulation parameters 56
  failover 39
  host profiles 27
  IP printing 204
  key macros 209
  license server IP address 205
  number of concurrent sessions 203
  passwords 201
scan handlers 213
screen panning 210
session monitor 150
telnet negotiation strings for VT emulation 217
TelnetCE Client 10
TelnetCE Client display settings 206
TelnetCE Client lockdown 207
TelnetCE Client with Avalanche Manager 13
TelnetCE Client with Microsoft ActiveSync 15
TermProxy-only connections 37
workstation IDs for 5250/3270 emulation 218
connecting to hosts 121
contact information 233
creating script code 84
cursor settings 180

deleting host profiles 30
demo license, using 118
deploying
  configurations 16
  configurations via Avalanche Manager 17
  configurations via Microsoft ActiveSync 23
deploying keyboards 109
deploying scripts 96
DHCP 236
diagnostics utility
  accessing 141
  performing a keyboard test 143
  performing a scan test 144
  performing a Windows keyboard test 145
diagnostics utility, using 141
disconnecting a Telnet session 127
display settings 177
display settings, configuring 206
DNS 237
document
  assumptions 1
  conventions 1
  revision history 3
E
  edit autologin 168
  editing scripts 92
emulation parameters
  about 4, 55
  configuring 56
  defined 237
  global 56
  global, defined 237
  manually configuring 169
  modifying 70
  per-host 55
  per-host, defined 237
  using configuration manager 68
Enabler 237
Enabler configuration utility 237
Enabler profile 237
enabling
  certificate verification 34
  indicator icons 220
  session monitor 150
  SSL 32
ESSID 237
executing scripts
  on barcode, MSR or RFID scan 98
  on key combination 97
  on screen update 98
  select from menu 98
  when session connects 97
exiting the TelnetCE Client 128
exporting 94
exporting scripts 94
F
  figures
about license server dialog box 225
accessing per-host emulation parameters 66
accessing the virtual emulation keyboard 134
ActiveSync installation and configuration utility 11
alphabetized view in the configuration manager 73
authorizing terminal dialog box 116, 118
available unconnected Telnet session 130
configuration manager 58, 60, 69
configuration manager for per-host emulation parameters 64, 67
configuring autologin settings 51
configuring emulation parameters from Avalanche 59
configuring host settings 41
configuring IBM settings 48
configuring indicators 221
configuring log file settings 155
configuring per-host emulation parameters from Avalanche 65
configuring per-host emulation settings 54
configuring TermProxy settings 44
configuring the TelnetCE Client package 13
configuring the TermProxy tab 40
configuring VT settings 50
connecting to session monitor 153
demonstration period expired 112
disconnecting a session 133
disconnecting a Telnet session 127
emulation parameter information 70
enabling certificate validation 35
enabling session override 154
enabling SSL for a host profile 33
enabling TermProxy-only connections 38
exiting the TelnetCE Client 128
get connected dialog box 193, 198
host profiles dialog box 28
host system and mobile device are synchronized 196
inputting a string to find 72
launching session monitor 152
license server GUI 228
managing SSL certificates 36
Microsoft ActiveSync guest partnership 199
modifying an emulation parameter 70
performing a keyboard test 144
performing a scan test 145
performing a Windows keyboard test 146
RAPI gateway in Avalanche keyboard test 146
select host dialog box 126
select synchronization settings dialog box 194
selecting the components to synchronize 195
selecting the connection method on the host system 190
selecting the license type 115
selecting to configure per-host emulation parameters 63
serial ports enabled in Avalanche Manager 18
setting the software collection synchronization medium 21
switching to a different Telnet session 131
TelnetCE Client 5250/3270 virtual emulation keyboard 136
TelnetCE Client available host profiles 26
TelnetCE Client default screen 123, 125
TelnetCE Client diagnostics utility 142
TelnetCE Client running in demonstration mode 119
TelnetCE Client shortcut icon 122
TelnetCE Client shortcut icon in the Avalanche Enabler 124
TelnetCE Client virtual emulation keyboard 134
TelnetCE Client VT/HP virtual emulation keyboard 137
viewing real-time statistics in Avalanche Manager 157
Wavelink authorization dialog box 229
Wavelink product configuration dialog box 15, 23, 57, 62
find 71
font settings 175
freeing a COM port 191
FTP 237
FTP server 237
G
gateway 238
global emulation parameters
  about 56
  accessing 56
GUI 238
H
host 238
host failover 39
host profile, defined 238
host profiles 86
  about 4
  adding 28
  and SSL 31
  and TermProxy 37
autologin settings 51
configuration settings 53
configuring 27
deleting 30
edit autologin 168
host settings 41
IBM settings 47
manually configuring 161
modifying 29
more 5250 options 166
more VT options 167
overview 25
TermProxy settings 43

VT settings 49
I
IBM Host settings 172
IBSS 238
ICMP 238
importing keyboard graphics 105
importing scripts 92
indicator icons 220
infrastructure mode 238
initiating a Telnet session 125
installing
  license server 225
  SSL support package on host system 31
  SSL support package on mobile device 32
TelnetCE Client 9
IP address 238
IP printing, configuring 204
K
key macros, configuring 209
keyboard creator
  about 5
  launching 99
  overview 99
keyboard files 101
keyboard test 143
keyboards
  adding 102
  creating 102
  deleting 104
  deploying 109
  importing graphics 105
  keys 105
  positioning rows 108
  sizing 104
  sizing rows 108
  keys
    adding keys 106
    configuring 106
creating 105
deleting 109
positioning 108
sizing 108

L
LAN 238
launching
session monitor 152
TelnetCE Client 121
TelnetCE Client from Avalanche 123
TelnetCE Client from Windows 122
lease 238
license server
installation methods 225
installing 225
using 227
versions 224
license server IP address, configuring 205
licenses
maintenance 113
platform 113
licensing
adding a license 228
demo license 118
manually licensing the TelnetCE Client 114
methods 112, 113
overview 111
releasing a license 230
removing a license 231
the TelnetCE Client 111
types 113
using license server 115
viewing license information 230
localization
about 5
defined 238
lockdown, configuring 207

M
MAC address 238
maintenance licenses
about 113
license server versions 224
management console 239
MB 239
Mbps 239
message settings 173
Microsoft ActiveSync
creating a guest partnership 196
creating a standard partnership 192
freeing a COM port 191
selecting connection method on host system 188
selecting mobile device connection method 187
mobile device 239
modifying
emulation parameters 70
host profiles 29
real-time statistics 159
more 5250 options 166
more VT options 167
multiple concurrent sessions 129

N
net mask 239
network profile, defined 239

O
options menu 147
orphan package, defined 239

P
partnership
creating a standard partnership 192
guest partnership 196
passwords, configuring 201
performing script capturing 88
per-host emulation parameters
about 55
accessing 61
beeps settings 182
cursor settings 180
display settings 177
font settings 175
IBM host settings 172
manually configuring 171
message settings 173
printer settings 183
telnet settings 183
view settings 178
VTXX settings 171
ping 239
platform license 113
printer settings 183

R
RAM 239
real-time statistics 155
modifying 159
viewing 156
releasing a license 230
removing a license 231
RF 239
router 239

S
saving scripts 94
scan handlers, configuring 213
scan test 144
screen panning
configuring 210
using 139
script capturing 88
script code 84
script editor 75
launching from Avalanche Manager 76
scripting
about 5
creating variables 84
scripts 94
activation method 79
creating scripts 78
deploying 96
editing 92
importing 92
overview 75
saving 94
SDK 239
selecting
host profiles 86
Microsoft ActiveSync connection on host system 188
Microsoft ActiveSync connection on mobile device 187
selection criteria 240
session monitor
configuring 150
enabling 150
launching 152
session override 153
tracing sessions 154
using 150
signal strength icon 220
silent install 240
silent mode 240
sizing keyboards 104
software packages, defined 240
SSID 240
SSL
about 5
and host profiles 31
enabling 32
enabling certificate verification 34
installing support package on host system 31
installing support package on mobile device 32
standard partnership, creating 192
static WEP 240
subnet 240
subnet mask 240
switching between active Telnet sessions 131

T

tables
  activetext parameters in configuration manager 212
  configuring battery and signal strength indicators 222
  configuring TelnetCE Client lockdown 208
  configuring TelnetCE Client passwords 202
  customizing the TelnetCE Client display 206
  document revision history 3
  TelnetCE Client configuration support matrix 12
  TelnetCE Client version and supported features matrix 6
  text-formatting conventions 2
TCP/IP 241
telnet 241
telnet negotiation strings, configuring 217
telnet settings 183
TelnetCE Client 241
  about 3
  authorizing 111
  autologin for VT emulation 215
  cold boot recovery 10
  components 4
  configuring lockdown 207
  configuration support matrix 12
  configuring 10
  configuring activetext 212
  configuring display settings 206
  configuring IP printing 204
  configuring key macros 209
  configuring license server IP address 205
  configuring number of concurrent sessions 203
  configuring passwords 201
  configuring scan handlers 213
  configuring screen panning 210
  configuring telnet negotiation strings for VT emulation 217
  configuring with Avalanche Manager 13
  configuring with Microsoft ActiveSync 15
  configuring workstation id 218
  deployment methods 3
  diagnostics utility 141
  disconnecting a session 127
  exiting 128
  functionality 5
  initiating a Telnet session 125
  installing 9
  launching 121
  licensing 111
  licensing with license server 115
  manually configuring emulation parameters 169
  manually configuring host profiles 161
  manually licensing 114
  multiple concurrent sessions 129
  options menu 147
  overview 3
  real-time statistics 155
  session monitor 150
  using 121
  version and supported features matrix 6
TermProxy
  and host profiles 37
  configuring failover 39
  configuring TermProxy-only connections 37
TFTP 241
tracing sessions 154

U

updates, defined 241
using
  activetext 139
  configuration manager 68
find 71
license server 227
real-time statistics 155
screen panning 139
session monitor 150
session override 153
standard virtual emulation keyboard 133
TelnetCE Client 121
TelnetCE Client diagnostics utility 141
TelnetCE Client options menu 147

V
variables 84
version and supported features matrix 6
view settings 178
viewing license information 230
viewing real-time statistics 156
virtual keyboard
  5250/3270 135
  using 133
  VT/HP 137
VT/HP virtual keyboard 137
VTXX settings 171

W
Wavelink contact information 233
WEP
  automatic 235
  defined 241
  static wep 240
Windows CE 241
Windows Enabler 241
WINS 241
workstation id, configuring 218